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Introduction The most widely used spreadsheet application in the world, Excel is a key part of the Microsoft Office suite of applications. You can use Excel for anything from a small spreadsheet of household finances to monster databases of all your company’s products, customers, and sales. You can use Excel either on its own or together with the other Office applications. Excel 2003 builds on the many previous versions of Excel to deliver powerful functionality and many new features along with a slick and easy-to-use interface. If you’re new to Excel, you’ve got a large amount to learn. If you’re coming to Excel 2003 as an experienced user of earlier versions, you’ve still got plenty to learn. But either way, this book will get you up to speed quickly.



Who Is This Book For? This book is designed to help beginning and intermediate users get the most out of Excel 2003 in the shortest possible time. If you fall into either of those categories, you’ll benefit from this book’s comprehensive coverage, focused approach, and helpful advice. If you’re an Excel expert seeking super-advanced coverage, look elsewhere.



What Does This Book Cover? Here’s what this book covers:



■ Chapter 1, “Get Started with Excel,” shows you how to launch Excel in the many ways that Windows provides and how to navigate the main components of the Excel screen. You’ll also learn what workbooks and worksheets are, how to select objects, and how to get help on using Excel.



■ Chapter 2, “Configure Excel to Suit Your Working Needs,” discusses how to improve your view of worksheets by splitting the view, displaying extra windows, hiding and redisplaying windows, zooming the view, and freezing particular rows and columns so they never move while everything else scrolls. You’ll learn how to set the most important of Excel’s many options to customize its behavior, how to load add-ins when you need the extra functionality they provide, and how to configure AutoCorrect to save you time and effort.
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xvi



How to Do Everything with Microsoft Office Excel 2003 ■ Chapter 3, “Create Spreadsheets and Enter Data,” starts by explaining how to create a new workbook in any of several convenient ways and how to save it, and then shows you how to create your own templates to use as the basis for future worksheets. You’ll also find out how to enter data in your worksheets manually and by using Excel’s AutoFill feature, how to use Excel’s Find and Replace features, and how to recover your work if Excel crashes.



■ Chapter 4, “Format Worksheets for Best Effect,” discusses how to manipulate the worksheets in a workbook, and then moves on to cover formatting cells and ranges using the many types of formatting that Excel supports.



■ Chapter 5, “Add Graphics and Drawings to Worksheets,” shows you how to add visual impact to your worksheets by including pictures, shapes, diagrams, and other graphical objects. This chapter also explains how Excel’s drawing layer handles graphical objects and how you can position, resize, and format objects.



■ Chapter 6, “Check, Lay Out, and Print Worksheets,” explains how to get your worksheets into shape for printing and how to print them. Topics covered include checking spelling, setting the print area, specifying the paper size and orientation, creating headers and footers, and using Print Preview to avoid wasting paper. You’ll also learn to set and adjust page breaks and specify which extra items to include in the printout.



■ Chapter 7, “Perform Calculations with Functions,” covers what functions are and how you enter them in your worksheets. You’ll also learn about the nine categories of functions that Excel provides, with examples of some of the most useful functions in each category.



■ Chapter 8, “Create Formulas to Perform Custom Calculations,” starts by teaching you the basics of formulas in Excel and the components from which formulas are constructed. After that, you’ll learn how Excel handles numbers, and how to create both regular formulas and array formulas. The end of the chapter shows you how to troubleshoot formulas when they don’t work correctly.



■ Chapter 9, “Organize Data with Excel Databases,” shows you how to create Excel databases, enter data, and sort and filter the data to find the information you need. This chapter also covers how to link an Excel worksheet to an external database (for example, an Access database) so that you can extract data to an Excel worksheet and manipulate it there, and how to perform web queries to bring web data into worksheets.



■ Chapter 10, “Outline and Consolidate Worksheets,” discusses how to outline a worksheet so that you can collapse it to show only the parts you need and how to consolidate multiple worksheets into a single worksheet. Both outlining and consolidation can save you welcome amounts of time.



■ Chapter 11, “Analyze Data Using PivotTables and PivotCharts,” explains how to use Excel’s powerful PivotTables and dynamic PivotCharts to manipulate your data so that you can draw conclusions from it. You’ll also learn how to create a conventional (static) chart from PivotTable data.



■ Chapter 12, “Solve Problems by Performing What-If Analysis,” discusses how to create data tables that enable you to assess what impact one or two variables have on a calculation.
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Introduction This chapter then describes how to use Excel’s scenarios to explore the effects of alternative data sets within the same worksheet, how to solve one-variable problems using Goal Seek, and how to use the Solver to solve multi-variable problems.



■ Chapter 13, “Create Effective Charts to Present Data Visually,” covers how to use Excel’s chart features to create compelling charts. You’ll learn how to create charts by using the Chart Wizard, how to choose the right type of chart for your data, and how to edit and format charts to give them the effect you need. You’ll also learn how to copy formatting you’ve applied to one chart to another chart, how to unlink a chart from its data source, how to print your charts, and how to add custom chart types to Excel’s existing types.



■ Chapter 14, “Share Workbooks and Collaborate with Colleagues,” explains the range of features that Excel provides for sharing workbooks, protecting them from types of changes you don’t want others to make, and collecting and reviewing input from your colleagues to produce a final version of a workbook. Among other things, you’ll learn how to work with comments, how to send workbooks via e-mail, how to track changes to a workbook, and how to merge multiple workbooks into a single workbook.



■ Chapter 15, “Using Excel’s Web Capabilities,” describes Excel’s key features for creating and working with Web data. You’ll learn when to save files directly to intranet sites and Internet servers, how to save a worksheet or workbook as a web page, how to configure Excel’s web options, and how to work in an interactive web workbook. If your company uses XML for data exchange, you can also learn how to use Excel’s powerful XML capabilities, including external schemas.



■ Chapter 16, “Use Excel with the Other Office Applications,” discusses how to transfer data smoothly and easily among Excel and the other Office applications (such as Word and PowerPoint). This chapter starts by discussing data transfer via the Clipboard, then covers embedding and linking, two different technologies for including a part of one document in another document. The end of the chapter explains how to insert Excel objects in Word documents and PowerPoint presentations, and how to insert Word objects and PowerPoint objects in worksheets.



■ Chapter 17, “Customize Excel’s Interface,” describes how to customize Excel’s toolbars and menus to put the commands you need at your fingertips while maximizing the amount of space available onscreen. This chapter is short, but it can save you considerable time and effort, so it’s worth a visit.



■ Chapter 18, “Use Macros to Automate Tasks,” explains how to use Office’s built-in Macro Recorder feature to record macros (sequences of commands) so you can perform them automatically later. To use macros, you must configure Excel’s macro virus–protection mechanism, so you’ll learn about that in this chapter as well.



■ The Appendix lists the keyboard shortcuts you can use to make Excel do your bidding without touching the mouse.
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xviii



How to Do Everything with Microsoft Office Excel 2003 Excel 2003 runs on Windows XP and Windows 2000 (not on Windows Me, Windows 9x, or Windows NT). The illustrations in this book show how Excel looks with Windows XP’s default interface, which is somewhat different than Windows 2000’s interface. Looks aside, Excel’s functionality is the same on both Windows XP and Windows 2000. However, you sometimes need to use different commands when working in Windows itself. For example, Windows XP’s default Start menu is laid out differently than Windows 2000’s Start menu, so where in Windows XP you launch Excel by choosing Start | All Programs | Microsoft Office | Microsoft Office Excel 2003, in Windows 2000 you choose Start | Programs | Microsoft Office | Microsoft Office Excel 2003.



Conventions Used in This Book To make its meaning clear without using far more words than necessary, this book uses a number of conventions, three of which are worth mentioning here:



■ Note, Tip, and Caution paragraphs highlight information you should pay extra attention to. ■ The pipe character or vertical bar denotes choosing an item from a menu. For example, “choose File | Open” means that you should pull down the File menu and select the Open item. Use the keyboard, mouse, or a combination of the two as you wish.



■ Most check boxes have two states: selected (with a check mark in them) and cleared (without a check mark in them). This book tells you to select a check box or clear a check box rather than “click to place a check mark in the box” or “click to remove the check mark from the box.” (Often, you’ll be verifying the state of the check box, so it may already have the required setting—in which case, you don’t need to click at all.) Some check boxes have a third state as well, in which they’re selected but dimmed and unavailable. This state is usually used for options that apply to only part of the current situation. This book assumes you’re using Internet Explorer rather than another browser. Given that Internet Explorer currently enjoys a market share of more than 95 percent at this writing (according to OneState.com, a web analytics firm), that’s probably a reasonable assumption. But if you’re using another browser, you’ll see different behavior when you take an action that causes Excel to access your default browser.



P:\010Comp\HowTo8\071-1\fm.vp Friday, August 29, 2003 2:51:50 PM



HowTo-Tght (8) / How to Do Everything with Microsoft Office Excel 2003 / Hart-Davis / 3071-1 / Chapter 1 Color profile: Generic CMYK printer profile Composite Default screen blind folio 1



Part I



P:\010Comp\HowTo8\071-1\ch01.vp Wednesday, August 27, 2003 2:06:49 PM



Get Started with Excel and Create Worksheets



This page intentionally left blank



HowTo-Tght (8) / How to Do Everything with Microsoft Office Excel 2003 / Hart-Davis / 3071-1 / Chapter 1 Color profile: Generic CMYK printer profile Composite Default screen blind folio 3



Chapter 1



P:\010Comp\HowTo8\071-1\ch01.vp Wednesday, August 27, 2003 2:06:50 PM



Get Started with Excel



(8) / How to Do Everything with Microsoft Office Excel 2003 / Hart-Davis / 3071-1 / Chapter 1 Color profile: Generic CMYK printerHowTo-Tght profile Composite Default screen



4



How to Do Everything with Microsoft Office Excel 2003



How to… ■ ■ ■ ■ ■ ■ ■ ■ ■



Start Excel manually or automatically Use or hide the task pane Understand the components of the Excel screen Understand the basics of worksheets and workbooks Open an existing workbook Open other formats of spreadsheet file in Excel Navigate in workbooks and worksheets Select cells, ranges, and other objects Get help with Excel



E



xcel is a powerful spreadsheet application for organizing, calculating, summarizing, and presenting data. Coming to grips with Excel involves a bit of a learning curve, but you’ll find that your experience with other Windows applications helps you get the hang of things quickly. In this chapter, you’ll see how to navigate the Excel screen and understand its components. You’ll learn the basics of worksheets (the spreadsheet pages that Excel uses) and workbooks (files that contain worksheets), how to open existing workbooks, and how to navigate through them and select objects in them. At the end of the chapter, you’ll learn how to use Excel’s built-in help features to find information you need.



Start Excel The basic way to start Excel is to choose Start | All Programs | Microsoft Office | Microsoft Office Excel 2003. When it opens, Excel creates a new blank workbook containing three worksheets. By default, Excel displays the Getting Started task pane when you launch it. You can dismiss the task pane by clicking its Close button (the × button). If you want to start Excel and open an existing workbook at the same time so that you can work in that workbook, start Excel in either of these ways:



■ Choose Start | My Recent Documents and select the workbook from the My Recent Documents submenu. If the My Recent Documents item doesn’t appear on your Start menu, right-click the Start button and choose Properties to display the Taskbar and Start Menu Properties dialog box. Click the upper Customize button to display the Customize Start Menu dialog box. On the Advanced tab, select the List My Most Recently Opened Documents check box. Click the OK button in each dialog box to close that dialog box.



■ Double-click the icon for an existing workbook in a Windows Explorer window or on your desktop.



P:\010Comp\HowTo8\071-1\ch01.vp Wednesday, August 27, 2003 2:06:51 PM



(8) / How to Do Everything with Microsoft Office Excel 2003 / Hart-Davis / 3071-1 / Chapter 1 Color profile: Generic CMYK printerHowTo-Tght profile Composite Default screen



CHAPTER 1: Get Started with Excel For instructions and illustrations, this book uses a default configuration of Windows XP as the operating system on which Excel is running. If you’re using Windows 2000 Professional, the user interface will look a little different, because Windows 2000 uses a different color scheme by default and doesn’t support the round upper corners on windows and dialog boxes that Windows XP uses by default. More important, Windows 2000’s Start menu is arranged a little differently than Windows XP’s default Start menu. For example, Windows 2000 has a Programs menu rather than an All Programs menu, so to start Excel in Windows 2000, you choose Start | Programs | Microsoft Office | Microsoft Office Excel 2003 rather than Start | All Programs | Microsoft Office | Microsoft Office Excel 2003.



Start Excel Easily and Often If you start Excel more frequently than most other applications, Windows XP automatically places a shortcut to Excel on the most frequently used applications section of the Start menu, as shown here. You can then start Excel by choosing Start | Microsoft Office Excel 2003.



Pinned Applications



Most Frequently Used Applications
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How to Do Everything with Microsoft Office Excel 2003



That makes launching Excel easier—but you can make it even easier by pinning Excel to the pinned items section of the Start menu, so that it always appears there no matter which applications you launch most frequently. To pin Excel, choose Start | All Programs | Microsoft Office to display the submenu, right-click the Microsoft Office Excel 2003 item, and choose Pin to Start Menu from the shortcut menu. (If there’s an icon for Excel on the most frequently used programs section of the Start menu, you can right-click that icon instead of displaying the Microsoft Office submenu.) If you use Excel in every Windows session, consider configuring Windows to launch Excel automatically each time you log on to Windows. Doing this makes the logon process take a few seconds longer, but it saves you the trouble of launching Excel manually. To configure Windows to launch Excel automatically when you log on, follow these steps: 1. Choose Start | All Programs | Microsoft Office to display the Microsoft Office submenu. 2. Right-click the Microsoft Office Excel 2003 item and choose Copy from the shortcut menu to copy it to the Clipboard. 3. Choose Start | Run to display the Run dialog box. 4. Type %userprofile%\Start Menu\Programs\Startup. (%userprofile% is a system variable that returns the path to your user profile folder—the folder that contains your My Documents folder and the folders in which your settings are stored.)



5. Click the OK button. Windows opens the Startup folder, which contains shortcuts to applications that run when you log on to Windows. 6. Right-click in the Startup folder and choose Paste from the shortcut menu to paste a copy of the Excel shortcut into the folder. 7. Click the Close button (the × button) or choose File | Close to close the Windows Explorer window. If you’re using Windows XP Professional in a corporate environment, an administrator may have prevented you from customizing your startup group. If this is the case, you’ll need to have an administrator customize the startup group for you.
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CHAPTER 1: Get Started with Excel



Use or Hide the Task Pane



1



By default, Excel displays the Getting Started task pane (Figure 1-1) when you launch the application. The task pane’s default position is to be docked (attached) to the right side of the Excel window, but you can drag it by the handle to any other edge of the window to dock it there if you prefer. Alternatively, you can display the task pane floating free anywhere in the Excel window by dragging it away from the side of the window to which it’s currently docked. When the task pane is docked, you can resize it by dragging the border on its open side to change its width or depth. When the task pane is floating free, you can resize it by dragging any side or corner. If you’ve used any of the Office XP applications (or any of the other Office 2003 applications), you’ll be familiar with task panes; if you’re coming to Excel 2003 fresh or from Office 2000 or an earlier version, task panes should be a welcome addition to the interface. The task pane area can Handle



FIGURE 1-1



Task Pane



When you launch Excel and create a new workbook, Excel displays the Getting Started task pane by default.
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How to Do Everything with Microsoft Office Excel 2003 display any one of a variety of different task panes built into Excel. I’ll introduce these task panes briefly in a moment and then discuss each one in detail in the part of the book that covers the functionality that the task pane provides. Each task pane draws together previously disparate functions that are commonly needed for a particular group of tasks. For example, the Getting Started task pane (which you can see in Figure 1-1) lets you open recently used files (instead of having to use the File menu or the Open dialog box), create a new workbook, or search Microsoft Office Online. Once you’ve taken an action from the Getting Started task pane or an action that removes the need for the Getting Started task pane, Excel hides the task pane. Whether you find the Getting Started task pane useful or an irritating waste of screen real estate depends on how you work (and perhaps your temperament). You can control the task pane manually as follows:



■ Click the Close button (the × button) to dismiss the task pane. ■ Choose View | Task Pane or press CTRL-F1 to toggle the display of the task pane. Excel displays the task pane you last used in the current session. If you haven’t used a task pane in this session, Excel displays the Getting Started task pane.



■ To prevent Excel from displaying the Getting Started task pane when you launch Excel, choose Tools | Options, clear the Startup Task Pane check box on the View tab of the Options dialog box, and click OK. Excel displays the other task panes when they’re needed. For example, Excel displays the Clipboard task pane when you copy or cut two items in succession without pasting the first item. You can also display most of the task panes manually by using the drop-down menu of whichever task pane is currently displayed. There are several exceptions that don’t appear on this menu. For example, you can’t display the two file-search task panes (the Basic File Search task pane and the Advanced File Search task pane) from the menu; instead, display them by choosing File | File Search and then, if necessary, clicking the Advanced File Search link or the Basic File Search link in the task pane. Another exception is the Document Recovery task pane, which appears only when you’ve restarted Excel after a crash or after closing it with Microsoft Office Application Recovery. Most of the task panes are available most of the time when you’re working in a workbook in Excel, but some are available only for specific files. When a task pane isn’t available, it appears dimmed in the list. For example, the Template Help task pane is available only when you’re working in a Smart Document that has custom help attached. Excel also offers these task panes:



■ Excel Help Enables you to search the local help files and (if you have an Internet connection available) the Microsoft Office Online support site. This task pane also
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CHAPTER 1: Get Started with Excel contains links for accessing additional content on Microsoft Office Online. You can also display this task pane by choosing Help | Microsoft Office Excel Help or by pressing F1.



■ Search Results After you begin a file search (by choosing File | File Search and specifying the details in the Basic File Search task pane or the Advanced File Search task pane), Excel displays the Search Results pane to show the results of the ongoing search. You can continue working on open workbooks while the search is under way.



■ Clip Art Enables you to search for graphics files organized by collection, file type, and location. You can also display this task pane by choosing Insert | Picture | Clip Art.



■ Research You can search specified encyclopedias, thesauruses, and translation tools for more information about selected words. You can also display this task pane by clicking the Research button on the Standard toolbar or choosing Tools | Research.



■ Clipboard The Office Clipboard can hold up to 24 items copied or cut from any Office application. You can then paste these items elsewhere. You can also display this task pane by choosing Edit | Office Clipboard.



■ New Workbook Offers workbook-creation options based on various formats or templates. You can also display this task pane by choosing File | New.



■ Template Help Displays custom help content included in the template that’s attached to the document you’re currently using.



■ Shared Workspace Provides features for sharing a central copy of a document with others from a SharePoint Team Services web site.



■ Document Updates This feature works with the Shared Workspace, enabling you to get the most recent version of the workbook from the server.



■ XML Source Displays the XML schema attached to the currently displayed XML file. You can map schema elements to parts of the worksheet by dragging them to the worksheet. You can also display this task pane by choosing Data | XML | XML Source. Once you’ve moved from one task pane to another, you can retrace your steps by clicking the Back button, and go forward again by clicking the Forward button. Click the Home button to display the Getting Started task pane.



Understand the Excel Screen Figure 1-2 shows the Excel application window with a workbook open and a worksheet displayed. In addition to standard Windows elements such as the task pane (if you choose to display it), menu bar, toolbars, scroll bars, and status bar, Excel has a reference area that shows the active cell’s address, a formula bar for entering and editing data and formulas, row and column headings, and worksheet tabs.
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How to Do Everything with Microsoft Office Excel 2003



Name Box Select All Button



Insert Function Enter



Cancel



Column Headings



Ask a Question Box



Formula Bar



Active Cell Split Boxes



Row Headings



Scroll Bars



Scroll to First Tab



Scroll Tabs Left



Scroll Tabs Right



FIGURE 1-2



Scroll to Last Tab



Worksheet Tabs AutoCalculate



Scroll Bars



The Excel application window with a workbook open and a worksheet displayed



Understand Worksheets and Workbooks Excel’s basic unit is the worksheet, a grid of cells in which you enter data. Each worksheet consists of 256 columns and 65,536 rows. The intersection of each row and column is a cell, so each worksheet contains 16,777,216 cells.
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CHAPTER 1: Get Started with Excel By default, Excel uses the A1 reference scheme to refer to columns, rows, and cells:



■ Columns are designated by letters: A to Z for the first 26 columns, AA to AZ for the next 26 columns, then BA to BZ, and so on. The last column is IV.



■ Rows are numbered from 1 to 65536. ■ Cells are designated by column and row. The first cell on a worksheet is cell A1, and the last cell is IV65536. This designation is called the cell address. Instead of A1, Excel can also use the R1C1 reference format, which uses the letter R and a number to indicate the row and the letter C and a number to indicate the column. For example, cell B2 is R2C2 in R1C1 reference format. You can change to R1C1 format on the General tab of the Options dialog box (Tools | Options). Excel saves worksheets in workbook files. These files use the Microsoft Excel Worksheet file format, which has the .XLS file extension. Each workbook can contain either one or more worksheets. By default, new workbooks contain three worksheets and can contain up to 256 worksheets. The worksheets are named Sheet1, Sheet2, and so on. You can change these names as needed. Workbooks make it easy to keep related information on separate sheets that you can access quickly. For example, you might use a separate worksheet to track the sales results for each of your company’s sales territories. As you’ll see shortly, Excel provides features for entering the same data on multiple worksheets simultaneously, so you can quickly create a group of worksheets that contain the same basic information—for example, the layout of those sales results and associated information. On the top sheet of the workbook, you might put a summary worksheet that presented an executive overview of the sales results. Excel lets you create formulas that link from one worksheet to another, so the sales-territory worksheets could automatically update the summary worksheet. See “Divide Data Among Workbooks and Worksheets,” in Chapter 3, for guidelines on how to divide your data.



Open an Existing Workbook Excel offers a variety of ways to open an existing workbook—from the Getting Started task pane, the Open dialog box, the File menu, a Windows Explorer window, or the Desktop. And those are only the conventional means of opening a workbook. (I won’t discuss the unconventional means here.)



Open a Workbook from the Getting Started Task Pane The newest way of opening a workbook is by using the Getting Started task pane, which displays a brief list of the workbooks you’ve used recently. Click a link to open the workbook, or click the Open link to display the Open dialog box (discussed next).
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How to Do Everything with Microsoft Office Excel 2003 If you have the Getting Started task pane displayed by default, this can be a convenient way of opening recently used files. (If not, the recently used list at the bottom of the File menu is more convenient.) But if you do have this task pane displayed all the time, you’re probably wasting precious screen space. So your chances of finding the Getting Started task pane a key way of opening a workbook seem destined to remain slim.



Open a Workbook from the Open Dialog Box The most conventional way of opening an existing workbook is to use the Open dialog box. To do so, follow these steps: 1. Click the Open button on the Standard toolbar or the Open link in the Getting Started task pane, or choose File | Open, or press CTRL-O, to display the Open dialog box:



2. Navigate to the folder that contains the workbook:



■ Use the My Recent Documents button on the Places bar to display a list of your recently opened workbooks.



■ Use the other buttons on the Places bar to quickly access your desktop, My Documents folder, My Computer folder, or My Network Places folder as necessary.



■ Navigate up and down the folder tree as usual. 3. Select the workbook. If the Open dialog box doesn’t show the workbook file, you may need to choose a different filter in the Files of Type drop-down list. The default filter is All Microsoft Excel Files, which displays all the file types that Excel claims as its own. 4. Click the Open button to close the Open dialog box and open the workbook.
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CHAPTER 1: Get Started with Excel



Know When to Use the Alternate Open Commands As well as opening the workbook for editing, the Open dialog box also enables you to open the workbook in the following ways by clicking the drop-down button on the Open button and choosing the action from the resulting menu:



■ Open Read Only Opens the workbook in a read-only format, which prevents you from saving changes to this copy of the file. You can save changes by using a Save As command to save the workbook under a different file name or path. Use this command when you need to ensure that you don’t unthinkingly save changes to a workbook that you’re not supposed to change. (If an administrator or another user decides to allow you to view their workbooks but not change them, Excel enforces the read-only status automatically when you try to open the workbook.)



■ Open As Copy Opens a copy of the workbook under the name Copy (1) of filename— for example, Copy (1) of Project Budget.xls. This command can be useful for quickly creating a copy of the workbook, but renaming the copy from its default name is cumbersome: even if you use a Save As command to save the copy under a different name, you’ll need to subsequently delete the Copy (1) Of file so as not to leave it lying around.



■ Open in Browser Opens the file in your computer’s default browser (for example, Internet Explorer). This command is available only for HTML files.



■ Open and Repair Opens the workbook and attempts to repair the damage it has sustained. With luck, you’ll rarely need to use this command.



Open a Recently Used Workbook from the File Menu The bottom of the File menu lists the workbooks you’ve used most recently. You can open one of these workbooks by displaying the File menu (for example, press ALT-F) and choosing the appropriate entry. By default, Excel lists your four most recently used workbooks. You can change this number by setting the Recently Used File List Entries text box on the General tab of the Options dialog box (Tools | Options).



Open a Workbook from Windows Explorer or Your Desktop You can open a workbook directly from a Windows Explorer window (or from your desktop) by double-clicking it. This technique is useful for files you’ve chosen to store on your desktop and when you’ve just used Windows Explorer to find, move, or copy a file. By opening the folder directly from Windows Explorer, you avoid having to navigate in the Open dialog box to the folder. Another advantage is that when you open a workbook in this way, Excel doesn’t change the working directory to the folder that contains the workbook. So the next time you display the Open dialog box, it still displays the folder from which you last opened a workbook using the dialog box.
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How to Do Everything with Microsoft Office Excel 2003



Open Other Formats of Spreadsheet in Excel If you’ve used another spreadsheet application before migrating to Excel, you may need to transfer data from your old spreadsheets to Excel. To help you do so, Excel includes filters for converting data from other formats, such as Lotus 1-2-3, Quattro Pro, Microsoft Works, and dBASE, not to mention files in earlier Excel formats (for example, Excel 95 or Excel 97) and XML. Excel can also open text files in widely used formats, such as comma-separated values (CSV)—a format that uses commas to denote the divisions between data fields. To get data from applications such as address books or organizers into an Excel worksheet, you’ll often need to export the data to a CSV file and then open that file in Excel. Similarly, if Excel doesn’t have a converter for a spreadsheet file that you need to open, use the application that created the file to save a copy in CSV format, then open that copy in Excel. To convert a file, open it via the Open dialog box as usual. Use the Files of Type drop-down list to specify the type of file you want to display in the main list box. If the type of file doesn’t appear in the list, select the All Files item to display all files—but be warned that Excel probably won’t be able to convert the file. If it can’t, Excel displays a message such as this, claiming the file format is not valid:



“Not valid” almost always means that Excel doesn’t have a converter for the file format. (On rare occasions, you may find that the file has become corrupted and useless, giving Excel a valid complaint.) When this happens, open the file in the application that created it (or an application that does have a converter), export the data to a CSV file, and then import that file into Excel.



Navigate in Workbooks and Worksheets After creating a new workbook or opening an existing workbook, you’ll need to navigate to the worksheet on which you want to work. You’ll then need to navigate on that worksheet to access the right cells or ranges. Like almost all other Windows applications, Excel supports navigating with both the mouse and the keyboard. For most purposes, the mouse is quicker and faster than the keyboard.



Navigate to the Worksheet You Need To move to another worksheet with the mouse, click its tab. If necessary, use the scroll buttons (shown with labels in the following illustration) to make the tab appear in the list.
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CHAPTER 1: Get Started with Excel Scroll to First Tab



Scroll Tabs Left



Scroll Tabs Right



Scroll to Last Tab



Active Tab (with underline)



1



Excel offers these keyboard shortcuts for navigating among and selecting worksheets: Action



Keyboard Shortcut



Move to the next worksheet



CTRL-PAGEDOWN



Move to the previous worksheet



CTRL-PAGEUP



Select the current and next worksheets



CTRL-SHIFT-PAGEDOWN



Select the current and previous worksheets



CTRL-SHIFT-PAGEUP



Navigate to Cells and Ranges in a Worksheet Most people find the mouse the easiest way of navigating in worksheets:



■ Click a worksheet or cell to access it. ■ Use the horizontal and vertical scroll bars and scroll boxes to scroll to different areas of the worksheet. But you can also navigate easily by using the arrow keys (↑, ↓, ←, and →) and keyboard shortcuts. Keyboard shortcuts are especially effective when you’re working in a large worksheet that requires extensive scrolling to navigate. These are the most useful keyboard shortcuts: Action



Keyboard Shortcut



Move to the specified edge of the data region



CTRL-↑,



Move to the first cell in the row



HOME



Move to the first cell in the worksheet



CTRL-HOME



Move to the last cell ever used in the worksheet



CTRL-END



Move down one screen



PAGEDOWN



Move up one screen



PAGEUP



Move to the right by one screen



ALT-PAGEDOWN



Move to the left by one screen



ALT-PAGEUP



Scroll the workbook to display the active cell



CTRL-BACKSPACE
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How to Do Everything with Microsoft Office Excel 2003 You can move to a specific cell by typing its address in the Name box and pressing ENTER.



Select Objects After navigating to the right areas of the appropriate worksheets, you select objects (such as cells and ranges) so that you can work with them. You can select most objects with either the mouse or the keyboard.



Select Cells and Ranges of Cells Much of your work in Excel will be with ranges of cells. Excel supports ranges of both contiguous and noncontiguous cells:



■ A range of contiguous cells is a rectangle of cells defined by the starting and ending cell addresses, separated by a colon. For example, the range C3 to E5 (shown on the left in Figure 1-3) consists of a block of nine cells. Technically, a range can consist of a single cell, but most people understand ranges to have two or more cells.



■ A range of noncontiguous cells consists of a collection of cell addresses separated by commas. For example, a range consisting of the cells B3, B5, B7, and B9 (as shown on the right in Figure 1-3) would be represented as B3,B5,B7,B9. Ranges of noncontiguous cells can include ranges of contiguous cells—for example, B3,B5:B7,B9. You can select objects in worksheets by using the mouse, the keyboard, or both. These are the basic techniques you need to know:



■ To select a cell, click it, or use the arrow keys to move the active cell outline to it. ■ To select a row or column, click its heading. Press SHIFT-SPACE to select the row or CTRL-SPACE



to select the column that the active cell is in.



■ To select a contiguous range of cells, click the cell at one corner of the range and then drag to the other corner. You can drag in any direction—up, down, sideways, or diagonally. This technique works best when the full range of cells appears on screen. If you need to scroll the window to reach the end of the range, you may overrun the far corner of the range. In this case, use the next technique instead.



■ To select a contiguous range of cells, click the cell at one corner of the range, scroll if necessary to display the far corner of the range, hold down SHIFT, and click. This technique works well for ranges that run beyond the current window.



■ To make multiple selections, make the first selection, hold down CTRL, and then make the other selections.
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FIGURE 1-3



Ranges can be either contiguous (left) or noncontiguous (right).



To select all the cells in the active worksheet, click the Select All button, the unmarked button at the intersection of the column headings and row headings. You can also select cells and ranges by using the names assigned to them, and by using the Go To dialog box and the Go To Special dialog box. The next two sections discuss these techniques.



Assign a Name to a Range To make a range easier to access and identify quickly, you can assign a name to it. You can then select the range easily by using the Name box’s drop-down list or the Go To dialog box, quickly apply formatting to the range, and use the range’s name in calculations rather than having to specify their addresses. To assign a name to a range, follow these steps: 1. Select the range. 2. Choose Insert | Name | Define to display the Define Name dialog box (shown here with a name added).



Collapse Dialog button



3. Type the name in the Names in Workbook text box.
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How to Do Everything with Microsoft Office Excel 2003 4. To create just this name and dismiss the dialog box, click the OK button. To create other names, click the Add button, enter a new name, click the Collapse Dialog button and use the mouse to identify the range, and click the Add button again. (See the sidebar “Use the Collapse Dialog Buttons to Specify Ranges,” following, for a demonstration of using the Collapse Dialog buttons.) 5. Click the Close button to close the Define Name dialog box. To delete a range name from a workbook, follow these steps: 1. Choose Insert | Name | Define to display the Define Name dialog box. 2. Select the name in the Names in Workbook list box. 3. Click the Delete button. 4. Click the Close button to close the Define Name dialog box. You can also name a range by selecting it, clicking in the Name box, typing the name for the range, and pressing ENTER. However, using the Define Name dialog box lets you more easily see which other range names you’ve defined, which can help you implement an orderly naming scheme and avoid duplicating names.



Use the Collapse Dialog Buttons to Specify Ranges Many of Excel’s dialog boxes require you to specify the range to affect. In some cases, you can enter the range automatically by selecting the range before displaying the dialog box. Alternatively, you can type the range, but it’s easy to get the address wrong. So these dialog boxes contain one or more Collapse Dialog buttons to help you specify the range by selecting it on the worksheet. Use any Collapse Dialog button as follows: 1. Display a dialog box that contains one or more Collapse Dialog buttons. The Conditional Formatting dialog box, shown here (and discussed in “Use Conditional Formatting,” in Chapter 4), uses one or more pairs of Collapse Dialog buttons:
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2. Click the Collapse Dialog button to reduce the dialog box to its bare bones. 3. Select the cell or range in the worksheet. Excel enters the cell or range address in the dialog box. This illustration shows the reduced version of the Conditional Formatting dialog box and a selection being made:



4. Click the Collapse Dialog button again to restore the dialog box.



Select Ranges by Using the Go To Dialog Box and the Go To Special Dialog Box For selecting ranges and cells with specific contents, Excel provides the Go To dialog box and the Go To Special dialog box. The Go To dialog box (shown on the left in Figure 1-4; choose Edit | Go To or press CTRL-G) largely duplicates the functionality of the Name box, but it also offers you quick access to unnamed ranges you’ve worked with recently—if you can identify them by their addresses.



FIGURE 1-4



Use the Go To dialog box (left) to select named ranges or unnamed ranges you’ve recently worked with, and the Go To Special dialog box (right) to select cells that match specific criteria.
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How to Do Everything with Microsoft Office Excel 2003 The Go To Special dialog box (shown on the right in Figure 1-4) tends to be of more interest than the Go To dialog box, as it enables you to easily select cells that match specific criteria, such as containing comments, conditional formats, or data validation. To display the Go To Special dialog box, click the Special button in the Go To dialog box. Choose the appropriate options (discussed below) and click the OK button to select the cells with those characteristics. You can then move through the range of cells selected by using ENTER, SHIFT-ENTER, TAB, and SHIFT-TAB. Table 1-1 explains the options that the Go To Special dialog box offers. Option



Explanation



Comments



Cells that contain comments.



Constants



Cells that contain constant data (text, numbers, or dates) rather than formulas. Select or clear the Numbers check box and Text check box under Formulas to specify whether to include numbers and text in the search.



Formulas



Cells that contain formulas rather than constant data. (In other words, the cell’s contents begin with =.) Select or clear the Numbers check box, Text check box, Logicals check box, and Errors check box to specify whether to include numbers, text, logical values (TRUE or FALSE), and error values, respectively. For example, you might use this option button to check all your formulas or to quell errors.



Blanks



Cells that contain no data or formatting. Excel excludes cells after the last cell in the worksheet that contains data.



Current Region



The active cell and all cells around it up to the first blank row and blank column in each direction.



Current Array



The active cell and the array it’s in.



Objects



Objects such as text boxes, charts, AutoShapes, and other objects (for example, sounds).



Row Differences



Cells within the selected range whose contents are different from the contents of the comparison cells you specify. Select the range to evaluate, click a cell in the comparison column to make it active, then select this option button in the Go To Special dialog box.



Column Differences



Cells within the selected range whose contents are different from the contents of the comparison cells you specify. Select the range to evaluate, click a cell in the comparison row to make it active, then select this option button in the Go To Special dialog box.



Precedents



Cells to which the active cell refers. Under the Dependents option button, select the Direct Only option button (the default) or the All Levels option button to specify whether to select direct references only or indirect references as well.



Dependents



Cells that refer to the active cell. Select the Direct Only option button (the default) or the All Levels option button to specify whether to select direct references only or indirect references as well.



TABLE 1-1



Go To Special Dialog Box Options
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Option



Explanation



Last Cell



The last cell ever used in the active worksheet.



Visible Cells Only



Cells that are visible—not hidden. Use this option to avoid pasting hidden rows or columns along with visible rows and columns. Select the range, display the Go To Special dialog box, select this option, then copy the range.



Conditional Formats



Cells that have conditional formatting applied. (“Use Conditional Formatting,” in Chapter 4, explains conditional formatting.) Under the Data Validation option, choose the All option button (the default) to select all cells. Select the Same option button to select only those that match the active cell.



Data Validation



Cells that contain data validation rules. Choose the All option button (the default) to select all cells. Select the Same option button to select only those that match the active cell.



TABLE 1-1



Go To Special Dialog Box Options (continued)



Select Worksheets in a Workbook You can select worksheets in a workbook as follows:



■ Click a worksheet’s tab to select it. ■ SHIFT-click another worksheet’s tab to select all the worksheets between the currently selected worksheet and the one you click.



■



CTRL-click another worksheet’s tab to add that worksheet to the selection, or CTRL-click a selected worksheet’s tab to remove it from the selection.



When multiple worksheets are selected, Excel displays [Group] in the title bar to remind you. Excel also offers two keyboard shortcuts for selecting worksheets:



■ Press CTRL-SHIFT-PAGEDOWN to select the current and next worksheets. ■ Press CTRL-SHIFT-PAGEUP to select the current and previous worksheets.



Get Help with Excel You can get help from Excel in either of the following ways:



■ Type a question (or some keywords) in the Ask a Question box at the right end of the menu bar and press ENTER. Excel searches the local help files and Microsoft’s web site (if an Internet connection is available), and displays the results in the Search Results task pane. Click a link to display Microsoft Excel Help in the Windows Help engine.



■ Press F1 or choose Help | Microsoft Excel Help to display the Excel Help task pane (shown next on the left). Enter a search word or phrase in the Search text box, and then
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How to Do Everything with Microsoft Office Excel 2003 press ENTER or click the Start Searching button. Click one of the search results in the Search Results pane (shown here on the right) to display it in the Windows Help engine.



Customize Excel’s Online Content Settings To customize the online content settings that Excel uses, follow these steps: 1. Press F1 or choose Help | Microsoft Excel Help to display the Excel Help task pane.
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2. Click the Online Content Settings link in the See Also section to display the Online Content section of the Service Options dialog box:



3. Choose the appropriate settings for your needs:



■ Clear the Show Content and Links from Microsoft Office Online check box if you want to turn off online content completely. Having online content is usually helpful, but you may want to suppress it if you have a nonpersistent Internet connection (for example, a dial-up connection) that you prefer not to connect each time you search for help.



■ Clear the Search Office Online Content Automatically When Connected check box if you prefer not to have the Help feature search the Office Online content without your explicitly telling it to do so.



■ Clear the Show Template Help Automatically When Available check box if you don’t want Excel to display the Template Help task pane when you open a Smart Document that has help attached.



■ Clear the Show Microsoft Office Online Featured Links check box if you want to suppress the display of featured links. 4. Click the OK button to close the Service Options dialog box.
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How to Do Everything with Microsoft Office Excel 2003



How to… ■ ■ ■ ■ ■ ■ ■ ■



Split a window to see different parts of it Open extra windows to view different parts of the same worksheet Hide and redisplay windows Zoom the display Keep key rows and columns on screen Set the most important options to make Excel suit your work style Load and unload add-ins Configure AutoCorrect to save time and effort



I



f you’re going to spend any portion worth mentioning of your life using Excel, you owe it to yourself to configure Excel to suit your working needs as closely as possible. In an ideal world, you might dream of simply telling Excel to do your work for you. While this isn’t possible yet, you can automate many routine tasks by creating macros in Visual Basic for Applications (VBA), the programming language built into Excel. (See Chapter 18 for information on VBA and how to record macros with it.) More realistically, you can set many configurable options to specify how Excel’s interface looks and behaves. By choosing appropriate settings, as discussed in this chapter, you can make the time you spend using Excel not only more comfortable but also shorter and more productive. In this chapter, you’ll also learn how to display the appropriate sections of your worksheets so that you can see the information you need; how to load add-ins (extra components) to provide added functionality when you need it; and how to use the AutoCorrect feature to correct typos, expand abbreviations you define, and help enforce consistency in your worksheets.



Improve Your View with Splits, Extra Windows, Hiding, Zooming, and Freezing You can greatly improve your view of data and your ability to work effectively in it by splitting the window to reveal one or three extra parts of it at the same time, opening extra windows, hiding windows you don’t need, zooming in and out to change your view of detail, and freezing the display of rows and columns to keep relevant information on screen.



Split the Excel Window to Show Separate Parts at Once You can split a worksheet window into two or four panes so you can see two or four separate parts of the worksheet at once. Figure 2-1 shows an example of a window split into four panes to show different areas of the same worksheet. The easiest way to apply a two-pane split is to drag the appropriate split box to where you want the split to be. Then, if necessary, you can drag the other split box to create a four-pane split.
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2



Split Bars



FIGURE 2-1



Use Excel’s window-splitting feature to display two or four separate parts of the same worksheet window at once.



To split the window into four panes at once, position the active cell in the row above which and the column to the left of which you want to split the window. Then choose Window | Split to split the window both ways. To adjust the horizontal or vertical split, drag the appropriate split bar. To adjust both split bars at once, drag where they cross. To remove a single split, double-click its split bar or drag it out of the worksheet window. To remove all splitting, double-click the split bars where they cross or choose Window | Remove Split.



Open Extra Windows to Work in Different Areas of a Worksheet Another way of working more easily in two or more areas of a worksheet or workbook is to open two or more windows containing the same workbook. To open a new window, choose Window | New Window. Excel names extra windows containing the same workbook by adding a colon and a number after the filename. For example, when you open a second window of Budget.xls, Excel renames



P:\010Comp\HowTo8\071-1\ch02.vp Thursday, August 28, 2003 11:31:29 AM



(8) / How to Do Everything with Microsoft Office Excel 2003 / Hart-Davis / 3071-1 / Chapter 2 Color profile: Generic CMYK printerHowTo-Tght profile Composite Default screen



28



How to Do Everything with Microsoft Office Excel 2003 the first window Budget.xls:1 and names the second window Budget.xls:2. You can easily switch from window to window by clicking in the target window (if the window is visible) or by using the Window menu. You can split each open window as needed, and you can hide and unhide windows as described later in this chapter. When you open multiple windows on the same workbook, you can zoom each window independently of the other. (See “Zoom In and Out,” later in this chapter, for a discussion of zooming the display.) For example, you might zoom one window out to display an overview of a worksheet while you work in close-up in another window.



Arrange Open Windows You can arrange your workbook windows by using standard techniques to resize and position the windows:



■ Click the Maximize Window button to maximize a window so that it occupies all the space in the Excel application window.



■ Click the Restore Window button to restore it to its previous, nonmaximized size. ■ Click the Minimize Window button to minimize a window. ■ Drag the edges or corners of nonmaximized windows to resize them. Drag the windows by their title bar to position them where you want them to appear.



Arrange Windows Using the Arrange Windows Dialog Box To arrange all nonminimized windows, follow these steps: 1. Choose Window | Arrange to display the Arrange Windows dialog box:



2. Select the Tiled option button, Horizontal option button, Vertical option button, or Cascade option button as appropriate:



■ Tiling sizes each nonminimized window as evenly as possible to fill the space available in the Excel window. Tiling tends to be most useful for getting an overview of which workbook windows are open. You can then close any workbook windows
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you no longer need, or minimize (or hide) other workbook windows to get them out of the way, before arranging the remaining windows horizontally or vertically.



■ The Horizontal and Vertical arrangements are good for comparing the contents of two or three windows. Horizontal is better for data laid out along rows; Vertical is better for data laid out down columns.



■ The Cascade arrangement is good for shuffling a stack of windows into an arrangement where each window is a reasonably large size but you can access any window instantly. 3. If you want the arrangement command to affect only the windows that belong to the active workbook (the one that had the focus when you issued the Window | Arrange command), select the Windows of Active Workbook check box. 4. Click the OK button to close the Arrange Windows dialog box. Excel arranges the windows as you specified.



Arrange Minimized Windows Using the Arrange Icons Command When all the open windows are minimized, the Window menu contains the Arrange Icons command rather than the Arrange command. Choose Window | Arrange Icons to arrange the window icons neatly at the bottom of the Excel window.



Compare Two Windows Side by Side You can use the Arrange Windows dialog box to position two windows alongside each other to compare their contents. But Excel also offers an option that goes one better and synchronizes the scrolling of the two windows so that you can compare their contents more easily. To compare the contents of two windows, follow these steps: 1. Activate one of the windows whose contents you want to compare. 2. Choose Window | Compare Side by Side With to display the Compare Side by Side dialog box:



3. Select the second window for the comparison. 4. Click the OK button to close the Compare Side by Side dialog box. Excel arranges the windows to occupy the Excel application window and synchronizes their scrolling.
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How to Do Everything with Microsoft Office Excel 2003 When you’ve finished comparing the windows, choose Window | Close Side by Side to revert to the previous arrangement of windows. If you have only two windows open, Excel lists the other nonactive window’s title as part of the Compare Side by Side With command—for example, Compare Side by Side with Department Staffing Projections.xls. When you issue the command, Excel arranges the windows without displaying the Compare Side by Side dialog box.



Hide a Window When you have multiple windows open, you may find a window is temporarily surplus to requirements. When this happens, hide the active window by choosing Window | Hide. This technique can help you both keep your Excel window uncluttered and protect yourself against inquisitive coworkers snooping your work. To redisplay a hidden window, follow these steps: 1. Choose Window | Unhide to display the Unhide dialog box:



2. Select the window you want to redisplay. 3. Click the OK button to close the Unhide dialog box. Excel reveals the specified window.



Zoom In and Out To make your worksheets easier to read on screen, you can zoom in and out either by selecting the appropriate item from the Zoom drop-down list on the toolbar (shown on the left in Figure 2-2) or by choosing View | Zoom and choosing the appropriate option button in the Zoom dialog box (shown on the right in Figure 2-2). The following points are worth mentioning:
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FIGURE 2-2



Use the Zoom drop-down list or the Zoom dialog box to zoom the display to make it easier to read.



■ Excel’s zoom range is from 10 percent to 400 percent. For percentages other than 25, 50, 75, 100, and 200, type the percentage into the Zoom drop-down list box or the Custom box in the Zoom dialog box.



■ The Selection item in the Zoom drop-down list and the Fit Selection option button in the Zoom dialog box zoom the worksheet to the largest size possible for the current selection. This zoom is great for concentrating on a group of key cells you’ve already selected.



■ Excel hides the cell gridlines at tiny magnifications to improve visibility.



Use Freezing to Keep Key Rows and Columns Visible If you work on worksheets that contain more data than will fit on your monitor at a comfortable size, you’ll need to scroll up and down, or back and forth, to refer to labels and headings in the leftmost columns or topmost rows of the worksheet. Such frequent scrolling can be both frustrating and a waste of time. To reduce scrolling, you can freeze specific rows and columns so that Excel keeps displaying them even though the other rows and columns scroll. For example, you could freeze column A and row 1 so that Excel would keep displaying them even when you navigated to cell IV65536. To freeze rows and columns, select the cell to the right of the column and below the row you want to freeze, then choose Window | Freeze Panes. Excel displays a heavier line along the
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FIGURE 2-3



You can freeze the leftmost columns and topmost rows of a worksheet to keep them on screen as you scroll to the depths of the worksheet.



gridlines to show where the frozen section is. The frozen section then remains in place when you scroll the rest of the worksheet as usual. Figure 2-3 shows a worksheet with column A and the top six rows frozen. (The first five rows are scrolled off the top of the screen.) To remove freezing, choose Window | Unfreeze Panes.



Set Options to Make Excel Easier to Use Splits, extra windows, zooming, and freezing can make a huge difference in the way you use Excel. But to have Excel best suit the way you work, you must configure settings on at least some of the 13 tabs in Excel’s Options dialog box (Tools | Options). In this section, you’ll learn about the options that affect the way Excel appears and behaves. There are more options than you can comfortably shake a stick at, and, inevitably, some options are more immediately useful and relevant than others. In this section, we’ll pass swiftly over the less useful and relevant options so that we can focus on the options most likely to make a difference to your work. Some categories of options affect separate parts of Excel’s functionality rather than Excel’s behavior as a whole. This book discusses these options in the section that covers their functionality instead of presenting all the options here. Here are the details of where these options are discussed:



■ The options on the Custom Lists tab enable you to create custom AutoFill lists. “Create Custom AutoFill Lists,” in Chapter 3, discusses how to use these options.
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■ The options on the Chart tab are relevant only when you’re creating charts. Chapter 13 covers creating charts and discusses these options.



■ “Troubleshoot Formulas,” in Chapter 8, explains the options on the Error Checking tab. ■ “Restrict Data and Protect Workbooks,” in Chapter 14, discusses the options on the Security tab.



Choose View Options to Customize Excel’s Visual Appearance Using the options on the View tab of the Options dialog box (Figure 2-4) can drastically change Excel’s appearance, which can make a great difference to your work with it. Which options you choose depends on the type of work you’re doing and how you prefer to go about it, but it’s worth experimenting with different combinations of the options to discover which you find most comfortable and convenient to work with.



Show Options The check boxes in the Show section of the View tab let you specify whether Excel displays the task pane, formula bar, and status bar on startup. (You can toggle the display of these options while working by choosing View | Task Pane, View | Formula Bar, or View | Status Bar.) The key option here is the Windows in Taskbar check box, which controls whether Excel displays a separate taskbar button for each open workbook or a single taskbar button for Excel.



FIGURE 2-4



Experiment with the options on the View tab to find which visual elements and cues you find most helpful.
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How to Do Everything with Microsoft Office Excel 2003 Having separate taskbar buttons for each open workbook can enable you to switch from one workbook to another more easily, but some people find that the extra clutter on the taskbar outweighs this convenience.



Comments Options The options in the Comments section let you specify how Excel displays comments attached to cells in worksheets. Your choices are to hide comments and comment indicators, display comment indicators only, or display both comment indicators and comments. This last setting is primarily useful for worksheets with few comments; worksheets with many comments can get busy with all comments displayed. Displaying only comment indicators is usually a happy medium, but you may want to hide all comment indicators to keep a complex worksheet as clean as possible while you work on it.



Objects Options The options in the Objects section let you specify how Excel displays objects in worksheets. Excel worksheets can contain a wide variety of objects—anything from charts or pictures to sounds and videos. Your choices are to display the objects, to display placeholders (blank rectangles) that indicate where the objects are, or to suppress the display of all objects. Displaying many complex objects may slow down the scrolling of worksheets, so displaying placeholders may speed up scrolling. Hiding all objects enables you to work in cells that are otherwise obscured by objects.



Window Options The options in the Window Options section let you specify which items are displayed in the window. Here’s a quick explanation of these items:



■ Page Breaks Controls whether Excel displays page breaks on worksheets. Seeing page breaks can be useful for laying out data but distracting for data entry.



■ Formulas Controls whether cells that contain formulas display the formula results (the default) or the formulas themselves. You may want to display formulas when constructing or editing a worksheet, but chances are that you’ll usually want to display their results.



■ Gridlines Controls whether Excel displays the gridlines for the worksheet, as it does by default. Seeing the gridlines is useful for most purposes, but you may want to turn off the display of gridlines when you’re laying out a form.



■ Gridlines Color If you choose to display gridlines, you can use this drop-down list to change their color from the default color (Automatic).



■ Row & Column Headers Controls whether or not Excel displays the row headers and column headers, as it does by default. You may sometimes want to turn off the display of headers to make more space available on screen or to hide the details of a collapsed outline or hidden cells or columns, but usually the headers help you keep track of which cell is active.



■ Outline Symbols Controls whether or not Excel displays outline symbols to indicate which outline sections are expanded and which are collapsed. Usually it’s useful to see
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the outline symbols, but you may want to hide them when displaying outlined spreadsheets to an audience.



■ Zero Values Controls whether Excel displays zeroes in cells that contain zero values (as it does by default) or whether Excel suppresses the display in those cells. Suppressing zero values can help you focus on nonzero values in worksheets.



■ Horizontal Scroll Bar Controls whether Excel displays the horizontal scroll bar, as it does by default. Hiding this scroll bar can save you valuable real estate on a small screen, but it reduces navigation options with the mouse.



■ Vertical Scroll Bar Controls whether Excel displays the vertical scroll bar, as it does by default. As with the horizontal scroll bar, hiding this scroll bar can save you valuable space on a small screen at the expense of easy navigation with the mouse.



■ Sheet Tabs Controls whether Excel displays the worksheet tabs at the bottom of the window, as it does by default. You may choose to hide the worksheet tabs when you don’t need to use them to move quickly from one worksheet to another. (Any workbook that includes only a single worksheet has no need for the worksheet tabs.)



Understand (and Maybe Choose) Calculation Options The Calculation tab of the Options dialog box (Figure 2-5) offers a set of options for specifying how Excel recalculates all worksheets, and a set of options for specifying how Excel handles the active worksheet.



FIGURE 2-5



Unless you have special needs, the default settings on the Calculation tab of the Options dialog box will probably do fine.
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Calculation Area Options The three option buttons in the Calculation area of the Calculation tab control how Excel calculates all worksheets. The default setting is the Automatic option button, which causes Excel to automatically recalculate all cells in a workbook when the value in any cell changes. So, by default, when you enter a new value in a cell, Excel automatically recalculates all the cells in the workbook. Normally, most of the cells won’t be affected by any change you make, so the recalculation process is so quick as to be unnoticeable. This makes Automatic recalculation the best choice for most users, because it ensures that all values in a workbook remain up-to-date no matter how many changes you make. The exception is if you’re using a workbook complex enough for recalculation to bog down your computer. For example, suppose you need to change a series of values in a physics calculation, and each value is involved in a set of complex calculations. In this case, automatic recalculation may take several seconds (or much longer) each time you enter a value in a cell, which will make for painfully slow progress. In this case, you would do better to select the Manual option button so that you could enter all the values without having to wait for each recalculation to finish before you could proceed. If you select the Manual option button, you can select or clear the Recalculate Before Save check box to control whether Excel recalculates formulas before saving the workbook. Recalculating before the save is the default and is usually a good idea, because it helps avoid someone subsequently opening the workbook and not realizing that some formula results aren’t up to date. The third option button, Automatic Except Tables, performs automatic recalculation of all formulas except those in data tables. Depending on how your data is laid out, this option may give you the best of both worlds—you can enter data in data tables without recalculation slowing down the process, but Excel will recalculate all other formulas at each change. If you choose the Automatic Except Tables option button or the Manual option button, you can force recalculation of the entire workbook at any time by clicking the Calc Now button or by pressing F9. You can force recalculation of the worksheet (rather than the workbook) by clicking the Calc Sheet button or by pressing CTRL-F9. The keyboard shortcuts are worth memorizing because you can issue them without displaying the Calculation tab of the Options dialog box. You’ll seldom need to change the Iteration options unless you need to use circular references in your formulas. (Briefly, a circular reference includes a calculation that refers to its own value.) Without iteration, circular references cause errors. If you need to use iteration, select the Iteration check box, adjust the maximum permitted number of iterations in the Maximum Iterations text box, or adjust the maximum change (per iteration) in the Maximum Change text box.



Workbook Options The Workbook Options section of the Calculation tab offers five check boxes for controlling how Excel handles recalculation in this workbook:



■ The Update Remote References check box controls whether Excel updates references to formulas that reference other applications. This check box is selected by default.



■ The Precision As Displayed check box on the Calculation tab changes the numbers in the cells to match the precision with which they’re displayed. For example, if you’re using two
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CHAPTER 2: Configure Excel to Suit Your Working Needs decimal places in a worksheet, applying this feature would change the numbers in all the cells in the workbook to using two decimal places (including any rounding involved); $44.5593 would change to $44.56, and so on. You’ll seldom need to use this feature. If you do, experiment first with a copy of your data, because the only way of undoing the change that Precision As Displayed makes is to revert to an unaffected copy of the data.



■ The 1904 Date System check box changes Excel’s serial date starting point from January 1, 1900, to January 2, 1904. Windows versions of Excel use 1900 as the starting date, while Mac versions of Excel use 1904. So when you import a workbook from Excel for the Mac, you’ll usually need to select this check box to make serial dates display the correct values. If your Excel workbooks are Windows only, you don’t need to worry about this option.



■ The Save External Link Values check box controls whether Excel saves the value of external links in the workbook. This check box is selected by default.



■ The Accept Labels in Formulas check box controls whether Excel lets you use row labels and column labels to reference cell addresses in formulas. This check box is cleared by default, but you may sometimes want to select it. “Use Range Names and Labels in Formulas,” in Chapter 8, explains when this option may be helpful and why it’s turned off by default.



Set Edit Options to Fine-Tune Editing Maneuvers The options on the Edit tab of the Options dialog box (Figure 2-6) offer fine control over Excel’s features for editing columns, rows, and cell contents. It’s a good idea to understand what these features do even if you don’t need to change the default settings immediately.



FIGURE 2-6



The options on the Edit tab of the Options dialog box can greatly change how Excel behaves as you edit worksheets.
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How to Do Everything with Microsoft Office Excel 2003 Here’s what the options do:



■ The Edit Directly in Cell check box controls whether or not you can perform editing in the cell in the worksheet as well as editing in the Formula bar. Most people find editing in the cell convenient for most purposes, and this check box is selected by default. If you prefer to restrict editing to the Formula bar, clear this check box.



■ The Allow Cell Drag and Drop check box controls whether or not you can use drag and drop to copy or move the contents of cells. This check box is selected by default. If you leave it selected, you can select or clear the Alert Before Overwriting Cells check box to control whether or not Excel warns you before overwriting cells that contain data when you perform a drag-and-drop operation.



■ The Move Selection After Enter check box lets you specify whether, and in which direction, Excel moves the selection when you press ENTER to apply an entry to a cell. The default is to move down to the next cell. You might prefer to move right (or, rarely, up or left).



■ The Fixed Decimal check box lets you make Excel format each number you enter with the number of decimal places you specify in the Places text box. This check box is cleared by default, and you’ll need to turn it on only for specialized purposes. When you use this option, Excel forces you to use the specified number of decimal places in each entry. For example, if you set three fixed decimal places and enter 1 in a cell, Excel uses the value 0.001. To enter the value 1, you enter 1000, and Excel displays it as 1.



■ The Cut, Copy, and Sort Objects with Cells check box controls whether or not Excel includes objects (for example, charts) in selections you cut, copy, or sort. This check box is selected by default.



■ The Ask to Update Automatic Links check box controls whether Excel gets your approval before updating automatic links or updates them without asking. This check box is selected by default.



■ The Provide Feedback with Animation check box controls whether or not Excel used animated visual effects to accentuate actions you’re performing. For example, when you insert a row (Insert | Row), Excel animates the process of sliding down the rows below it. Animation is on by default. Turn it off if you find it annoying or if it makes your graphics card struggle.



■ The Enable AutoComplete for Cell Values check box controls whether, when you’re entering text in a cell, AutoComplete suggests a matching item from another cell in the column once you’ve typed enough letters to identify it. For example, if you enter Madrid in cell A1, enter Malaga in cell A2, and type mad in cell A3, AutoComplete suggests Madrid to complete that cell. AutoComplete can greatly speed up entering repetitive information in columns. But if you find AutoComplete distracting, clear this check box.



■ The Extend List Formats and Formulas check box controls whether Excel applies repeated formats and formulas to new rows you add to the end of a list. This check box is selected by default and, in most cases, this feature saves time and effort. If not, clear this check box.
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■ The Enable Automatic Percent Entry check box controls whether or not Excel multiplies percentage entries by 100 before displaying them. Most people find this option helpful— it enables you to enter percentages without thinking about them. When this option is turned off, entering 1 in a Percentage-formatted cell displays 100%, entering 2 displays 200%, and so on.



■ The Show Paste Options Buttons check box controls whether, when you paste data, Excel displays the Paste Options Smart Tag, which is useful for changing the format or content of data you’ve pasted.



■ The Show Insert Options Buttons check box controls whether Excel displays the Insert Options Smart Tag when you insert cells (for example, by using an Insert | Cells command). This Smart Tag lets you change the way in which inserting the cells has affected the existing rows and columns in the worksheet.



Choose General Options The General tab of the Options dialog box (Figure 2-7) contains a wide variety of useful settings— everything from the number of files in the recently used file list to the folder that Excel opens by default. Here are details of the settings:



■ The R1C1 Reference Style check box controls whether Excel refers to cells using A1 reference style (column A, row 1) or R1C1 reference style (Row 1, Column 1). Almost



FIGURE 2-7



The General tab of the Options dialog box includes settings for adjusting the recently used file list and the folder that Excel opens by default.
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How to Do Everything with Microsoft Office Excel 2003 everybody uses A1 reference style, which is the default, but you may occasionally need to use R1C1 reference style.



■ The Ignore Other Applications check box controls whether Excel ignores Dynamic Data Exchange (DDE) requests from other applications. This check box is cleared by default.



■ The Function Tooltips check box controls whether Excel displays ScreenTips when you hover the mouse over interface items such as the toolbar buttons. This check box is selected by default.



■ The Recently Used File List check box controls whether Excel displays the list of recently used files at the bottom of the File menu and in the Getting Started task pane. The Entries text box controls the number of entries. The default setting is 4; you can set any number from 1 to 9.



■ The Prompt for Workbook Properties check box controls whether Excel displays the Properties dialog box when you first save a file. This check box is cleared by default. By entering properties rigorously in every workbook, you can make it easier to identify the contents of workbooks by searching.



■ The Provide Feedback with Sound check box controls whether Excel and the other Office applications give you audio feedback when you take actions such as scrolling, using toolbars, or displaying dialog boxes. (Turning on sound feedback in one application turns it on for all of the Office applications.) To receive sound feedback, you must download the Office Sounds add-in from the Microsoft Office Download Center and install it.



■ The Zoom on Roll with IntelliMouse check box controls whether rolling the wheel on an IntelliMouse zooms the display. This check box is cleared by default.



■ The Sheets in New Workbook text box lets you specify how many worksheets each new workbook contains. The default is 3. If you frequently have to add or delete worksheets, adjust the number accordingly. The limits are 0 and 255 sheets.



■ The Standard Font drop-down list and the Size drop-down list enable you to set the standard font and font size for workbooks.



■ The Default File Location text box specifies the folder that dialog boxes such as Open and Save As use initially. If you want Excel to display a different location, type it or paste it into this text box.



■ The At Startup, Open All Files In check box and text box let you specify a folder of templates, workbooks, or add-ins that you want Excel to open automatically when you start Excel. Some people find this option useful, but many don’t.



■ The User Name text box contains Excel’s current idea of your name. Change it if necessary.



Choose Suitable Save Options The three options on the Save tab of the Options dialog box (Figure 2-8) are crucial for keeping valuable data as safe as possible.
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FIGURE 2-8



The Save tab of the Options dialog box contains only three options, but each of them is crucial to keeping your work safe from mishaps.



These are the available options:



■ The Save AutoRecover Info Every NN Minutes check box controls whether AutoRecover automatically saves data while you’re working so as to be able to recover from a disaster such as Excel crashing or your computer losing power. This check box is selected by default, and it’s best to leave it selected. Set the value in the text box to a value that suits you. The default setting is 10 minutes, but you may want to set a shorter interval if your computer has been unstable. You may want to turn off AutoRecover if you prefer to save your documents manually every time you make an important change, or if you find that AutoRecover’s automatic saves interfere with your work or your concentration. (The status bar displays Saving AutoRecover Info and a progress readout during each AutoRecover save.)



■ The AutoRecover Save Location text box specifies the folder in which AutoRecover saves its files. The default location is the %userprofile%\Application Data\Microsoft\ Excel folder. In a network environment, an administrator may have redirected the AutoRecover save location to a network drive so that AutoRecover files can be backed up centrally along with other files. Entering a folder path correctly in the AutoRecover Save Location text box is harder than it should be, because Excel doesn’t let you browse to the folder. An easy way to enter the folder path is to open a Windows Explorer window to it, copy the path from the address bar, and paste it into the AutoRecover Save Location text box.
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How to Do Everything with Microsoft Office Excel 2003 ■ The Disable AutoRecover check box lets you disable AutoRecover for the active workbook. This check box is cleared by default. You may want to disable AutoRecover for a workbook so large that AutoRecover saves take a disruptive length of time or a workbook you don’t care so much about—or, again, if you compulsively save your workbooks manually after any change.



Choose Transition Options The options on the Transition tab of the Options dialog box (Figure 2-9) provide help with moving to Excel from Lotus 1-2-3, including using Lotus 1-2-3 Help and 1-2-3–style navigation keys. The option you’re most likely to need to change here is the Save Excel Files As drop-down list, which lets you specify the default file format in which to save workbooks. For example, you might choose XML Spreadsheet rather than the default Microsoft Excel Workbook. You can override this setting in the Save As dialog box.



Set Spelling Options The options on the Spelling tab of the Options dialog box (Figure 2-10) are as follows:



■ In the Dictionary Language, select the dictionary language—for example, English (U.S.)—to use for spell checking in Excel.



FIGURE 2-9



You can use the settings on the Transition tab of the Options dialog box to help make the move from another spreadsheet application to Excel.
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■ In the Add Words To drop-down list, select the custom dictionary to which you want to add correct spellings. The default is CUSTOM.DIC. (You can create new dictionaries from the Spelling tab of the Options dialog box in Excel or from the Spelling & Grammar tab of the Options dialog box in Word.)



■ The Suggest from Main Dictionary Only check box controls whether Excel confines its spelling suggestions to its main dictionary or whether it uses the custom dictionary as well. This check box is cleared by default.



■ The Ignore Words in UPPERCASE check box controls whether spelling checks skip words in all capitals. This check box is cleared by default.



■ The Ignore Words with Numbers check box controls whether spelling checks skip words that include numbers. This check box is selected by default.



■ The Ignore Internet and File Addresses check box controls whether spelling checks skip Internet addresses (for example, http://www.mcgraw-hill.com) and file paths. This check box is selected by default.



■ The AutoCorrect Options button on the Spelling tab displays the AutoCorrect dialog box. See “Configure AutoCorrect’s Basic Settings,” later in this chapter, for a discussion of the AutoCorrect options.



FIGURE 2-10



Choose the dictionary language and specific types of text to ignore on the Spelling tab of the Options dialog box.
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Load and Unload Add-Ins Excel includes several add-ins, optional components that you can load when you need the extra functionality that they provide. For example, the Euro Currency Tools add-in provides tools for working with the euro, which can be handy if you do business in Europe. If you need an add-in frequently, you can always load it. But in general, it’s not a good idea to load add-ins unless you need them, because they take up memory and may slow down your computer. So you should load add-ins when you need them, use them, and then unload them when you’ve finished. To load or unload an add-in, follow these steps: 1. Choose Tools | Add-Ins. Excel displays the Add-Ins dialog box:



2. Select the check boxes for the add-ins you want to load, and clear the check boxes for any loaded add-ins you want to unload. 3. Click the OK button to close the Add-Ins dialog box Once you’ve loaded an add-in, you can use its features, which may be implemented as menu commands, toolbar buttons, Wizards, or other interface elements.



Configure AutoCorrect to Save Time and Effort AutoCorrect is an automatic-correction feature that watches as you type and substitutes predefined replacement text when you type a group of characters that match one of its entries. AutoCorrect cannot only save you the awkwardness of typos and some basic grammatical errors in your spreadsheets, but it also can make data entry faster and more consistent. It’s well worth spending a few minutes understanding what AutoCorrect does and how it can help your work. AutoCorrect is implemented in most of the Office applications, with text-only AutoCorrect entries stored in a central location so each application can access them. (Word can also use



P:\010Comp\HowTo8\071-1\ch02.vp Thursday, August 28, 2003 11:31:33 AM



(8) / How to Do Everything with Microsoft Office Excel 2003 / Hart-Davis / 3071-1 / Chapter 2 Color profile: Generic CMYK printerHowTo-Tght profile Composite Default screen



CHAPTER 2: Configure Excel to Suit Your Working Needs



Add the Add-ins to Your Installation of Office If your computer has a complete installation of Office, the add-ins will be installed; if it has a custom installation, they may be. If you need to install the add-ins, follow these steps: 1. Choose Start | Control Panel | Add or Remove Programs. 2. Select Microsoft Office 2003 and click the Change button. 3. Click Add or Remove Features. 4. Select the Choose Advanced Customization of Applications option button and click the Next button. 5. On the Advanced Customization sheet, expand the Excel item, then expand the Add-ins item. 6. For each add-in you want to load, choose the Run from My Computer option. 7. Click the Update button to update your Office installation.



formatted AutoCorrect entries, which it doesn’t share with the other applications.) The entries are stored in the MSOnnnn.acl file, where nnnn is the numeric designation for the localization of Office you’re using, in the %userprofile%\Application Data\Microsoft\Office folder, where %userprofile% is the path to your user profile (for instance, C:\Documents and Settings\Jane Petersen\Application Data\Microsoft\Office). For example, U.S. English AutoCorrect entries are stored in the MSO1033.acl file. If you use AutoCorrect extensively, back up your .ACL file. If you use multiple computers, you may want to copy the .ACL file from one computer to another so you don’t need to re-create AutoCorrect entries manually.



Configure AutoCorrect’s Basic Settings To configure AutoCorrect, choose Tools | AutoCorrect Options to display the AutoCorrect tab of the AutoCorrect dialog box (Figure 2-11). Choose settings as appropriate:



■ The Show AutoCorrect Options Buttons check box controls whether Excel displays Smart Tags in worksheets for items that AutoCorrect has replaced. The Smart Tag gives you a visual indication of each AutoCorrect correction and enables you to undo a correction easily.
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FIGURE 2-11



Configure AutoCorrect, and create and delete AutoCorrect entries, on the AutoCorrect tab of the AutoCorrect dialog box.



■ The Correct TWo INitial CApitals check box controls whether or not AutoCorrect lowercases the second of two initial capitals. AutoCorrect comes with some exceptions built in (such as “COs” and “JScript”), and you can add extra exceptions as necessary by clicking the Exceptions button and working on the INitial CAps tab of the AutoCorrect Exceptions dialog box.



■ The Capitalize First Letter of Sentences check box controls whether AutoCorrect capitalizes the first letter of everything it takes to be a sentence. Generally this feature works well, but sometimes you may disagree with what AutoCorrect considers to be a sentence. (This tends to be more of a problem with Word than with Excel.)



■ The Capitalize Names of Days check box controls whether AutoCorrect capitalizes the names of days. Usually this option is useful for speeding up data entry.



■ The Correct Accidental Use of cAPS LOCK Key check box controls whether AutoCorrect attempts to detect when you’ve mistakenly switched on the Caps Lock key. AutoCorrect switches off the key and changes the case of the letters that should have been the opposite case.



■ The Replace Text As You Type check box controls AutoCorrect’s main feature— scanning for entries as you type and replacing them with their designated replacement text. You’ll seldom want to clear this check box, unless you’re using someone else’s account on a computer and you find AutoCorrect unexpectedly replacing text you type.
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By leaving this check box selected, and by creating as many AutoCorrect entries as is reasonable, you can make AutoCorrect shoulder part of the burden of entering text in your worksheets.



2



Create and Delete AutoCorrect Entries AutoCorrect comes with a large number of built-in entries that range from simple typos (for example, abotu instead of about) to basic grammatical mistakes (for example, may of been instead of may have been) and some symbols (for example, AutoCorrect corrects (c) to a copyright symbol, ©). You can add as many custom entries as you need, and you can replace or delete the built-in entries if you find them inconvenient. Creating and deleting AutoCorrect entries could hardly be easier:



■ To create an entry, enter the entry text in the Replace text box and the replacement text in the With text box. (You can paste copied text into either of these text boxes.) Either click the Add button to add the entry and keep the AutoCorrect dialog box open, or click the OK button to add the entry and close the AutoCorrect dialog box. If an AutoCorrect entry with this name already exists, AutoCorrect prompts you to decide whether to overwrite it.



■ To delete an entry, select it in the list by scrolling or typing its first few letters, and then click the Delete button.



■ To change the name of an existing AutoCorrect entry, select it in the list to enter its name in the Replace text box and its contents in the With text box. Type the new name and click Add to create a new entry with that name and contents. Then delete the old entry.



How AutoCorrect Works As you type, AutoCorrect examines each character. When you type a character that typically means you’ve finished typing a word, AutoCorrect compares the word (or, more precisely, the group of characters) against its list of entries. If the word matches an entry, AutoCorrect substitutes the replacement text for the word. If the word doesn’t match an entry, AutoCorrect checks the word and its predecessor together to see if they match an entry. If so, AutoCorrect substitutes the replacement text. If not, AutoCorrect checks those two words with the word before them—and so on until it has checked all the complete words in the preceding 31 characters, at which point it gives up. AutoCorrect entries can be up to 31 characters long and can contain spaces and punctuation. The replacement text for an entry can be up to 255 characters long—plenty to
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enable you to enter a short paragraph or two. (If you try to use more than 255 characters, AutoCorrect warns you that it’ll need to shorten the replacement text.) No entry’s name should be a real word in any language you use; otherwise, AutoCorrect will replace that word each time you try to use it. The exception is if you want to prevent yourself from using a particular word. For example, if the word purchase sends your boss into conniptions, you can define AutoCorrect entries to change words based on purchase (such as purchase, purchases, purchased, purchasing, and so on) to their counterparts based on buy. AutoCorrect will then censor your language use gently and automatically. AutoCorrect considers various characters to mean you’ve finished typing a word. As you’d guess, these characters include spaces, punctuation, tabs, and carriage returns. You might not guess that various symbols (such as % and #) trigger AutoCorrect checks, but they do.



Undo an AutoCorrect Correction When AutoCorrect makes a correction that you don’t want to keep, you can undo it by issuing an Undo command (for example, press CTRL-Z or click the Undo button on the Standard toolbar). But if you were typing fast at the time when AutoCorrect chose to kick in, you might need to undo a lot of typing (or other editing) before you can undo the AutoCorrect action. To make corrections easier, Word, PowerPoint, Excel, and Outlook track corrections applied by AutoCorrect. When you hover your mouse pointer over an AutoCorrect correction, the application displays an AutoCorrect Options Smart Tag that you can click to display a menu of AutoCorrect options. Your choices vary according to the context but include the option to undo this instance of the correction and to stop correcting this AutoCorrect entry (for the future).



Use AutoCorrect Most Effectively AutoCorrect is wonderful for fixing typos as you type. But if you enter much text in your worksheets, define AutoCorrect entries for long words, complex terms, phrases, or sentences you enter frequently. By doing so, you can both accelerate your typing and avoid typos. You can also use AutoCorrect for enforcing consistency. For example, if you work for the vice president for sales and marketing but tend to write the title as “Vice President of Sales and Marketing,” create an AutoCorrect entry to change “Vice President of Sales and” to “Vice President for Sales and.” AutoCorrect will then correct the error for you automatically when you make it. (Note that the phrase is too long to include “Marketing” in the AutoCorrect entry. But this has a hidden benefit—AutoCorrect will fire as you go on to type “Marketing.” Otherwise, if the entry included “Marketing” and you typed the wrong phrase and no further, AutoCorrect wouldn’t fire.) To continue the previous example, you should create a shorter AutoCorrect entry (called something like “bossjob”) that expands to your boss’s correct title. The shorter entry will save you keystrokes and capitalization.
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If you create many AutoCorrect entries, remembering entries that you use less frequently may be a problem. But there’s nothing to stop you from creating multiple entries for the same replacement text.



Adding and Deleting AutoCorrect Exceptions You can also define AutoCorrect exceptions—terms that you don’t want AutoCorrect to automatically correct. Excel supports first-letter exceptions (for abbreviations such as corp. and for similar terms that end with punctuation) and initial-caps exceptions (for example, IDs). To add and delete exceptions, click the Exceptions button on the AutoCorrect tab of the AutoCorrect dialog box, and work in the AutoCorrect Exceptions dialog box:
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How to… ■ ■ ■ ■ ■ ■ ■



Create a workbook Save a workbook Create and save a template Enter data in worksheets Use AutoFill to enter data series quickly Use Find and Replace Recover your work if Excel crashes



N



ow that you know how to navigate Excel’s interface, and you’ve chosen such customization options as necessary to make your work in Excel as smooth and comfortable as possible, you’re ready to create workbooks of your own. This chapter shows you how to create and save workbooks and the templates on which workbooks are based, how to enter data in worksheets manually and by using Excel’s AutoFill feature, how to use Excel’s Find and Replace features, and how to recover your work if Excel crashes.



Create a New Workbook Each workbook is based on a template—a file that’s used as the basis for the workbook. A template can contain anything from basic worksheets with minimal modifications from Excel’s defaults to a complete complex form with text, formatting, and perhaps VBA macros, that requires the user to do nothing more than fill in a few pieces of information to complete the form. (For example, you might use such a template for an invoice, a business proposal, or a psychometric evaluation.) When you need a new workbook, you have several options, which are discussed in the following sections:



■ You can create what Excel calls a “blank workbook”—a workbook with extremely basic settings. If you’ve just launched Excel by using the Start menu, Excel will have automatically created a blank workbook for you. By default, Excel creates blank workbooks without actually using a template. However, if you can create a template called Book.xlt in the appropriate folder, Excel then uses it as the template for default worksheets and workbooks. By creating and formatting Book.xlt, you can apply default formatting and contents to each new workbook and worksheet you create. See “Change the Formatting on New Default Worksheets and Workbooks,” in Chapter 4, for instructions.
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■ You can create a new workbook by cloning an existing workbook. ■ You can create a new workbook based on a template.



Create a New Blank Workbook The easiest way to create a new blank workbook is to click the New button on the Standard toolbar or press CTRL-N. There are a couple of other ways to create a new blank workbook:



■ Display the New Workbook task pane (as described in “Create a New Workbook Based on an Existing Workbook,” next) and click the Blank Workbook hyperlink.



■ Display the Templates dialog box (as discussed in “Create a New Workbook Based on a Template,” a little later in this chapter), select the Workbook icon on the General tab, and click the OK button. Usually, these ways are so much slower and clumsier than clicking the New button that they’re not worth using, but you may find them useful occasionally.



Create a New Workbook Based on an Existing Workbook Once you’ve created and formatted a workbook to your (or your boss’s) satisfaction, you can reuse it as the basis for other workbooks that use the same layout and formatting. Even if you need to make significant changes to the data in the new copy of the layout, you should be able to save considerable time and effort over creating the new workbook from scratch. You can reuse an existing workbook in any of three ways:



■ Use the New from Existing Workbook dialog box to create a new workbook based on an existing workbook, as described in this section. This is an informal but effective way of reusing material.



■ Open the workbook as usual, and then use a Save As command to save a copy of the workbook under a different name for reuse. This method of reuse is even more informal but equally effective.



■ Create a template from the workbook or, better still, create a template from scratch. See “Create and Save a Template,” later in this chapter, for instructions.
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How to Do Everything with Microsoft Office Excel 2003 To create a new workbook based on an existing workbook, follow these steps: 1. Choose File | New to display the New Workbook task pane:



2. Click the From Existing Workbook hyperlink to display the New from Existing Workbook dialog box. This dialog box is a common Open dialog box with a different name. 3. Navigate to the folder that contains the workbook, and then select the workbook. 4. Click the Create New button to close the New from Existing Workbook dialog box and create a new workbook based on the workbook.



Create a New Workbook Based on a Template You can also create a new workbook based on a template—a template that you or your company has created, a template supplied with Excel, or a template that you download from the Microsoft Office Online web site. See the next section for instructions on downloading templates from this site. See “Create and Save a Template,” later in this chapter, for instructions on creating your own templates.



Create a New Workbook Based on a Local Template To create a new workbook based on a local template, follow these steps: 1. Choose File | New to display the New Workbook task pane.
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2. Click the On My Computer hyperlink in the Templates area to display the Templates dialog box:



3



In a default configuration, the Templates dialog box displays the General tab and Spreadsheet Solutions tab. You (or an administrator) can add additional tabs by creating folders within your Templates folder. The illustration of the Templates dialog box shows one tab added—the Acme Heavy Industries tab. 3. Click the appropriate tab to display its contents. 4. Select the icon for the template. If necessary, use the Preview pane to check that you’ve selected the right template. 5. Click the OK button to close the Templates dialog box and create a new document based on the template.



Create a New Workbook Based on a Web-Site Template If you have access to templates stored on a web site or a SharePoint site, create a new workbook as follows: 1. Choose File | New to display the New Workbook task pane.



P:\010Comp\HowTo8\071-1\ch03.vp Thursday, August 28, 2003 11:35:49 AM



(8) / How to Do Everything with Microsoft Office Excel 2003 / Hart-Davis / 3071-1 / Chapter 3 Color profile: Generic CMYK printerHowTo-Tght profile Composite Default screen



56



How to Do Everything with Microsoft Office Excel 2003 2. Click the On My Web Sites hyperlink to display the New from Templates on My Web Sites dialog box:



3. Select the network place (for example, a SharePoint site) and click the Open button to display its contents. If Excel displays the Connect To dialog box demanding your user name and password for the site, supply them and click the OK button. 4. Select the template and click the Create New button to create a new workbook based on it.



Download a Template from Microsoft Office Online To create a new workbook based on a template from Microsoft Office Online, click the Templates Home Page hyperlink. (Alternatively, if you’ve displayed the Templates dialog box, click the Templates on Office Online button on either tab.) Excel opens an Internet Explorer window to the Templates area of the Microsoft Office Online web site. Browse the available templates and, when you find one you want, click the Download Now button. You’ll need to accept the Terms of Use policy before you can proceed. The first time you download a template from Microsoft Office Online, you must install the Microsoft Office Template and Media Control on your computer. This is a small program (technically, an ActiveX control) that manages the process of downloading items from the Microsoft Office Online web site. Windows displays a Security Warning dialog box (shown here) to prompt you to accept the Microsoft Office Template and Media Control. Click the Yes button. Leave the Always Trust Content from Microsoft Corporation check box cleared unless you’re certain you want to install content signed by Microsoft digital certificates without being prompted. (Because some
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Microsoft digital certificates are known to have been pirated, it’s best to review each Microsoftsigned item you download rather than allow your computer to accept them all trustingly.)



3



If a download from Microsoft Office Online fails, make sure that cookies are enabled in your browser. After downloading the template, your browser activates Excel and creates a new document based on that template.



Divide Data Among Workbooks and Worksheets More than most other applications, Excel faces you with a choice of how to divide your data among workbooks and worksheets. Because each workbook can contain up to 256 worksheets, you might be tempted to keep all of your data in a single workbook, allotting each subject to a different worksheet. That way, you need to open only one workbook to have access to all your data. Even if your work involves a small enough quantity of data to fill only a handful of worksheets, keeping all of your data together is usually a mistake. Quite apart from increasing the risk of data loss or damage through a user error (for example, accidental deletion) or a hardware or software mishap, having all of your data together makes it hard to share some of the data with other people without sharing all of it. There are various ways around this—for example, you can copy or move a worksheet to a different workbook, or you can save a copy of the master workbook and delete all the sheets you don’t want to share—but you’ll be better off keeping separate data in separate workbooks in the first place.
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How to Do Everything with Microsoft Office Excel 2003



In general, try to follow these rough guidelines:



■ Divide data by subject, and use a different workbook for each subject. For example, you might keep a workbook for your company’s (or department’s) sales, another workbook for staff details and salaries, another workbook for budgeting, and so on.



■ Within each subject, divide the data into logical categories, and use a separate worksheet for each category. For example, in a staff workbook, you might keep staff address information on one worksheet, salary information on a second worksheet, and performance information on a third worksheet. (You might prefer to keep a separate worksheet for each employee, but doing so would make it much more difficult to sort employee details or compare employee performance.) Similarly, you might use separate worksheets for months, quarters, or years in a budget workbook. If you’re using Excel in your work for a company of any size, you’ll probably find that the decisions for dividing data among workbooks and worksheets have been taken already. If you get to make such decisions, be prepared to move worksheets to different workbooks when the need arises. See “Move and Copy Worksheets,” in Chapter 4, for instructions. See Chapter 9 for a discussion of considerations for creating databases (long or complex lists) in Excel.



Save a Workbook In theory, you can leave a workbook unsaved until you’ve finished working with it and are ready to close it. In practice, it’s a good idea to save your work as soon as you’ve made changes that you wouldn’t want to have to make again. This is in case a problem occurs with Excel, Windows, or your computer (for example, a power outage or a hardware failure) and loses your work. To begin with, you’ll need to save the workbook for the first time, which involves assigning a file name and specifying the folder in which to save the file. After that, you can save changes to the workbook by issuing a Save command. At times, you may need to save a workbook under a different name (making a copy of it) or in a different format (for example, for sharing with someone who uses a different spreadsheet application). And for some workbooks, you may need to enter property information to make the workbook more easily identifiable via searching. The following sections show you how to take these actions.



Save a Workbook for the First Time To save a workbook for the first time, follow these steps: 1. Issue a Save command in any of the following ways to display the Save As dialog box. Figure 3-1 shows the Save As dialog box with choices made and key items labeled.



■ Click the Save button on the Standard toolbar.
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■ Choose File | Save. ■ Press CTRL-S or F12. 2. If you don’t want to save the file in the current folder, navigate to the folder you want to use:



■ Click a button in the Places Bar to navigate quickly to that place. For example, click the My Network Places button to display your My Network Places folder.



■ Display the Save In drop-down list and select the drive or folder. ■ Double-click a folder displayed in the main area of the dialog box to open it. Click the Up button to move up to the parent folder of the current folder; click the Back button to return to the previous folder. 3. Enter the file name in the File Name text box:



■ The file name can be up to 255 characters in length including the folder path (the drive and all the folders leading to this folder).



■ In practice, most people find they can create usefully descriptive names by using 20 to 50 characters.



Places bar



Save In drop-down list



File Name text box FIGURE 3-1



Save As Type drop-down list



Use the Save As dialog box to specify the file name and location for a workbook or template.
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How to Do Everything with Microsoft Office Excel 2003 ■ Very long file names can make Windows Explorer windows and common dialog boxes (for example, the Open dialog box) hard to navigate, and listings such as the recently used files list on Excel’s File menu have to truncate the names to display them. 4. In the Save As Type drop-down list, choose the appropriate format:



■ Choose the Microsoft Excel Workbook item for a normal workbook. This is the default format for Excel, so this item should be selected already.



■ Choose the Template item when creating a template. ■ Choose a different format when necessary. For example, if your company uses XML for data exchange, you may need to save workbooks in the XML Spreadsheet format. (Chapter 15 discusses XML.) 5. Click the Save button to dismiss the Save As dialog box and save the file. When you dismiss the Save As dialog box, Excel may display the Properties dialog box automatically to encourage you to enter property information. See “Enter Property Information for a Workbook,” later in this chapter, for a discussion of this topic.



Save Changes to a Previously Saved Workbook After saving a workbook as described in the previous section, you can save any unsaved changes to the workbook instantly by clicking the Save button on the Standard toolbar, choosing File | Save, or pressing CTRL-S or SHIFT-F12.



Save a Workbook Under a Different Name You can save a previously saved workbook under a different name by choosing File | Save As or pressing F12 to display the Save As dialog box again. Specify a new file name (or folder; or both) and then click the Save button. This technique is useful for making a copy of a file you’ve been working on when you realize you don’t want to overwrite the original file with the changes you’ve made—for example, when you start tweaking a planning budget and get carried away with the changes you make. This technique is also useful for read-only files—you can’t save changes to the existing files anyway, but you can save them under a different name. You can also use this technique as a quick way of making a copy of a file without leaving Excel. The more formal alternative is to use Windows Explorer to copy the file, rename the copy from its default name if necessary, and then double-click the copy to open it in Excel (if you need to work in the file). These two techniques have almost the same result—a file with the same contents but a different name—but not quite. The difference is that creating a copy in Windows Explorer creates a file identical with the original file, whereas creating a copy by using a Save As command creates a new file with the same contents as the original file (assuming you haven’t yet changed them) but with a different Modified date stamp. In most business or home contexts, the different date stamp is of little consequence, but in some ticklish situations, it may be better to create a copy that has the same date stamp as the original file.
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Save a Workbook in a Different Format By default, Excel saves files in its own Microsoft Excel Worksheet format unless you choose to override the default temporarily or permanently. Excel also lets you save workbooks in other formats (such as those that various versions of Lotus 1-2-3 use) for when you need to share data with people who use different spreadsheet applications. When you save a workbook in a non-Excel format, data and basic formatting should be saved without a problem, but complex formatting and advanced features may be stripped from the workbook during the conversion. So don’t use a non-Excel format for workbooks unless you must; and if you must, test the required format with noncritical information first in case anything vital disappears from the workbook. To save a workbook in a different format, choose the format in the Save As Type drop-down list in the Save As dialog box. Excel automatically changes the extension on the file to suit the format, so if you’re using a Save As command to save a previously saved workbook in a different format, you won’t need to change the file name. If you usually or always need to save a file in another format than Excel’s native format, you can make Excel use that format as the default for new workbooks you save. To do so, choose Tools | Options to display the Options dialog box, click the Transition tab, select the file type in the Save Excel Files As drop-down list, and then click the OK button. Excel doesn’t use this default format when you’re using a Save As command to save a workbook you’ve already saved in another format.



Enter Property Information for a Workbook To make workbooks easier to identify via searches, and to help the Windows Indexing Service to store the appropriate key information about workbooks, you can enter property information by using the Properties dialog box. You can display the Properties dialog box at any time by choosing File | Properties. You can also have Excel display the Properties dialog box the first time you save each file, which encourages you to enter the property information at a relatively convenient time. To make Excel display the Properties dialog box, choose Tools | Options to display the Options dialog box, select the Prompt for Workbook Properties check box on the General tab, and click the OK button. The Properties dialog box contains five tabs, which are discussed here.



General Tab Properties The General tab contains basic information about the file: its type (for example, Microsoft Excel Worksheet); the folder it’s located in; its size; its MS-DOS name (in the 8.3 format—for example, ACMEPR~1.XLS); the dates it was created, last modified, and last accessed; and the status of its Read Only, Hidden, Archive, and System attributes. You can’t manipulate any of this information directly on this tab.
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How to Do Everything with Microsoft Office Excel 2003



Summary Tab Properties The Summary tab (Figure 3-2) contains Title, Subject, Author, Manager, Company, Category, Keywords, Comments, and Hyperlink Base fields. Excel automatically fills in the author information from the Author property of the template or, if that’s blank, with your user name. Excel automatically fills in the Company field with the registered organization that’s assigned to the copy of Windows you’re using. These fields are self-explanatory except for Hyperlink Base, which enables you to specify the base address for all of the hyperlinks in the workbook. For example, if you enter http://www.acmeheavyindustries.com/ in the Hyperlink Base text box, you can then create a hyperlink to http://www.acmeheavyindustries/com/examples/example1.html by entering examples/example1.html rather than the full address.



Statistics Tab Properties and Content Tab Properties The Statistics tab contains details on when the workbook was created, last saved, last modified, last accessed, and last printed as well as on the person it was last saved by, the revision number, and the total time spent editing it. The Contents tab provides a list of document contents, such as the worksheet names and the names of named ranges.



FIGURE 3-2



You can enter key information on the Summary tab of the Properties dialog box to make workbooks easier to identify without opening them.
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3



FIGURE 3-3



You can enter further identifying details for workbooks on the Custom tab of the Properties dialog box.



Custom Tab Properties The Custom tab (Figure 3-3) contains a variety of predefined properties that you can fill in. You can create custom properties by typing their names in the Name text box. You can also assign to a property the contents of the first cell in a named range in the workbook. This capability enables you to store the contents of specific cells automatically in the properties and thus have them indexed along with the other property information. To add a property, follow these steps: 1. Select the property in the Name list, or type a new name to create a custom property. 2. In the Type drop-down list, select the appropriate type for the property: Text, Date, Number, or Yes or No. This choice isn’t relevant if you’re linking the property to a range in the workbook. 3. Enter the data for the property as appropriate:



■ For a Text, Date, or Number value, type it in the Value text box. ■ For a Yes or No choice, select the Yes option button or the No option button.
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How to Do Everything with Microsoft Office Excel 2003 ■ For information contained in a named range in a worksheet in the workbook, select the Link to Content check box. Excel displays a Source drop-down list that contains the named ranges in the workbook. Select the range from this list. 4. Click the Add button. Excel adds the property and data to the Properties list box. A property linked to a range displays a chain symbol beside it, as the Project property in Figure 3-3 does. To delete a field, select it in the Properties list box and click the Delete button.



Save the Entire Workspace Instead of just saving the workbooks you’re using, you can save your entire workspace—the workbooks that are open and the way they’re arranged, together with other settings that don’t otherwise persist from one Excel session to another. Saving a workspace is great when you use multiple workbooks, multiple windows, or both in the course of your work. If you tend to have only a single workbook and window open at a time, saving your workspace is unlikely to help you much. To save your workspace, choose File | Save Workspace, specify a file name and folder in the Save Workspace dialog box, and click the Save button. Workspace files use the extension .XLW, and Excel suggests the default name resume.xlw for each workspace you save. If you use this default name, you automatically overwrite each previously saved workspace with the latest workspace you save. You may prefer to enter another name so that you can save multiple workspaces. Workspace files contain only the data about the workspace, not copies of the workbooks in it, so the files are very small and won’t eat up your disk space. After you dismiss the Save Workspace dialog box, Excel prompts you to save any workbooks that contain unsaved changes. The easiest way to open a workspace file is to choose it from the recently used area at the bottom of the File menu. You can also open a workspace file from the Open dialog box (File | Open). The All Microsoft Excel Files filter includes workspace files, but you can reduce the listing to only workspace files by choosing the Workspace item in the Files of Type drop-down list. If you save your workspace frequently, you may want Excel to open your last saved workspace automatically when you launch it. To do so, save the workspace file in a folder of its own, and enter the path to that folder in the At Startup, Open All Files In text box on the General tab of the Options dialog box (Tools | Options). Don’t save in this folder any files other than those you want opened for every Excel session.



Create Your Own Templates Excel ships with a small variety of templates built in, and, as you saw earlier in this chapter, you can download further templates from the Microsoft Office Online web site. You can create as many of your own templates as you need, either starting from scratch or basing them on an existing workbook or template. If you work for a company, chances are that the company will
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provide you with templates that its developers and users have created to meet the company’s business needs.



Understand What Templates Are and What They’re For A template file is the same as a workbook file except that the template file uses the .XLT extension instead of the workbook’s .XLS extension. You can create a template simply by changing a workbook’s extension from .XLS to .XLT in Windows Explorer or another file-management program if you choose. As you saw earlier in this chapter, you can base a new workbook on an existing workbook— so you might reasonably ask why you need templates at all. The answer is that there’s no absolute need to use templates, but keeping templates separate from workbooks tends to be cleaner and neater than basing new workbooks on existing workbooks and replacing or excising the parts that aren’t relevant. By making your templates contain just the basic information for a workbook, you can avoid awkward errors such as forgetting to delete irrelevant information from a workbook you’ve based on an existing workbook.



Understand Where Templates Are Stored Excel keeps its templates in the %userprofile%\Application Data\Microsoft\Templates folder. If you’re using Excel on a corporate network, an administrator may have redirected the Templates folder to a different location—for example, on a network drive—so that your templates can be backed up centrally.



Create and Save a Template To create a template, create a workbook in any of the ways covered earlier in this chapter: create a new blank workbook, create a workbook based on an existing workbook, or create a workbook based on a template. Set up the template so that it contains the data and formatting you want. Depending on the type of task it’s intended to accomplish, a template might contain anything from a little cell formatting to a full layout that needs only a few cells filling in to become a printable document. To save a template, follow these steps: 1. Display the Save As dialog box in any of the ways discussed in the previous section. For example, if you’re saving a file for the first time, choose File | Save. If you’re saving an existing file under a different name, choose File | Save As. 2. In the Save As Type drop-down list, select the Template entry. Excel changes the folder to your Templates folder to help you save the template in the right place. (If you need to save the template in another folder, navigate to that folder now.) 3. Type the name for the template in the File Name text box. 4. Click the Save button to close the Save As dialog box and save the template.
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How to Do Everything with Microsoft Office Excel 2003 After saving the template, close it (for example, choose File | Close), then issue a File | New command and create a new workbook based on the template to check that the template has the contents you expect and that it works satisfactorily. For most templates, it’s helpful to save a preview picture so that the user can get a visual impression of the template from the Preview pane in the New dialog box. To save the preview picture, choose File | Properties, select the Save Preview Picture on the Summary tab of the Properties dialog box, and click the OK button. Saving the preview picture increases the file size somewhat, but for templates, it’s usually worth doing.



Enter Data in Worksheets There are three main ways of entering data in worksheets: by typing data in manually, by using drag and drop to move or copy existing data, and by pasting in existing data that you’ve cut or copied. The following sections discuss these methods.



Enter Data Manually You can enter data in a cell by selecting the cell, typing the entry, and then pressing ENTER or clicking the Enter button. Pressing ENTER moves the active cell to the next cell in the direction specified by the Move Selection After Enter option on the Edit tab of the Options dialog box. (The default direction is Down.) Alternatively, move to another cell by clicking in it, by using one of the arrow keys (↑, ↓, ←, or →), or by pressing TAB (to move right), SHIFT-TAB (to move left), or SHIFT-ENTER (to move the opposite way to that given by ENTER). When entering data, you can work in either the cell itself (the default position of the insertion point) or in the Formula bar (by clicking there). Entering data in the cell itself tends to be more straightforward, because you can see where the data will appear in the worksheet and whether it will fit in the cell. Entering data in the Formula bar is useful for long or complex entries for which a lack of space in the cell itself might prove distracting. Excel also offers the following techniques for speeding up data entry:



■ To enter data in a range of cells, select the range, type the entry, and then press CTRL-ENTER.



■ To enter data in multiple worksheets at once, CTRL-click the worksheet tabs to select the worksheets, and then enter the data. You can combine this technique with CTRL-ENTER to enter data in a range of cells on multiple worksheets at once. “Use AutoFill to Enter Data Series Quickly,” later in this chapter, explains how to use Excel’s AutoFill feature to enter lists and series of data quickly in ranges of cells. Chapter 7 explains how to enter functions in cells, and Chapter 8 discusses how to enter formulas. To delete the existing contents of a cell or range, select that cell or range and press DELETE. To replace the existing contents of a cell, simply create a new entry over the existing contents of the cell. To edit the existing contents of a cell, double-click the cell. Alternatively, move to the
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cell and press F2. You can then edit the text either in the cell itself (the default) or in the Formula bar (by clicking there). Once you’re editing the contents of a cell, the ← and → keys move the insertion point right and left, so you can’t use these keys (or ↑ or ↓) to enter the entry. Instead, you need to press ENTER, press TAB, click the Enter button, or click in another cell.



Undo an Action As in many Windows applications, you can undo actions in Excel. To undo an action, issue an Undo command in one of the following ways:



■ Press CTRL-Z. ■ Choose Edit | Undo Action Name (for example, Undo Typing ‘Bermuda’ in E13). ■ Click the Undo button on the Standard toolbar to undo a single action. To undo multiple actions, click the drop-down button, and then choose the action up to which you want to perform the undo in the resulting list.



But unlike Word, which can undo an impressively long sequence of actions, Excel can undo only 16 actions by default—and even those 16 actions won’t always be available to you. Some actions in Excel can’t be undone, but Excel doesn’t warn you before clearing the Undo buffer, so you may find yourself unable to undo actions. So if you suspect that you may need to undo an action, decide whether or not to undo it before taking any further actions. When Undo falls short, you can sometimes achieve the effect of undoing actions by closing the file without saving changes, thus reverting to the last saved version of the file. The catch is that, unless you can remember exactly when you last saved the file, you may lose more work than you had bargained for.
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Increase the Number of Undo Levels in Excel If you’re willing and able to edit the Registry on your computer, you can change Excel’s number of Undo levels. Before you edit the Registry, make sure you understand what it is and what problems you can cause by tampering with it. Briefly, the Registry is a giant hierarchical database of settings for Windows and the applications running on it. By damaging the Registry, you can stop Windows from working at all. (Consult a Windows book for details.) To change the number of Undo levels, follow these steps: 1. Choose Start | Run to display the Run dialog box. 2. Enter regedit and press ENTER to launch Registry Editor. 3. Navigate to the HKEY_CURRENT_USER\Software\Microsoft\Office\11.0\Excel\Options subkey. 4. Right-click in the right pane and choose New | DWORD Value. Registry Editor creates the new value with a name such as New Value #1 and selects this name for editing. 5. Type the name UndoHistory over the default name and press ENTER to apply the name. 6. Press ENTER to display the Edit DWORD Value dialog box:



7. In the Base group box, make sure the Decimal option button is selected. 8. In the Value Data text box, enter the number of Undo levels you want—anywhere from 0 to 100. 9. Click the OK button to close the Edit DWORD Value dialog box. 10. Choose File | Exit to close Registry Editor. 11. Close Excel if it’s running, and then restart it to make the changes take effect.
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Redo an Undone Action If you’ve undone one or more actions, you should be able to redo them by issuing a Redo command in any of the following ways:



■ Press CTRL-Y. ■ Choose Edit | Redo Action Name (for example, Redo Clear). ■ Click the Redo button on the Standard toolbar to redo a single action. To redo multiple actions, click the drop-down button, and then choose the action up to which you want to perform the redo in the resulting list. The number of Redo levels corresponds to the number of actions you’ve undone that can be redone. If you increase the number of Undo levels as described in the sidebar, the number of Redo levels also increases, although you won’t see this change until you’ve undone more than 16 redoable actions.



Enter Data Using Drag and Drop You can also enter data by using drag and drop (unless you’ve cleared the Allow Cell Drag and Drop check box on the Edit tab of the Options dialog box). Here’s how drag and drop works:



■ Move the mouse pointer over one of the borders of the selection to produce the drag and drop pointer. (Don’t click in the selection, because doing so will select the cell you click.)



■ Drag and drop to move the selection. CTRL–drag and drop to copy the selection. ■ Right–drag and drop to display a shortcut menu offering options such as Move Here, Copy Here, Copy Here as Values Only, Copy Here as Formats Only, Link Here, Create Hyperlink Here, Shift Down and Copy, Shift Right and Copy, Shift Down and Move, Shift Right and Move, and Cancel. Choose the appropriate option as needed. Copying values (rather than formulas) is often useful, as is copying formatting. (You can also use the Format Painter to copy formatting.)



P:\010Comp\HowTo8\071-1\ch03.vp Thursday, August 28, 2003 11:53:43 AM



3



(8) / How to Do Everything with Microsoft Office Excel 2003 / Hart-Davis / 3071-1 / Chapter 3 Color profile: Generic CMYK printerHowTo-Tght profile Composite Default screen



70



How to Do Everything with Microsoft Office Excel 2003



Enter Data with Paste, Paste Options, and Paste Special You can cut, copy, and paste data from the Windows Clipboard or the Clipboard task pane much as in the other Office applications but with the following variations:



■ When you copy an item, Excel displays a flashing border around it to indicate that the item is available for pasting. To paste a single time without using the Clipboard task pane, select the destination and press ENTER; Excel removes the flashing border and clears the item from the Clipboard. To paste multiple times, issue a Paste command (for example, CTRL-V). Excel maintains the flashing border until you clear it by pressing ESC.



■ When you paste the contents of multiple cells, Excel uses the active cell as the top-left corner of the destination range. So you don’t need to select the whole of the destination range, just its top-left cell.



■ When you paste data, Excel displays a Paste Smart Tag below and to the right of the destination cells. Click this Smart Tag to display a menu of paste options, as shown below. For example, you can choose between maintaining the formatting of the source cell and matching the formatting of the destination cell, apply formatting only, or paste a value rather than the formula that produces it. The available options depend on the type of data you’ve pasted.



When the Smart Tag options don’t give you the fine control you need, issue a Paste Special command from the Edit menu or the shortcut menu to display the Paste Special dialog box:
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The Paste section of the Paste Special dialog box offers these mutually exclusive options:



■ All Pastes everything copied: all values, formulas, formatting, etc. ■ Formulas Pastes all data—formulas, constants, etc.—without formatting. ■ Values Pastes the values of formulas (rather than the formulas themselves) without formatting.



■ ■ ■ ■ ■ ■ ■



Formats Pastes all formatting without any data or formulas. Comments Pastes all comments without other data. Validation



Pastes the data-validation criteria.



All Except Borders Pastes all data and formatting except cell borders. Column Widths Pastes the column widths without data and without other formatting. Formulas and Number Formats Pastes formulas and number formatting only. Values and Number Formats Pastes values and number formatting only. The Paste Special dialog box limits you to a single operation at a time, but you can use multiple Paste Special operations with the same data range to transfer multiple items.



The Operation section of the Paste Special dialog box offers mutually exclusive options for adding, subtracting, multiplying, dividing, or performing no operation (the default). To use these options, follow these steps: 1. Copy to the Clipboard the cell or range that contains the number or numbers you want to add to or subtract from, or by which you want to multiply or divide, the other numbers.
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How to Do Everything with Microsoft Office Excel 2003 2. Select the cell or range you want to affect. 3. Display the Paste Special dialog box, choose the appropriate Operation option, and click the OK button. The final section of the Paste Special dialog box contains the following options, which you can use with the Paste options and Operation options:



■ Skip Blanks Prevents Excel from pasting blank cells. ■ Transpose Transposes rows to columns and columns to rows.



Link Data Across Worksheets or Across Workbooks Chances are, your work in Excel involves a healthy variety of different worksheets or workbooks, some of which bear a relationship to one another. To avoid having to copy information manually from one worksheet or workbook to another each time it changes (let alone retype it), Excel lets you link data across worksheets or even across workbooks. For example, each departmental manager might maintain a separate workbook of productivity targets, with summaries from each of those workbooks linked to an executive-overview workbook used by the VPs. To create a link, follow these steps: 1. Open the source workbook and the destination workbook. (If you’re linking from one sheet of a workbook to another, open just that workbook.) 2. In the source workbook, copy the relevant cell or range. 3. Display the destination sheet of the destination workbook, issue a Paste Special command to display the Paste Special dialog box, and click the Paste Link button. Excel updates links within the same workbook automatically and immediately when you change the data in the source. When you link from one workbook to another, here’s what happens:



■ If the source workbook is open and contains changes made since the destination workbook was last updated, Excel updates the links in the destination workbook when you open it.



■ If the source workbook isn’t open but contains changes made since the destination workbook was last updated, Excel’s default behavior is to prompt you to update automatic links when you open the destination workbook. To make Excel update the links without prompting, clear the Ask to Update Automatic Links check box on the Edit tab of the Options dialog box. You can also force updating manually by choosing Edit | Links and working in the Edit Links dialog box. This dialog box also lets you check the status of a link, change a link’s source, or break a link (for example, if the source isn’t available now and never will be again). See “Edit, Update, and Break Links,” in Chapter 16, for more information on working with links.
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Use AutoFill to Enter Data Series Quickly To enable you to fill in series of data quickly and easily in worksheets, Excel provides the AutoFill feature. You select one, two, or more cells that contain the basis for a series, then drag the AutoFill handle—the black square that appears at the lower-right corner of the last cell selected—to show AutoFill the range of cells you want to fill with the series of data. AutoFill analyzes the starting cells, determines what the contents of the other cells should be, and enters the information automatically. The best way to get the hang of AutoFill is to play around with it for a few minutes. Open a new, blank workbook and try the following examples to see how AutoFill works and what it does:



■ Enter January in cell A1 and drag the AutoFill handle to cell D1. As you drag, AutoFill displays a ScreenTip to show you the entry that the current cell will receive. When you release the mouse button, AutoFill enters the months February through April in the selected cells.



■ Press CTRL-Z to undo the AutoFill operation, and then drag the AutoFill handle from cell A1 to cell M1 instead. AutoFill will start repeating the list and enter January in cell M1.



■ Enter 0 in cell A2 and 5 in cell A3, select those cells, and then drag the AutoFill handle down column A. AutoFill continues the sequence by adding 5 to each number it enters in the successive cells. The AutoFill series must be contained in a single row or a single column—it can’t cover a range consisting of multiple rows and columns at once.



■ Drag the AutoFill handle from cell A3 to the right. AutoFill repeats the data in cell A3 (the number 5), because there’s no progression. You can use this behavior to extend a text label over a range of cells.



■ Hold down CTRL and drag the AutoFill handle from cell A3 to the right. Holding down CTRL forces AutoFill to increment the number entered in the single cell over the AutoFill range rather than copy the number.



■ Enter Monday in cell B2 and press CTRL-B to make it boldface. Then right-drag the AutoFill handle across to cell H2 and release the mouse button. AutoFill displays a context menu that includes options such as Copy Series, Fill Series, Fill Formatting Only, Fill Without Formatting, Fill Days, and Fill Weekdays. (For other content, the options Fill Months, Fill Years, Linear Trend, Growth Trend, and Series are available as appropriate.) Select the appropriate item. For example, select Fill Formatting Only to fill the series with the formatting from cell B2 but skip filling the cells with the content. You can change the item that AutoFill has entered by clicking the AutoFill Options Smart Tag that appears below and to the right of the last cell in an AutoFill series and choosing the appropriate option from the resulting menu.
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Create Custom AutoFill Lists As well as being able to extrapolate AutoFill sequences from data in cells, Excel includes several custom lists for frequently used data: months, three-letter months (such as Jan and Feb), days of the week, and three-letter days of the week (such as Sun and Mon). You can supplement these by defining your own lists. To create a custom list, follow these steps: 1. Choose Tools | Options to display the Options dialog box. 2. Display the Custom Lists tab (Figure 3-4). 3. In the Custom Lists box, select the NEW LIST item. 4. Enter the list items in the List Entries text box, one to a line. 5. Click the Add button. You can import an existing list from a range of cells in a worksheet. Click the button at the right end of the Import List from Cells box to minimize the Options dialog box, select the range in the worksheet, and then click Import. (Alternatively, select the range of cells before displaying the Options dialog box.) To delete a custom list, select it in the Custom Lists box and click the Delete button.



FIGURE 3-4



To speed up data entry, you can create custom AutoFill lists on the Custom Lists tab of the Options dialog box.
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Use Find and Replace Excel includes Find and Replace functionality with plenty of power to make sweeping changes in your worksheets in moments. To find items, choose Edit | Find from the menu or press CTRL-F; Excel displays the Find tab of the Find and Replace dialog box (on the left of Figure 3-5). To replace items, choose Edit | Replace or press CTRL-H; Excel displays the Replace tab of the Find and Replace dialog box (on the right on Figure 3-5). By default, Excel displays the reduced version of the Find and Replace dialog box. For a basic Find operation, enter the search text in the Find What text box and click Find Next to find the next occurrence or Find All to find all occurrences. For a basic Replace operation, enter the search text and replacement text, and then use the Find Next, Find All, Replace, and Replace All buttons as appropriate. For more options, click the Options button to reveal the rest of the dialog box. These are the extra Find and Replace options:



■ The Within drop-down list lets you specify whether to restrict the search or replace operation to the active worksheet (the default) or to the entire workbook.



■ The Search drop-down list lets you choose whether to search by rows (the default) or by columns. Searching by columns can be quicker, but search performance is rarely an issue unless you’re working with colossal worksheets. To reverse the search direction, hold down SHIFT and click Find Next.



■ The Look In drop-down list lets you specify whether to search formulas, values, or comments.



■ The Match Case check box enables you to turn case-sensitive searching on and off. ■ The Match Entire Cell Contents check box enables you to restrict matches to only the entire contents of cells rather than partial contents.



FIGURE 3-5



The full Find tab (left) and full Replace tab (right) of the Find and Replace dialog box
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How to Do Everything with Microsoft Office Excel 2003 ■ The Format button lets you search for or replace specific types of formatting that you either define using the Format Cells dialog box (choose Format | Format) or specify by selecting a cell formatted that way (choose Format | Choose Format from Cell). You can replace text and formatting together or simply replace formatting on its own. This allows you to make sweeping changes to the formatting of your workbooks. If you can’t find an item that you’re sure is in the worksheet, make sure that Find isn’t set to use formatting. Click Format and choose Clear Find Format to clear Find formatting.



Recover Your Work If Excel Crashes Creating spreadsheets on a computer rather than on paper can save you a huge amount of time, but it means your work is vulnerable to loss through user error, application crashes, operating system crashes, hardware failures, or power outages. To help you avoid losing data through mishaps, Excel has a feature called AutoRecover that automatically saves recovery copies of files that contain unsaved changes as you work. (By default, AutoRecover saves every 10 minutes. You can change this interval by choosing Tools | Options and using the controls on the Save tab of the Options dialog box.) After a crash or a power outage, you can then try to recover one of the versions that AutoRecover has saved. Always save your work manually. AutoRecover may be able to save you from disaster, but you should never rely on it. If you’re tempted to rely on AutoRecover, try thinking of it as akin to a fire sprinkler system—the sprinkler may save your home and its contents from disaster, but you’d probably rather not find out the hard way whether it actually works.



Minimize the Risk of Data Loss To minimize the risk of data loss, practice safe computing and use Excel and Office’s recovery features. Here are some recommendations:



■ Keep your computer hardware well maintained to reduce the risk of hardware failures.



■ Use an uninterruptible power supply (UPS) to enable your desktop computer to ride out brownouts or brief blackouts, and to enable you to save your work and shut down your computer if a longer power outage occurs. If you have a laptop computer, you shouldn’t need a UPS, because your computer’s battery can act as a backup. If your
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company’s building has a backup power supply, you may not need a UPS for your computer.



■ Keep Windows and your applications up-to-date by applying patches to eliminate known bugs and security vulnerabilities. Run Windows Update (Start | All Programs | Windows Update) periodically to check for patches to Windows and the applications you’re using.



■ Run an effective antivirus application. Update your antivirus application consistently and frequently.



■ Back up your data to a removable disk or an Internet drive so that you can recover your data if your computer is destroyed, lost, or stolen. In a corporate environment, an administrator will probably back up your data centrally.



■ Save your work frequently—perhaps even every time you’ve made a significant change. ■ Configure AutoRecover options to save AutoRecover backups as often as necessary. ■ Know how to use Microsoft Office Application Recovery to close down an application that has crashed.



To reduce the likelihood of losing data if Excel (or one of the other Office applications) crashes, Microsoft Office includes Microsoft Office Application Recovery, an application for closing down an Office application that’s crashed. Microsoft Office Application Recovery can sometimes save data from the crashed application. When the application is relaunched, you can try to recover the data.



Use Microsoft Office Application Recovery to Close a Hung Application Normally, when a Windows application hangs (stops responding to the keyboard and mouse), you need to use Windows Task Manager to shut it down. Windows Task Manager closes the application effectively but without finesse. Closing the application loses any unsaved changes in the files you had open in that application. Office includes a tool called Microsoft Office Application Recovery for shutting down the Office applications a bit more gently when they crash. Microsoft Office Application Recovery can sometimes (but not always) save unsaved changes in the files that the application has open. If Excel stops responding, follow these steps: 1. Make sure nothing easily fixable is wrong:



■ Check that you don’t have a dialog box open for the application but hidden behind another window.
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How to Do Everything with Microsoft Office Excel 2003 ■ If you’re running a VBA macro, wait for it to stop. Windows lists an application as Not Responding when it’s under VBA’s control but is otherwise fine.



■ Wait for a couple of minutes to see if the application starts responding again. 2. Choose Start | All Programs | Microsoft Office | Microsoft Office Tools | Microsoft Office Application Recovery to display the Microsoft Office Application Recovery window:



3. Select the application that’s not responding. 4. Click the Recover Application button to try to recover the application. 5. If Microsoft Office Application Recovery is able to recover data, you’ll see a progress report such as that shown below. The recovery operation may take anything from a few seconds to several minutes, depending on how much data was involved.



6. Windows displays the error-reporting dialog box that invites you to send Microsoft a report on the problem. If Microsoft Office Application Recovery may be able to save some of your work, this dialog box includes an option for recovering your work and restarting the application. Make sure this option is selected, then click the Send Error Report button or the Don’t Send button as appropriate. 7. If the Recover Application option doesn’t work, click the End Application button to end the application forcibly. (Clicking the End Application button has the same effect as clicking the End Task button on the Applications tab of Windows Task Manager.)
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Recover a Workbook from an AutoRecover File When an Office application restarts after a crash or after being closed by Microsoft Office Application Recovery or Windows Task Manager, it displays the Document Recovery task pane (shown below) on the left of the application window. The Document Recovery task pane lists any files the application has recovered, together with original versions of the documents:



When you hover the mouse pointer over the entry for an available file in the Document Recovery task pane, the application displays a drop-down button on the right side of the entry. Click the button to display the menu, then choose Open, Save As, Delete (for AutoRecover versions only, not for original files), or Show Repairs. Once you’ve opened a document, the menu offers the choices View, Save As, Close, and Show Repairs. The Show Repairs item displays the Repairs dialog box with a report showing which errors (if any) were detected and repaired in the file. Figure 3-6 shows two examples of the Repairs dialog box. In the first example, the news is good: Excel was able to repair the file. In the second example, “damage to the file was so extensive that repairs were not possible” and “some data may have been lost or corrupted.” Before you ask—yes, the workbook had lost a huge amount of data, but some parts of it were recoverable. After deciding which recovered file to keep, choose File | Save As to display the Save As dialog box, and then save the file under a different name than the original file. This way, you’ll
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FIGURE 3-6



The Repairs dialog box tells you whether Excel was able to repair the file or whether data was lost.



be able to go back to the original file if you subsequently discover that the recovered file has problems you didn’t identify when viewing it. Click the Close button to close the Document Recovery task pane. Approach the recovery of documents with as calm a mind as possible. Don’t fall sobbing with relief on a recovered document and save it over your old document before making sure it contains usable data without errors.
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How to… ■ ■ ■ ■ ■ ■ ■



Add, delete, and manipulate worksheets Format cells and ranges Understand the number formats that Excel offers Apply visual formatting to cells and ranges Use conditional formatting to make remarkable values stand out Apply canned formatting instantly with AutoFormat Create and use styles to apply consistent formatting easily



A



s you saw in Chapter 3, Excel makes it easy to navigate in and enter data in worksheets. Excel also offers a wide variety of formatting options for presenting the data in worksheets as effectively as possible. In this chapter, you’ll learn how to manipulate worksheets in a workbook before moving on to discover how to format cells and ranges by using the many types of formatting that Excel supports.



Add, Delete, and Manipulate Worksheets By default, each Excel workbook contains three worksheets and can contain from one to 255 worksheets. In the following sections, you’ll learn how to add, delete, hide, and redisplay worksheets; move and copy worksheets; rename worksheets; and change the formatting on default new worksheets that you create.



Add, Delete, Hide, and Redisplay Worksheets You can add and delete worksheets to workbooks as follows:



■ To add a worksheet, select the worksheet before which you want the new worksheet to appear, and choose Insert | Worksheet or press either SHIFT-F11 or ALT-SHIFT-F1. Alternatively, right-click the worksheet tab, choose Insert from the shortcut menu, select Worksheet on the General tab of the Insert dialog box, and click the OK button. You can change the default number of worksheets in a new workbook by adjusting the value in the Sheets in New Workbook text box on the General tab of the Options dialog box (Tools | Options).



■ To delete a worksheet, right-click its tab and choose Delete from the shortcut menu. Alternatively, select the worksheet and choose Edit | Delete Sheet. Excel deletes the worksheet without confirmation and doesn’t let you undo the deletion, so double-check that you’ve picked the right worksheet before issuing the Delete command.



■ To hide a worksheet from view, select it and choose Format | Sheet | Hide. To display the worksheet again, choose Format | Sheet | Unhide, select the sheet in the Unhide dialog box, and click the OK button.
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Recover from Deleting the Wrong Worksheet If you delete the wrong worksheet, the only way to recover your work is to revert to the previously saved version of the workbook—if that version of the workbook contains the worksheet. (If you’ve just inserted the worksheet in the workbook, entered data on it, and deleted it, you’re stuck.) To revert to the previously saved version of the workbook, close the workbook without saving changes to it, and then open the workbook again. When you close the workbook like this, you’ll also lose any other unsaved changes to the workbook, so this isn’t an action to take lightly. But if the alternative is losing a worksheet that contained valuable information, losing other unsaved changes may be worthwhile.



Move and Copy Worksheets In a workbook that contains few worksheets, the easiest way to move a worksheet to a new position in the workbook is to drag its tab to the new position. You can copy the worksheet instead of moving it by holding down CTRL as you drag. The copy receives the same name as the original worksheet followed by the number two in parentheses. In a workbook that contains many worksheets, it’s easier to use the Move or Copy dialog box to move or copy a worksheet. Follow these steps: 1. Select the worksheet or worksheets that you want to move or copy. 2. Choose Edit | Move or Copy Sheet, or right-click a selected worksheet tab and choose Move or Copy from the shortcut menu. Excel displays the Move or Copy dialog box:



3. Select the destination in the Before Sheet list box.
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How to Do Everything with Microsoft Office Excel 2003 4. To copy the worksheet, select the Create a Copy check box. 5. Click the OK button to close the Move or Copy dialog box. Excel moves or copies the worksheet. The Move or Copy dialog box also enables you to move or copy a worksheet to a different workbook. Open the workbook and follow the previous steps, but in the To Book drop-down list, select the destination workbook. When you copy a worksheet, Excel copies only the first 255 characters of each cell. If any cell in the worksheet contains more than 255 characters, Excel warns you of this problem, but it doesn’t specify the cells affected. To work around the problem, click the Select All button to select the source worksheet, issue a Copy command, and then paste the copies into the destination worksheet.



Rename a Worksheet By default, Excel names worksheets Sheet1, Sheet2, and so on. You can rename worksheets with new names of up to 31 characters. Usually, it’s best to keep worksheet names considerably shorter than the maximum lengths so that there’s enough room for several tabs to appear at once on an average-resolution screen. To rename a worksheet, follow these steps: 1. Double-click the worksheet’s tab, or right-click the tab and choose Rename from the shortcut menu. Excel selects the existing name. 2. Type the new name over or edit the existing name. 3. Press ENTER or click elsewhere. To make a worksheet tab easier to identify among its siblings, you can change its color. Issue a Tab Color command from the Format | Sheet submenu or the tab’s shortcut menu, select the color, and click the OK button.



Change the Formatting on New Default Worksheets and Workbooks You can change the default formatting of the workbook and worksheets that Excel uses for the New Blank Workbook command by creating a template named Book.xlt in the XLSTART folder. This folder is located in your %userprofile%\Application Data\Microsoft\Excel\ folder (for example, C:\Documents and Settings\Jane Phillips\Application Data\Microsoft\ Excel\XLSTART).
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Before you can navigate to the XLSTART folder, you’ll need to display hidden files and folders (if you haven’t already done so). Choose Tools | Options in an Explorer window to display the Folder Options dialog box, select the Show Hidden Files and Folders option on the View tab, and click the OK button. Then open an Explorer window to the XLSTART folder and take either of the following actions:



■ If you have a workbook or template that contains the formatting that you want to use for new default worksheets and workbooks, copy it to the XLSTART folder. Press F2 and rename the copy Book.xlt. (If the file was a workbook, Windows displays a Rename dialog box that warns you about the change of file extension. Click the Yes button.) Open Book.xlt and delete any contents you don’t want to have in the new default worksheets and workbooks. Save and close the file.



■ If you don’t have a workbook or template that contains the formatting you want to use for new default worksheets and workbooks, create a new one. In the XLSTART folder, issue a New | Microsoft Excel Worksheet command from the File menu or context menu. Name the new workbook Book.xlt. Windows displays a Rename dialog box that warns you about the change of file extension. Click the Yes button. Open Book.xlt, set it up with the formatting you want to use for new default worksheets and workbooks, save it, and close it.



Format Cells and Ranges As you’ve seen already in this book, the cell is the basis of the Excel worksheet. A cell can contain any one of various types of data—numbers (values that can be calculated), dates, times, formulas, text, etc.—and can be formatted in a variety of ways. You can adjust everything from the formats in which Excel displays different types of data to alignment to background color and gridlines. The most basic type of formatting controls the way in which Excel displays the data the cell contains. For some types of entries, Excel displays the literal contents of the cell by default; for other types of entries, Excel displays the results of the cell’s contents. For example, when you enter a formula in a cell, by default, Excel displays the results of the formula rather than the formula itself. So to be sure of the contents of a cell, you need to make it the active cell or edit it. Excel displays the literal contents of the active cell in the Formula bar; and, when you edit a cell, Excel displays its literal contents in both the cell itself and in the Formula bar. Even when Excel displays the contents of the cell, it may change the contents for display purposes. For example, when you enter a number that’s too long to be displayed in a Generalformatted cell, Excel converts it to scientific notation using six digits of precision. Similarly, Excel rounds display numbers when they won’t fit in cells, but the underlying number remains unaffected.
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Apply Number Formatting The main way of applying formatting to cells and ranges is the Format Cells dialog box (Format | Cells). You can also apply basic formatting from the Formatting toolbar, shown here with labels. (If the Formatting toolbar isn’t currently displayed, right-click the menu bar or any displayed toolbar and choose the Formatting entry to display it.) Bold



Merge and Center Underline



Font



Font Size



Center



Align Left Italic



Percent Style



Currency Style



Align Right



Borders



Increase Decimal



Decrease Indent



Decrease Decimal



Comma Style



Font Color



Fill Color



Increase Indent



If you find the Formatting toolbar to be a more convenient way to apply formatting than the Format Cells dialog box, customize the Formatting toolbar by adding to it buttons for the types of formatting you apply most frequently. You’ll find a few extra buttons on the Add or Remove Buttons | Formatting submenu. You’ll find all of the formatting commands under the Format category on the Commands tab of the Customize dialog box. Chapter 17 explains how to customize toolbars and menus. Excel’s Format Cells dialog box (choose Format | Cells or press CTRL-1) offers a large number of options for formatting the active cell or selected ranges. You’ll learn about most of these options later in this chapter. (Other options, such as those for locking and protecting cells, you’ll learn about later in this book.) You can also apply some font formatting via standard Office shortcuts (such as CTRL-B for boldface, CTRL-I for italic, and CTRL-U for single underline).



Understand Excel’s Number Formats To make Excel display the contents of a cell in the way you intend, apply the appropriate number format. You can apply number formats manually in several ways, but Excel also applies number formats automatically when you enter text that matches one of Excel’s triggers for a number format. Because some of the triggers for automatic number formatting are less than intuitive, it’s a good idea to know about them so that you can avoid having Excel apply the number formats unexpectedly. The central place for applying number formats is the Number tab of the Format Cells dialog box (Figure 4-1). The Number tab offers 12 categories of built-in formats. The following sections discuss these formats.
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4



FIGURE 4-1



Use the options on the Number tab of the Format Cells dialog box to apply number formatting.



General Number Format The General number is the default format for all cells on a new worksheet (unless you’ve customized it). General displays up to 11 digits per cell and doesn’t use thousands separators. You can apply General format by pressing CTRL-SHIFT-~ (tilde).



Number Format The Number formats let you specify the number of decimal places to display (0 to 30, with a default of 2), whether to display a thousands separator (for example, a comma in U.S. English formats), and how to represent negative numbers. You can make Excel apply the Number format with the thousands separator by including a comma to separate thousands or millions (for example, enter 1,000, 1,000,000, or 1,000000—only one appropriately placed comma is necessary).



Currency Format The Currency formats let you specify the number of decimal places to display (0 to 30, with a default of 2), which currency symbol to display (if any), and how to represent negative numbers. You can make Excel apply Currency format by entering the appropriate currency symbol before the number. For example, enter $4 to make Excel display dollar formatting. If you enter one or more decimal places, Excel applies Currency format with two decimal places. For example, if you enter $4.1, Excel displays $4.10.
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Accounting Format The Accounting formats let you specify the number of decimal places to display (0 to 30, with a default of 2) and which currency symbol to display (if any). The currency symbol appears flush left with the cell border, separated from the figures. The Accounting formats represent negative numbers with parentheses around them—there’s no choice of format. You can apply the Accounting format quickly by clicking the Currency Style button on the Formatting toolbar.



Date Format The Date formats offer a variety of date formats based on the locale you choose. These options are easy to understand. What’s more important to grasp is how Excel stores dates and times. Excel treats dates and times as serial numbers representing the number of days that have elapsed since 1/1/1900, which is given the serial number 1. For example, the serial date 37955 represents November 30, 2003. Excel for the Macintosh uses a different starting date—January 2, 1904—instead of January 1, 1900. If you use spreadsheets created in Excel for the Mac in Windows versions of Excel, you’ll need to select the 1904 Date System check box in the Workbook Options section of the Calculation tab of the Options dialog box to get Excel to display the dates correctly. For computers, serial dates (and times) are a snap to sort and manipulate: to find out how far apart two dates are, the computer need merely subtract one date from the other, without having to consider which months are shorter than others or whether a leap year is involved. For humans, serial dates are largely inscrutable, so Excel displays dates in your choice of format. If you want, you can enter dates by formatting cells with the Date format and entering the appropriate serial number, but most people find it far easier to enter the date in one of the conventional Windows formats that Excel recognizes. Excel automatically converts to serial dates and formats with a Date format any entry that contains a hyphen (-) or a forward slash (/) and matches one of the date and time formats Windows uses. For example, if you enter 11/30/04, Excel assumes you mean November 30, 2004. If you don’t specify the year, Excel assumes you mean the current year



Time Format The Time formats offer a variety of time formats based on 12-hour and 24-hour clocks. These options are easy to understand. Excel treats times as subdivisions of days, with 24 hours making up one day and one serial number. So, given that 37987 is the serial date for January 1, 2004, 37987.5 is noon on that day, 37987.25 is 6AM, 37987.75 is 6PM, and so on. You can make Excel automatically format an entry with a time format by entering a number that contains a colon (for example, 12:00) or a number followed by a space and an uppercase or lowercase a or p (for example, 1 P or 11 a).
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Percentage Format The Percentage format displays the value in the cell with a percent sign and with your choice of number of decimal places (the default is two). For example, if you enter 71 in the cell, Excel displays 71.00% by default. You can make Excel automatically format an entry with the Percentage format by entering a percent sign after the number. If you enter no decimal places, Excel uses none. If you enter one or more decimal places, Excel uses two decimal places. You can change the number of decimal places displayed by formatting the cell manually.



Fraction Format Excel stores fractions as their decimal equivalents—for example, it stores ¼ as 0.25. To display fractions (for example, ¼) and compound fractions (for example, 11¼) in Excel, you have to use the Fraction formats. Excel offers fraction formats of one digit (for example, ¾), two digits (for example, 16/18), and three digits (for example, 303/512)—halves, quarters, eighths, sixteenths, tenths, and hundreds. Before worrying about fractions being displayed as their decimal equivalents, however, you need to worry about entering many fractions in a way that Excel won’t mistake for dates. For example, if you enter 1/4 in a General-formatted cell, Excel converts it to the date 4-Jan in the current year. To enter a fraction in a General-formatted cell, type a zero, a space, and the fraction—for example, type 0 1/4 to enter ¼. To enter a compound fraction in a General-formatted cell, type the integer, a space, and the fraction—for example, type 11 1/4 to enter 11¼. Excel formats the cell with the appropriate Fraction format, so the fraction is displayed, and stores the corresponding decimal value. If you need to enter simple fractions consistently in your worksheets, format the relevant cells, columns, or rows with the Fraction format ahead of time.



Scientific Format Scientific format displays numbers in an exponential form—for example, 567890123245 is displayed as 5.6789E+11, indicating where the decimal place needs to go. You can change the number of decimal places displayed to anywhere from 0 to 30. You can make Excel apply Scientific format by entering a number that contains an e in any position but the ends (for example, 3e4 or 12345E17).



Text Format Text format is for values that you want to force Excel to treat as text so as to avoid having Excel automatically apply another format. For example, if you keep a spreadsheet of telephone numbers, you might have some numbers that start with 0. To prevent Excel from dropping what appears to be a leading zero and converting the cell to a number format, you could format the cell as Text. (You could also use the Special format for phone numbers, discussed in the next section.)
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How to Do Everything with Microsoft Office Excel 2003 Similarly, you might need to enter a value that Excel might take to be a date (for example, 1/2), a time, a formula, or another format. Excel left-aligns Text-formatted entries and omits them from range calculations—for example, SUM()—in which they would otherwise be included. You can make Excel format a numeric entry with the Text format by entering a space before the number. For safety, force the Text format by typing a space before a numeric entry or manually format the cell as Text before entering data in it. If you apply the Text format to numbers you’ve already entered, Excel will continue to treat them as numbers rather than as text. You’ll need to edit each cell (double-click it, or press F2, and then press ENTER to accept the existing entry) to correct this error.



Special Format The Special formats provide a locale-specific range of formatting choices. For example, the English (United States) locale offers the choices Zip Code, Zip Code + 4, Phone Number, and Social Security Number. As you’ll quickly realize, these formats all have rigidly defined formats, most of which are separated by hyphens into groups of specific lengths. (Phone numbers are less rigid than the other formats, but Excel handles longer numbers—for example, international numbers—as well as could be expected.) Special formats enable you to quickly enter numbers of the given type and have Excel enter the hyphens automatically for you. For example, if you format a cell with the Social Security Number format and enter 623648267, Excel automatically formats it as 623-64-8267.



Custom Format The Custom format enables you to define your own custom formats for needs that none of the built-in formats covers. Excel includes a variety of built-in formats that cover general, numeric, currency, percentage, exponential, date, time, and custom numeric formats. You can also design your own custom formats based on one of the built-in formats. To define a custom format, follow these steps: 1. Enter sample text for the format in a cell, and then select that cell. (Excel then displays the sample text in the format you’re creating, which helps you see the effects of your changes.) 2. Display the Number tab of the Format Cells dialog box. 3. In the Category box, select the Custom item. 4. In the Type list box, select the custom format on which you want to base your new custom format. Excel displays the details for the type in the Type text box.
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5. If the details for the type extend beyond the Type text box, double-click in the Type text box to select all of its contents, issue a Copy command (for example, press CTRL-C), and then paste the copied text into a text editor, such as Notepad. (For a shorter type, you can work effectively in the Type text box. For a longer type, it’s easier to have enough space to see the whole type at once.) 6. Enter the details for the four parts of the type, separating the parts from each other with a semicolon. (See the detailed explanation below.) 7. If you’re working in a text editor, copy what you typed and paste it into the Type text box. Check the sample text to make sure it seems to be correct. 8. Click the OK button. Each custom format consists of format codes that specify how Excel should display the information. Each custom format can contain four formats. The first format specifies how to display positive numbers, the second format specifies how to display negative numbers, the third format specifies how to display zero values, and the fourth format specifies how to display text. The four formats are separated by semicolons. You can leave a section blank by entering nothing between the relevant semicolons (or before the first semicolon, or after the last semicolon). Table 4-1 explains the codes you can use for defining custom formats. Code



Meaning



Example



[color name]



Display the specified color.



Enter the appropriate color in brackets as the first item in the section: [Black], [Red], [Blue], [Green], [White], [Cyan], [Magenta], or [Yellow]. For example, #,##0_);[Magenta](#,##0) displays negative numbers in magenta.



Number Format Codes #



Display a significant digit.



##.# displays two significant digits before the decimal point and one significant digit after it. (A significant digit is a nonzero figure.)



0



Display a zero if there would otherwise be no digit in this place.



00000 displays a five-digit number, packing it with leading zeroes if necessary. For example, if you enter 4, Excel displays 00004.



%



Display a percentage.



#% displays the number multiplied by 100 and with a percent sign. For example, 2 appears as 200%.



?



Display as a fraction.



# ????/???? displays a number and four-digit fractions—for example, 4 1234/4321.



.



Display a decimal point.



##.## displays two significant digits on either side of the decimal point.



TABLE 4-1



Codes for Creating Custom Formats
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Code



Meaning



Example



,



Two meanings: Display the thousands separator or scale the number down by 1,000.



Thousands separator example: $#,### displays the dollar sign, four significant digits, and the thousands separator. Scale by 1,000 example: €#.##,,, " billion" displays the euro symbol, one significant digit before the decimal point and two after, the number scaled down by a billion, and the word billion (after a space). For example, if you enter 9876543210, Excel displays €9.88 billion.



Date and Time Format Codes d



Display the day in numeric format.



d-mmm-yyyy displays 1/1/04 as 1-Jan-2004.



dd



Display the day in numeric format with a leading zero.



dd/mmm/yy displays 1/1/04 as 01/Jan/04. Use leading zeroes to align dates.



ddd



Display the day as a three-letter abbreviation.



ddd dd/mm/yyyy displays 1/1/04 as Thu 01/01/2004.



dddd



Display the day in full.



dddd, dd/mm/yyyy displays 1/1/04 as Thursday, 01/01/2004.



m



Display the month in numeric format.



d/m/yy displays 1/1/04 as 1/1/04.



mm



Display the month in numeric format with a leading zero.



dd/mm/yy displays 1/1/04 as 01/01/04.



mmm



Display the month as a three-letter abbreviation.



dd-mmm-yy displays 1/1/04 as 01-Jan-2004.



mmmm



Display the month in full.



d mmmm, yyyy displays 1/1/04 as 1 January, 2004.



mmmmm



Display the month as a one-letter abbreviation.



January, June, and July appear as J; April and August appear as A; and so on. This code is seldom useful because it tends to be visually confusing.



yy



Display the year as a two-digit number.



d/m/yy displays 1/1/04 as 1/1/04.



yyyy



Display the year in full.



d-mmm-yyyy displays 1/1/04 as 1-Jan-2004.



h



Display the hour.



h:m displays 1:01 as 1:1.



hh



Display the hour with a leading zero.



hh:mm displays 1:01 as 01:01.



m



Display the minute.



h:m displays 1:01 as 1:1.



mm



Display the minute with a leading zero.



hh:mm displays 1:01 as 01:01. To distinguish mm from the months code, you must enter it immediately after hh or immediately before ss.



TABLE 4-1



Codes for Creating Custom Formats (continued)
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Code



Meaning



Example



s



Display the second.



h:m:s displays 1:01:01 as 1:1:1.



ss



Display the second with a leading zero.



hh:mm:ss displays 1:01:01 as 1:01:01.



.0, .00, .000



Display tenths, hundredths, or thousandths of seconds.



h:mm:ss.00 displays 1:01:01.11 as 1:01:01.11. Use further zeroes for greater precision.



A/P



Display A for A.M. and P for P.M.



h:mm A/P displays 1:01 as 1:01 A. You can use uppercase A/P or lowercase a/p to specify which case to display.



AM/PM



Display AM for A.M. and PM for P.M.



h:mm am/pm displays 13:01 as 1:01 PM. Excel uses uppercase regardless of which case you use.



[]



Display the elapsed time in the specified unit.



[h]:mm:ss displays the elapsed time in hours, minutes, and seconds—for example, 33:22:01.



Text Format Codes _



Display a space as wide as the specified character.



_) makes Excel enter a space the width of a closing parenthesis—for example, to align positive numbers with negative numbers surrounded by parentheses.



*



Repeat the specified character to fill the cell.



*A makes Excel fill the cell with A characters. Sometimes useful for drawing attention to particular values—for example, zero values.



\



Display the following character.



[Blue]$#,###.00 \*;[Red]$#,###.00 \D displays positive numbers in blue and followed by an asterisk, and negative numbers in red and followed by a D.



"string"



Display the string of text.



$#,##0.00" Advance" displays the word Advance after the entry. Note the leading space between the " and the word.



@



Concatenate the specified string with the user’s text input.



“Username: “@ enters Username: and a space before the user’s text input. This works only in the fourth section (the text section) of a custom format.



N/A



Display the specified character.



$ - + = / ( ) { } : ! ^ & ‘ ’ ~ < > [SPACE]



TABLE 4-1



Codes for Creating Custom Formats (continued)



Apply Visual Formatting After specifying how Excel should represent the data you enter in worksheet cells, you’ll probably want to apply formatting to the worksheets to make them more readable. Excel offers a wide range of formatting options, most of which are easy to understand and applicable to a cell or range. The following list outlines the main types of formatting that Excel offers. The primary way of applying these formatting options is the Format Cells dialog box (choose Format | Cells or
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How to Do Everything with Microsoft Office Excel 2003 press CTRL-1). You can also apply basic formatting by using the buttons on the Formatting toolbar.



■ Font formatting Change fonts, font size, font style (regular, bold, italic, or bold italic), underline, and color. When you change the formatting, Excel clears the Normal Font check box. Reselect this option to reapply the normal font—in other words, remove all of the font formatting that you’ve applied to the selection. These options appear on the Font tab of the Format Cells dialog box (shown on the left in Figure 4-2).



■ Alignment formatting Change cells’ horizontal and vertical alignment. Options include horizontal centering across the selection (which can be useful for centering a heading over several columns), vertical centering in a cell whose height you’ve increased, and indentation. These options appear on the Alignment tab of the Format Cells dialog box (shown on the right in Figure 4-2).



■ Orientation and text-direction formatting Specify the orientation of the text—for example, set text at a slant for special emphasis, or create a vertical heading to save space. Specify the direction of the text: Left-to-Right, Right-to-Left, or Context (Excel decides based on the context). These options appear on the Alignment tab of the Format Cells dialog box.



■ Text-control formatting Choose whether to wrap text in the cell, shrink it to fit the cell, or merge multiple cells into one cell. Wrapping text can greatly improve long



FIGURE 4-2



Use the Font tab (left) of the Format Cells dialog box to apply font formatting and the Alignment tab (right) to control alignment, text orientation, and text direction.
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entries, and you can break lines manually by pressing ALT-ENTER. These options appear on the Alignment tab of the Format Cells dialog box. Be careful with the Shrink to Fit option—when it resizes the display of some cells to make their contents fit the column but leaves other cells at full size, it can produce the effect of formatting errors. For more control, resize your columns or fonts manually.



■ Border formatting Apply borders of assorted weights, styles, and colors around or across cells. For example, you might put a double line across the top of a cell containing a total. Select the style and color, then click the preview pane to apply a line. Click an applied line to remove it. These options appear on the Border tab of the Format Cells dialog box (shown on the left in Figure 4-3).



■ Pattern formatting Apply solid shades of color or colored patterns to add emphasis or create a design. These options appear on the Patterns tab of the Format Cells dialog box (shown on the right in Figure 4-3).



■ Protection formatting Choose whether to lock or hide particular cells. Locking and hiding takes effect only when you protect the worksheet. “Protect Cells, a Worksheet, or a Workbook,” in Chapter 14, explains how to protect your work.



Format Rows and Columns In most worksheets you create, you’ll need to change some columns from their standard widths to widths better suited to the data entered in their cells. Similarly, you may need to change row height—for example, to accommodate objects or taller text you enter for headings.



FIGURE 4-3



Use the options on the Border tab (left) and the Patterns tab (right) of the Format Cells dialog box to apply borders and patterns to cells.
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Copy Formatting from One Range to Another To copy formatting from one cell or a range of cells to another cell or range of cells, use the Format Painter feature. Follow these steps: 1. Select the cell or range that has the formatting you want to copy. 2. Click the Format Painter button on the Formatting toolbar. Excel changes the mouse pointer to a brush and displays a flashing outline around the cell or range that contains the copied formatting:



3. Click the cell, or drag over the range, to which you want to apply the formatting. Excel applies the formatting. After applying the formatting, Excel restores the normal mouse pointer. If you need to apply the formatting to multiple cells or ranges, double-click the Format Painter button to lock the feature on. Apply the formatting to all the cells or ranges, and then press ESC or click the Format Painter button again to unlock the feature.



The fastest and most effective way to change the width of a column or the height of a row is by using Excel’s AutoFit feature. AutoFit resizes a column to just wider than its widest entry, and resizes a row to just high enough for its tallest character or object. You can use AutoFit in either of these ways:



■ Double-click the right border bar of a column header or the bottom border bar of a row header.



■ Select the column (or its widest cell) and choose Format | Column | AutoFit Selection, or select a cell in the row and choose Format | Row | AutoFit. You can also change column width and row height manually by dragging the appropriate column border bar or row border bar. Excel displays a ScreenTip showing the size to which you’ve currently dragged. The column-width ScreenTip shows the number of characters and the number of pixels; the row-height ScreenTip shows the number of points and the number of pixels. The most formal way to change column width is to choose Format | Column | Width and enter the width in characters in the Column Width dialog box. Valid values are 0 to 255 characters. Similarly, you can change row height by choosing Format | Row | Height and entering the row height in points in the Row Height dialog box. Valid values are 0 to 409 points.
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You can change the standard column width for the active worksheet by choosing Format | Column | Standard Width, entering the width you want, and clicking the OK button. Excel doesn’t apply this new standard width to any columns you’ve already adjusted. You can hide rows and columns by choosing Format | Row | Hide or Format | Column | Hide. Alternatively, right-click a column heading or row heading and choose Hide from the shortcut menu. Hidden rows and columns can be a great way of hiding the workings of your spreadsheets from inquisitive eyes, but you have to be aware of them when you copy data and paste it, because Excel includes them in the Paste operation. This can produce some unpleasant surprises, particularly when you’re working under time restraints. To redisplay hidden rows or columns, select the row headings or column headings around the hidden rows or columns, or select the whole worksheet to redisplay all hidden rows and columns. Then choose Format | Row | Unhide or Format | Column | Unhide. Use the Column Widths option button in the Paste Special dialog box to copy column widths to another worksheet without including their data.



Use Conditional Formatting The formatting you’ve used so far is constant formatting—once you’ve applied it to a cell, range, column, or row, there it stays until you change it. But Excel also supports conditional formatting, formatting that Excel uses only when specified conditions are met. Typical uses of conditional formatting include drawing attention to missing data or to figures that deviate significantly from expectations—for example, Stakhanovite productivity statistics or evidence of terminal sloth. Conditional formatting is similar to the effect produced by some predefined number formats— for example, those that display negative numbers in a different color—but more subtle, in that you can set careful triggers for applying the formatting. To apply conditional formatting, follow these steps: 1. Select the cell or range of cells you want to format. 2. Choose Format | Conditional Formatting. Excel displays the Conditional Formatting dialog box, shown below with two conditions entered:
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How to Do Everything with Microsoft Office Excel 2003 3. Use the options in the Condition 1 section to specify the condition:



■ Choose the Cell Value Is option button or the Formula Is option button as appropriate.



■ Choose the appropriate comparison: Between, Not Between, Equal To, Not Equal To, Greater Than, Less Than, Greater Than or Equal To, or Less Than or Equal To.



■ Specify the point or points of comparison. You can enter values or cell addresses. You can either type cell addresses or use the Collapse Dialog buttons to enter them. 4. Click the Format button and use the abbreviated version of the Format Cells dialog box to specify the formatting to use. This version of the dialog box offers only Font, Border, and Patterns tabs. 5. Click the Add button to add another condition, or click the OK button to close the Conditional Formatting dialog box and apply the formatting. You can create up to three conditions. If you use multiple conditions, Excel evaluates them in order and stops evaluating them after it finds one that’s true. So to make your conditional formatting effective, you must arrange your conditions in the correct order.



Use AutoFormat to Apply Canned Formatting Quickly Excel’s AutoFormat feature provides a variety of canned formats for adding font formatting, borders, shading, and colors to your worksheets. To use AutoFormat, follow these steps: 1. Enter your data and arrange it to your satisfaction. (For example, sort the data into order.) 2. Select the range you want to affect. If you don’t select a range, AutoFormat uses the current region—the cells around the active cell up to the first empty row and empty column in each direction. In many cases, the current region will be larger than you want to affect, so usually it’s best to select the range manually when applying AutoFormat. 3. Choose Format | AutoFormat. Excel displays the AutoFormat dialog box, shown in Figure 4-4 with the Formats to Apply group box displayed. 4. Select the automatic format you want. 5. To specify which elements of the automatic format are applied, click the Options button to display the Formats to Apply group box. Then select or clear the Formats to Apply check boxes as appropriate. 6. Click the OK button to close the AutoFormat dialog box.
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4



FIGURE 4-4



AutoFormat can be useful for quickly applying canned formatting to worksheets.



To remove an AutoFormat, select a cell in the range (or select the entire range), display the AutoFormat dialog box, select the None format (last in the list), and click the OK button.



Use Styles Like Word’s documents and templates, Excel’s workbooks and templates include a number of built-in styles that you can use to apply predefined sets of formatting quickly and easily. You can also create styles to meet your own formatting needs, and you can copy styles from one workbook or template to another workbook or template you want to use them in. Each default new workbook contains these styles:



Style



Example Using 1000



Explanation



Normal



1000



Used for each workbook cell by default until another style is applied.



Comma



1,000.00



Uses a thousands separator and two decimal places.



Comma [0]



1,000



Uses a thousands separator and no decimal places.



Currency



$1,000.00



Uses a currency symbol, a thousands separator, and two decimal places.
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Style



Example Using 1000



Explanation



Currency [0]



$1,000



Uses a currency symbol, a thousands separator, and no decimal places.



Percent



100000%



Uses a percent symbol and multiplies the number by 100.



Hyperlink



N/A



Uses an underline and different coloring from the default. Indicates that the user has not yet clicked this hyperlink.



Followed Hyperlink



N/A



Uses an underline and different coloring from the default and the Hyperlink style. Indicates that the user has clicked this hyperlink.



Apply a Style Excel applies Normal style to all cells in the default workbook format. You can apply the Comma style, the Percent style, and the Currency style from the corresponding buttons on the Formatting toolbar. Excel applies the Hyperlink style automatically to any cell in which you enter a recognizable URL or path, and changes the style to Followed Hyperlink when you click the hyperlink. You can turn off Excel’s automatic creation of hyperlinks in two ways: Display the AutoFormat As You Type tab of the AutoCorrect dialog box (Tools | AutoCorrect Options) and clear the Internet and Network Paths with Hyperlinks check box, or click the Smart Tag on a changed hyperlink and choose Stop Automatically Creating Hyperlinks from the menu. To apply the other styles, choose Format | Style, choose the style in the Style dialog box (shown here), and click the OK button.



Create Your Own Styles To create your own styles, follow these steps: 1. Apply the formatting for the style to a cell. 2. Select that cell.
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3. Choose Format | Style to display the Style dialog box. 4. In the Style Name text box, type the name for the new style. Excel changes the Style Includes area’s name to Style Includes (By Example). 5. Clear any check boxes for formatting you don’t want to include in the style. 6. Click the OK button to close the Style dialog box.



Modify a Style



4



To modify an existing style to better suit your needs, follow these steps: 1. Choose Format | Style to display the Style dialog box. 2. Select the style in the Style Name drop-down list. 3. Click the Modify button. Excel displays the Format Cells dialog box. 4. Specify the new formatting for the style, then click the OK button to close the Format Cells dialog box. 5. Click the OK button to close the Style dialog box.



Add the Style Drop-Down List to the Formatting Toolbar Whereas Word displays the Style drop-down list prominently on its Formatting toolbar, Excel doesn’t include this drop-down list in the default set of buttons for its Formatting toolbar. This reflects the relative frequency with which the typical user of Excel applies styles— seldom (if ever), and then usually via the style buttons on the Formatting toolbar. But if you need to apply styles frequently when creating worksheets, you may benefit from adding the Style drop-down list to the Formatting toolbar (or the Standard toolbar—it’s your choice). To do so, follow these steps: 1. Right-click any displayed toolbar or the menu bar and choose Customize to display the Customize dialog box. 2. Click the Commands tab. 3. In the Categories list box, select the Format category. 4. In the Commands list box, select the Style drop-down list and drag it to the toolbar. (Don’t select the Style… button by mistake.) 5. Click the Close button to close the Customize dialog box.
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Delete a Style If you no longer need a style, you can delete it. Follow these steps: 1. Choose Format | Style to display the Style dialog box. 2. Select the style in the Style Name drop-down list. 3. Click the Delete button. Excel deletes the style and reapplies the Normal style to any cells in the workbook that were formatted with the style. 4. Click the OK button to close the Style dialog box. You can delete any style except the Normal style, which Excel protects.



Merge Styles from Another Workbook If you create your own styles in a workbook or template, you may want to use them in another workbook or template. You can copy styles from one workbook (or template) to another by performing what Excel calls a merge styles operation. To merge styles from one workbook to another, follow these steps: 1. Open the source workbook (or template) and the destination workbook (or template). 2. Activate the destination workbook (or template). 3. Choose Format | Style to display the Style dialog box. 4. Click the Merge button to display the Merge Styles dialog box:



5. Select the source workbook (or template) and click the OK button to close the Merge Styles dialog box. 6. Click the OK button to close the Style dialog box.
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How to… ■ ■ ■ ■ ■ ■



Understand how Excel handles graphical objects Insert clip art in worksheets Work with shapes, AutoShapes, and WordArt Add graphics to worksheets Import pictures from scanners and cameras Add diagrams to worksheets



T



o give worksheets more visual impact, or simply to make them more comprehensible, you’ll often need to add pictures, shapes, diagrams, or other graphical objects. In this chapter, you’ll learn about the wide variety of features that Excel offers for adding graphical objects—everything from a modest shape or textual note to a full-color picture, a Venn diagram, or an organization chart—to worksheets.



Understand How Excel Handles Graphical Objects The way that Excel handles objects isn’t entirely intuitive, so understanding the basics of how it handles them will help you to avoid confusion or problems later on. Although Excel worksheets appear to be flat (thanks, at least in part, to the limitations of display technology currently available), Excel actually treats them as consisting of a number of different layers. The primary layers are the text layer (which contains the cells of the worksheet) and the drawing layer. By default, Excel starts you off in the text layer and leaves you there until you specifically go to work with an object that resides in a different layer—for example, a graphical object in the drawing layer. The layers are transparent unless they contain an object, so when you look at a worksheet, you see the contents of all the layers together, making up the entire appearance of the worksheet. You can change the order in which the layers appear, so you can change the way that objects appear to be superimposed on each other. For example, you can position a graphic so that it appears behind the cells of a worksheet, inline with the cells, or in front of the cells, blocking the view to them. The drawing layer effectively works as a very thick layer that consists of as many sublayers as you need. You can create multiple objects in the drawing layer, either keeping them separate from each other or arranging them into groups that you can keep together and manipulate with a single command. You can arrange objects in the drawing layer so that they overlap each other, and you can alter the order in which they appear by moving the objects forward (up the stack of sublayers, as it were) or backward (down the stack of sublayers). To work with objects in the drawing layer, display the Drawing toolbar by choosing View | Toolbars | Drawing or right-clicking any displayed toolbar (or the menu bar) and choosing Drawing from the shortcut menu. Alternatively, click the Drawing button on the Standard toolbar to display the Drawing toolbar (Figure 5-1).
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Arrow Rectangle Oval Text Box Insert WordArt



Line AutoShapes Select Objects Draw FIGURE 5-1



Line Color Font Color Line Style Dash Style Arrow Style



Fill Color Insert Picture Insert Clip Art Insert Diagram or Organizational Chart



3-D Shadow



Use the Drawing toolbar to create and manipulate shapes and graphical objects.



Insert Clip Art in Worksheets Office includes a wide selection of graphics, photographs, movie clips, and sounds clip art that you can use freely in your documents. When using these items, exercise discretion and restraint—a unique picture may still be worth the thousand words of the cliché, but a tired piece of clip art may detract from a workbook rather than enhance it. To insert one of Office’s included clip art items, follow these steps: 1. Choose Insert | Picture | Clip Art to display the Clip Art task pane. The illustration here shows the Clip Art task pane after a successful search:



P:\010Comp\HowTo8\071-1\ch05.vp Thursday, August 28, 2003 10:12:48 AM



105



5



(8) / How to Do Everything with Microsoft Office Excel 2003 / Hart-Davis / 3071-1 / Chapter 5 Color profile: Generic CMYK printerHowTo-Tght profile Composite Default screen



106



How to Do Everything with Microsoft Office Excel 2003 2. Use the Search For box, the Search In drop-down list, and the Results Should Be drop-down list to specify which types of files you’re looking for:



■ In the Search For box, specify one or more keywords. ■ In the Search In drop-down list, choose which collections to search (or choose Everywhere).



■ In the Results Should Be drop-down list, choose the media types you’re interested in: All Media Types, Clip Art, Photographs, Movies, or Sounds. 3. Click the Go button. Excel searches for matching media types and displays them in the pane. Once you find a clip that matches your needs, you can take a variety of actions with it. The most basic action is to insert the clip in the worksheet. To do so, click the clip, or click the drop-down button that appears when you hover the mouse over it and choose Insert from the menu. This menu also offers options for the following actions:



■ Copy Copies the clip so you can paste it elsewhere. ■ Delete from Clip Organizer Deletes the clip from all collections in the Clip Organizer. Office makes you confirm the deletion in case you misclicked. This option isn’t available for clips that come with Office, only for clips you add.



■ Copy to Collection Displays the Copy to Collection dialog box so you can add a copy of the clip to another collection—for example, your Favorites. This option is useful for making a collection of clips you use often. This option is available only for clips stored on local drives.



■ Make Available Offline Displays the Copy to Collection dialog box so you can download this clip from its online source to one of your collections. This option is available only for online clips.
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■ Move to Collection Displays the Move to Collection dialog box so you can move the clip to another collection. This option is useful for relocating clips in your collections. You can move only clips you add to the collection, not the clips included with Office.



■ Edit Keywords Displays the Keywords dialog box (Figure 5-2), in which you can add, modify, or delete the keywords associated with the clip. You can’t change the keywords for the clips included with Office, only those for clips you add.



■ Find Similar Style Searches for clips that have a similar style to the clip from which you issue this command. This option is useful when you need multiple clips in the same style to convey a certain impression in a document. The clips returned by a style search can span an interesting range of subjects and keywords.



■ Preview/Properties Displays the Preview/Properties dialog box (Figure 5-3), in which you can view the image and its details. The Paths section of this dialog box shows the full path for the image’s file and the catalog that contains the image. To organize your clips, click the Organize Clips link at the foot of the Clip Art task pane. Excel opens the Microsoft Clip Organizer applet (Figure 5-4). In the figure, the Concepts collection is selected in the Collection List task pane, so the word Concepts appears in the title bar.



FIGURE 5-2



You can associate keywords with clips you add to the collection, which helps you search for them in the future.
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FIGURE 5-3



Use the Preview/Properties dialog box to check an image’s details.



FIGURE 5-4



Microsoft Clip Organizer enables you to add, browse, collate, and search clips.
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The first time you open Microsoft Clip Organizer, Excel displays the Add Clips to Organizer dialog box:



5



Use the controls in this dialog box to specify whether to search your hard disk now for media files to add to your catalogs. You can specify particular folders by clicking the Options button, using the resulting Auto Import Settings dialog box to specify which folders to search for media files, and clicking the Catalog button. Alternatively, click the Later button to dismiss the Add Clips to Organizer dialog box until the next time you launch Microsoft Clip Organizer. (To prevent the Add Clips to Organizer dialog box from being displayed again, select the Don’t Show This Message Again check box before dismissing the dialog box.) These are the key commands for working with Microsoft Clip Organizer:



■ To navigate your collections, click the Collection List button and work in the Collection List task pane.



■ To search for clips, click the Search button and use the Search task pane. ■ To add clips, choose File | Add Clips to Organizer and then choose Automatically, On My Own, or From Scanner or Camera from the submenu.



■ To edit the keywords for a selected clip, choose Edit | Keywords. ■ To compact your clips collection so that it takes up as little space as possible, choose Tools | Compact. After inserting a picture, you can double-click it to display the Format Picture dialog box, which contains options for configuring the picture. You’ll learn how to use the options in this dialog box later in this chapter.



Work with Shapes, AutoShapes, and WordArt Excel provides tools for creating drawing objects that fall into three broad categories:



■ Shapes are basic shapes such as squares and circles. ■ AutoShapes are more complex shapes with some intelligence built in.
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How to Do Everything with Microsoft Office Excel 2003 ■ WordArt items are pictures made by applying effects to text. In the following sections, you’ll learn how to work with these objects.



Add Basic Shapes To add a basic shape to a workbook, follow these steps: 1. Click the appropriate button on the Drawing toolbar to activate the tool. 2. Click in the worksheet to position one corner of the shape. It doesn’t matter which corner you position, so position whichever corner is most convenient. 3. Drag to the size you want the shape to be. When you release the mouse button, the application restores the mouse pointer. The process could hardly be simpler, but there are four enhancements you’ll benefit from knowing about:



■ To create the shape centered on the point where you click and start dragging, instead of having one corner of the shape (or the rectangular frame that surrounds a nonrectangular shape) appear there, hold down CTRL as you click and drag.



■ To constrain a rectangle to a square, or to constrain an ellipse to a circle, hold down SHIFT as you click and drag.



■ Hold down CTRL-SHIFT to apply both the centering and the constraint. ■ To create multiple shapes of the same type (for example, several rectangles), double-click the tool to lock it on. Then, when you release the mouse button after creating a shape, the tool remains active. Press ESC to toggle the tool off when you’ve finished creating all the shapes of that type. (Alternatively, click or double-click another tool to start using that tool.)



Add AutoShapes To add an AutoShape to a workbook, follow these steps: 1. Click the AutoShapes drop-down button on the Drawing toolbar. 2. Choose the appropriate category from the AutoShapes menu and select the AutoShapes you want:
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3. Click in the worksheet to position one corner of the AutoShape. 4. Drag to the size you want the AutoShape to be. When you release the mouse button, the application restores the mouse pointer. AutoShapes are easy to work with, but it’s worth knowing the following:



■ The More AutoShapes item on the AutoShape menu displays the Clip Art task pane with a selection of AutoShapes in it.



■ As with basic shapes, you can hold down CTRL to create the AutoShape centered around the point at which you click, hold down SHIFT to constrain the AutoShape, and hold down CTRL-SHIFT to combine the effects.



■ To create multiple AutoShapes of the same type, create the first AutoShape, and set any formatting needed. (See “Format a Drawing Object,” later in this chapter.) Then copy the AutoShape and paste in as many copies as you need. Alternatively, CTRL-drag the AutoShape to create a quick copy of it.



■ The AutoShapes in the Connectors category are smart—once you’ve attached an end of a connector to an object, the connector stays attached even when you move the object. For this reason, it’s usually much better to use a Connector AutoShape than a plain line to join objects when you’re creating a drawing.
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Tear Off a Tear-Off Palette Using the AutoShapes menu and its submenus is easy, but it can involve a large number of mouse-clicks, as you need to display the menu each time you want to create an AutoShape. The same goes for the Draw menu on the Drawing toolbar, which offers commands for moving, aligning, rotating, altering, and changing the order of graphical objects. If you need to use the commands from a submenu of the AutoShapes menu or the Draw menu frequently, you can tear off that menu as a tear-off palette—essentially a floating toolbar. Tearing off a palette is useful for when you’re working extensively with the same submenu and don’t want to have to keep displaying it manually. Excel indicates a tear-off palette by a line of dots at the top of its menu entry. In the previous illustration, you can see that the Callouts menu is a tear-off palette, as is the AutoShapes menu itself. To tear off a palette, display it from the AutoShapes menu or Draw menu as usual, grab the row of dots on the title bar, and drag it off the menu. The palette appears as a floating toolbar that you can move about the screen as necessary. You can also dock a torn-off palette to another side of the application window by dragging it there or by double-clicking its title bar.



Add WordArt Objects to Worksheets Another element you can add to worksheets is a WordArt object. WordArt is an Office applet for creating text-based designs, such as logos or decorations. WordArt sounds like a component of Word, but it works equally well in Word, Excel, Outlook, and PowerPoint. Like all means of making text more difficult to read, WordArt is best used only when necessary and, even then, only in moderation. To insert a WordArt object in a drawing, follow these steps: 1. Click the Insert WordArt button on the Drawing toolbar. (Alternatively, choose Insert | Picture | WordArt.) Office displays the WordArt Gallery dialog box (shown on the left in Figure 5-5). 2. Select the style of WordArt item and click the OK button. WordArt displays the Edit WordArt Text dialog box (shown on the right in Figure 5-5). 3. Type the text in the Text box. 4. Select the font, font size, and bold and italic, as appropriate. 5. Click the OK button. WordArt closes the Edit WordArt Text dialog box, inserts the WordArt object in your workbook, and displays the WordArt toolbar. Figure 5-6 shows a WordArt object and the WordArt toolbar with labels.
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FIGURE 5-5



Choose the basic shape of WordArt in the WordArt Gallery dialog box (left), then enter the text in the Edit WordArt Text dialog box (right).



Most of the buttons on the WordArt toolbar are easy to understand: the Edit Text button displays the Edit WordArt Text dialog box (alternatively, double-click the WordArt item to display



Text Wrapping WordArt Shape Format WordArt WordArt Gallery Edit Text Insert WordArt



FIGURE 5-6



WordArt Same Letter Heights WordArt Vertical Text WordArt Alignment WordArt Character Spacing



Use the WordArt toolbar’s controls to manipulate the WordArt object.
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How to Do Everything with Microsoft Office Excel 2003 this dialog box); the WordArt Gallery button lets you change the WordArt style applied to the object, and the WordArt Shape button lets you change its shape. The other buttons let you tweak the positioning of the WordArt item, make its letter heights all the same, change the text orientation to vertical, change the alignment, and adjust the character spacing. You can resize a WordArt object either by clicking the Format WordArt button and working in the resulting dialog box or by dragging one of its handles. You can rotate a WordArt object by dragging its rotation handle.



Add Text to an AutoShape You can add text inside just about any AutoShape that has enough space inside. In practice, this means that Basic Shapes, Block Arrows, Flowcharts, Stars and Banners, and Callouts can contain text—even lightning-bolt and crescent-moon AutoShapes can contain text, but you’ll need to place it artfully. Lines and Connectors can’t contain text, because they lack sufficient depth to handle the text. To add text to an AutoShape, right-click the AutoShape and choose Add Text from the shortcut menu. The application displays an insertion point inside the AutoShape. Type the text, select it, and apply formatting by using standard means such as those discussed in Chapter 4. If you need to add text to a Line or Connector AutoShape, use the Drawing toolbar to place a text box or a Callout AutoShape next to it. Enter the text, and resize the text box or Callout to best present the text (for example, change the width of the text box or Callout to rebreak the text lines to a suitable width). Then format the line color for the text box or Callout with the No Line option, and set the Fill color to No Fill.



Format a Drawing Object You can format a selected drawing object by using the commands on the Drawing toolbar, by using standard dialog boxes (for example, the Font dialog box), or by displaying the Format dialog box for the object and working with the options on its tabs. The Format dialog box offers quick access to most of the formatting options for the object, so it’s usually the fastest way of setting multiple formatting options at once. To display the Format dialog box, right-click the drawing object and issue the Format command from the shortcut menu. The Format dialog boxes contain the selection of options available to the object, divided among the tabs discussed in the following sections. The name of the Format command and the Format dialog box vary depending on the object. For example, when you right-click an AutoShape, the shortcut menu contains a Format AutoShape command, which displays the Format AutoShape dialog box. For a WordArt object, the command and dialog box are named Format WordArt. For a picture, the command and dialog box are named Format Picture.



Apply Colors and Lines Formatting to a Drawing Object To apply colors and lines formatting to a drawing object, use the controls on the Colors and Lines tab of the Format dialog box for the object (Figure 5-7).
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FIGURE 5-7



The Colors and Lines tab of the Format dialog box lets you control an object’s fill color, line color, arrow style, and more.



The options on this tab enable you to:



■ Specify the fill color and transparency percentage (how see-through the object is). ■ Set the line color, style, and weight. ■ Choose the beginning and ending style for any arrows that the object contains.



Resize a Drawing Object You can resize a drawing object either approximately by using the mouse or more precisely by using the object’s Format dialog box. To resize a drawing object to approximately the right size, select the object and drag one of its handles:
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How to Do Everything with Microsoft Office Excel 2003 To resize an object more precisely, use the controls on the Size tab of the Format dialog box for the object (Figure 5-8). The Size tab’s options are easy to understand:



■ You can change the size of an object by specifying measurements in the Size and Rotate section or in the Scale section. Changing one set of controls changes the other controls as well.



■ You can rotate the object by specifying the number of degrees in the Rotation text box. ■ You can lock the aspect ratio of the object so that you can’t change its height without changing the width as well, and vice versa.



■ If the object had an original size (as a picture does), you can reset it to its original size by clicking the Reset button.



Set Protection on an Object You can set protection on an object by selecting the Locked check box on the Protection tab of the object’s Format dialog box and then applying protection to the worksheet that contains the object. “Restrict Data and Protect Workbooks,” in Chapter 14, explains how to protect a workbook.



Choose Properties for an Object You can specify whether to move and resize an object with cells and whether to include an object in printouts on the Properties tab of the Format dialog box (Figure 5-9).



FIGURE 5-8



Use the options on the Size tab of the Format dialog box to resize or rotate an object.
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FIGURE 5-9



The Properties tab of the Format dialog box enables you to specify whether to move and resize an object along with cells and whether to print an object.



Specify Alternative Web Text for an Object On the Web tab of the Format dialog box for an object, you can specify alternative text to be displayed while a web browser is loading the picture, when the picture isn’t available, or when the user has chosen not to display pictures. For example, you might supply a text description of the picture so that the user knows what they’re missing.



Choose Options for a Picture The Picture tab (Figure 5-10) is available only in the Format Picture dialog box, not in other Format dialog boxes. This tab contains options for cropping the picture from the left, right, top, and bottom edges; for adjusting its color, brightness, and contrast; for resetting the picture (click the Reset button); and for compressing the picture. Click the Compress button to display the Compress Pictures dialog box (Figure 5-11), which contains options for compressing either the selected picture or all pictures in the workbook. The Web/Screen option uses a resolution of 96 dots per inch (dpi); the Print option uses 200 dpi; and the No Change option leaves the current resolution in place. Use the No Change option with the Delete Cropped Areas of Pictures option to remove any portions of the picture you’ve cropped, thus reducing the file size. Use the Delete Cropped Areas of Pictures option only when you’re sure you won’t need to undo the cropping.
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FIGURE 5-10



The Picture tab appears only in the Format Picture dialog box.



Choose Options for a Text Box The Format Text Box dialog box contains tabs for formatting alignment (Figure 5-12), fonts, and internal margins as well as the tabs discussed earlier in this section. These options are self-explanatory.



FIGURE 5-11



Use the Compress Pictures dialog box to compress one or all pictures in a workbook to a suitable resolution for your intended readership.
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FIGURE 5-12



The Format Text Box dialog box offers options for formatting the text box’s font, alignment, and internal margins.



Position Drawing Objects You can position drawing objects in various ways. You can drag objects roughly into position, nudge them precisely into position, use the Format dialog box to position them by specifying measurements, align one object according to another, and create groups of objects that you can format and move together. You can also adjust the granularity of the drawing grid and choose whether objects snap to the grid or not.



Drag and Nudge Objects The basic method of positioning an object is to select it and drag it to where you want it to appear. Dragging is good for moving objects for medium or long distances, but for short distances or pinpoint placement, you need a steady hand with the mouse. To move an object a shorter distance, nudge it. Select the object and press the appropriate arrow key (↑, ↓, ←, or →) to move the object one square up, down, left, or right on the underlying grid that Excel uses for positioning objects. You can also nudge a selected object by choosing Draw | Nudge and then choosing Up, Down, Left, or Right from the submenu, as appropriate. In most cases, the Nudge submenu is too cumbersome to be effective unless you tear it off and leave it displayed for immediate clicking.



Snap an Object to the Grid or to a Shape For positioning objects on a worksheet, Excel uses a drawing grid. You can neither display nor configure this grid, as you can in Word and PowerPoint, but you can control whether an object



P:\010Comp\HowTo8\071-1\ch05.vp Thursday, August 28, 2003 10:12:50 AM



(8) / How to Do Everything with Microsoft Office Excel 2003 / Hart-Davis / 3071-1 / Chapter 5 Color profile: Generic CMYK printerHowTo-Tght profile Composite Default screen



120



How to Do Everything with Microsoft Office Excel 2003 snaps to the grid or to another object by choosing Draw | Snap | To Grid or Draw | Snap | To Shape, respectively, from the Drawing toolbar.



Align an Object According to Another Object Instead of positioning an object by a gridline or a shape, you can align an object with another object. To do so, follow these steps: 1. Select the object according to which you want to align the other object or objects. 2. Hold down SHIFT and click to select the other objects. 3. Choose Draw | Align or Distribute from the Drawing toolbar, then choose the appropriate command from the submenu. Most of the options are self-explanatory, but the following options merit explanation:



■ The Align Center option applies horizontal centering, while the Align Middle option applies vertical centering.



■ The Distribute Horizontally option and the Vertically option place the objects evenly across the area. These commands are available only when you have three or more objects selected.



Group and Ungroup Objects When you’ve selected multiple objects by SHIFT-clicking or CTRL-clicking, you can treat them as an informal group—for example, you can drag an object to move all the objects, or apply shared formatting to all the objects at once. To apply formal grouping so that you can quickly work with these objects as a unit in future, issue a Group command from the Draw menu or the Grouping submenu on the shortcut menu. To ungroup grouped objects, issue an Ungroup command. To regroup objects, issue a Regroup command.



Layer Drawing Objects To adjust the order in which drawing objects appear, select an object and use the Order submenu on the Draw menu or the shortcut menu to move the object forward or back. Your choices are to bring the object to the front or send it to the back, to bring it forward by one layer or send it backward by one layer, and to bring it in front of the text or send it behind the text. To hide all objects so that you can enter text in cells that they would otherwise obscure, choose Tools | Options, select the Hide All option button in the Objects section of the View tab of the Options dialog box, and then click the OK button. To display the objects again, select the Show All button in the Objects section of the View tab.



Use Text Boxes to Position Text Wherever You Need It As you’ve seen earlier in this book, you can wrap text to fit more text in a cell—but increasing the depth of the cell increases the depth of the whole row, which can cause problems with layout.
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If you need to position text precisely, a text box gives you much greater flexibility. You can use text boxes to create anything from labels for chart elements to explanatory paragraphs of text. To create a text box, click the Text Box button on the Drawing toolbar, click in the worksheet, and then drag to the size you want. Right-click the text box and choose Format Text Box to display the Format Text Box dialog box (shown in Figure 5-12, earlier in this chapter); use the controls on the six tabs of this dialog box to format the font, alignment, and internal margins of the text box. By default, a text box has a thin black line around it, but you can remove this by choosing the No Line option in the Line Color drop-down list on the Colors and Lines tab. If you’ve used text boxes in other Office applications, such as Word and PowerPoint, you’ll find that Excel’s text boxes are more limited: you can’t place graphics in them, and you can’t make text flow from one text box to another.



Add Graphics to Worksheets As you saw earlier in this chapter, Excel makes it easy to insert clip art in workbooks. But clip art is usually decoration, or at best a generic picture to illustrate a concept or an archetype. To actually show your readers or audience something useful, in most any business or social situation, you’ll probably need to insert a specific graphic, such as a custom illustration, photograph, or screen capture. To add a graphic to a workbook, follow these steps: 1. Select the cell where you want the upper-left corner of the graphic to appear. (The graphic isn’t placed in this cell, but is aligned with its borders.) 2. Choose Insert | Picture | From File. The application displays the Insert Picture dialog box, which is a common Open dialog box. 3. Navigate to the graphic you want to add and select it. 4. Click the Insert button to close the Insert Picture dialog box and insert the graphic.



Use the Picture Toolbar The Picture toolbar (Figure 5-13) provides quick access to the most useful commands for formatting pictures. Excel automatically displays the Picture toolbar when you select a picture in a worksheet. (If Excel doesn’t display the Picture toolbar, right-click the picture and choose Show Picture Toolbar from the shortcut menu.)



Crop a Picture You can crop (in effect, hide parts of) a selected picture in either of two ways:



■ Click the Crop button on the Picture toolbar and use the resulting mouse pointer to drag one of the picture’s handles to specify which part of it to crop. Unless you have a very steady hand, this technique is more useful for rough cropping than exact cropping.



■ Choose Format | Picture and use the controls in the Crop From section of the Picture tab of the Format Picture dialog box to specify how much to crop from the left, right, top, and bottom of the picture.
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Color More Contrast Less Contrast



Rotate Left 90 Degrees Line Style Compress Pictures



Insert Picture from File



Reset Picture Crop Less Brightness More Brightness



FIGURE 5-13



Set Transparent Color Format Picture



Use the Picture toolbar to manipulate pictures.



Import Pictures from Scanners and Cameras Excel enables you to import a picture from a scanner or camera directly into a worksheet. This capability can be handy when you need to perform such an import operation directly. But in most cases, you’ll get better results by importing the picture via the tools built into Windows (for example, the Scanner and Camera Wizard in Windows XP), cropping and improving it in a graphics application, and then importing the finished file into the workbook via the Insert | Picture | From File command. That said, to import a picture from a scanner or camera directly, follow these steps: 1. Select the cell where you want the upper-left corner of the graphic to appear. (Again, the graphic is aligned with the cell’s borders rather than being placed in the cell.) 2. Choose Insert | Picture | From Scanner or Camera. Office displays the Insert Picture from Scanner or Camera dialog box:



3. Use the Device drop-down list to specify which scanner or camera to use. (If you have only one scanner or camera attached to your computer, Office will probably have selected the right device.)
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4. Select the Web Quality option button or the Print Quality option button to specify the resolution at which to import the picture:



■ Use the Web Quality option button for items that will be displayed on screen (whether on the Web or not) and the Print Quality option button for items you’ll use in printed documents.



■ Print Quality is higher than Web Quality, so print-quality items have a larger file size than web-quality items. 5. Select or clear the Add Pictures to Clip Organizer check box, as appropriate. 6. Click the Custom Insert button. The Wizard then leads you through the process of scanning an item with your scanner or downloading an image from your digital camera. For example, if you’re using a scanner on Windows XP, you see the Scan Using dialog box, in which you can specify which type of picture you want to create and how to crop it:



You can also use the Insert command instead of the Custom Insert command if you’re comfortable using the default scan type with no cropping. For almost all cases, Custom Insert is a better choice. 7. After performing the scan or acquiring the image from your digital camera, the Wizard inserts it in your workbook. 8. Crop or format the image as needed.



Add Diagrams to Worksheets In addition to the drawing and graphics tools discussed so far in this chapter, Excel also can use the applets that Office provides for creating simple diagrams and organizational charts.
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Create Basic Diagrams with the Diagram Applet The Diagram applet enables you to quickly insert six different kinds of basic diagram in worksheets. Choose Insert | Diagram from the menu to display the Diagram Gallery dialog box, choose the diagram type, and click the OK button:



These are the types of diagram you can create:



■ Organization chart Represents organizational relationships as a hierarchical structure. Organization charts also have their own command on the Insert | Picture submenu. See the next section for a more detailed discussion of organization charts.



■ Cycle diagram Represents data and labels in a circular layout. Usually used for demonstrating the flow of a process (for example, the cycle of the seasons).



■ ■ ■ ■



Radial diagram Represents information as circles attached by spokes to a central hub. Pyramid diagram Represents information as a series of slices in a pyramid. Venn diagram Represents information as a series of overlapping circles. Target diagram Represents information as a series of concentric circles with labels at the side.



The diagrams are extremely basic—for example, you can’t adjust the size of pyramid slices or the amount of overlap in the Venn circles—but they can prove adequate for quick-and-dirty illustrations. Figure 5-14 shows examples of the diagrams, including examples of the clumsiness of the diagram tools. For example, notice that there’s not enough space in the Venn diagram’s labels for the word Yellow to appear without breaking. To get around problems like this, use AutoShapes for labeling diagrams when the built-in labels don’t work satisfactorily. (Alternatively, invest a little time and create better diagrams out of AutoShapes.) Excel should automatically display the Diagram toolbar when you select a diagram. If necessary, you can display the Diagram toolbar manually by right-clicking the diagram and
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FIGURE 5-14



Office’s Diagram applet can create organization charts, cycle diagrams, radial diagrams, pyramid diagrams, Venn diagrams, and target diagrams.
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How to Do Everything with Microsoft Office Excel 2003 choosing Show Diagram Toolbar from the shortcut menu. The Diagram toolbar, shown below with labels and with the Layout menu displayed, provides buttons for the following actions:



■ Inserting a new shape (for a new data point) ■ Selecting the previous item (Move Shape Backward) or the next item (Move Shape Forward)



■ ■ ■ ■ ■ ■



Reversing the diagram’s layout Toggling AutoLayout on and off Resizing the diagram (the commands on the Layout menu) Applying an AutoFormat Changing the diagram to one of the other types (but not to an organization chart) Applying text wrapping



Move Shape Forward Move Shape Backward



Reverse Diagram



AutoFormat Text Wrapping



If the Diagram applet fails to remove a Click to Add Text placeholder when you add text to a shape, force an update by adding an extra shape and then deleting it.



Create Organization Charts Office includes an applet called Organization Chart for creating organization charts (or org charts, as most people refer to them). Organization Chart offers modest features that work well for creating org charts for small companies or departments. However, if you need to create an org chart for more than a few dozen people, you should consider a heavier-duty solution, such as Corel iGrafx Flowcharter, NetViz, or Microsoft Visio. To create an org chart with Organization Chart, follow these steps: 1. Select the cell where you want the upper-left corner of the organization chart to appear. 2. Choose Insert | Picture | Organization Chart. Excel creates the stub of an org chart on it and displays the Organization Chart toolbar:
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5 If Excel doesn’t display the Organization toolbar automatically, you can display it by right-clicking the org chart and choosing Show Organization Chart toolbar from the shortcut menu. The basic actions for creating an org chart from the stub of the org chart are as follows:



■ Click one of the Click to add text boxes and type the text. Format the text as necessary by using standard formatting commands from the toolbar, the menus, or the shortcut menu.



■ Delete one of the stub items by selecting it and pressing DELETE. You can’t delete the topmost item until you’ve deleted all its subordinate items.



■ Add a subordinate, coworker, or assistant by selecting the shape to which it will be related, then clicking the Insert Shape button and choosing Subordinate, Coworker, or Assistant from the menu.



■ Apply a layout by clicking the Layout button and choosing the layout from the menu. From this menu, you can toggle the AutoLayout feature on and off. If the AutoLayout feature is switched off, when you add multiple subordinates, coworkers, or assistants, Organization Chart stacks their items one on top of another. This makes it very hard to see what you’re doing. The solution is to use AutoLayout while adding items, and then switch it off when you want to lay out your org chart manually.



■ Apply one of Organization Chart’s AutoFormats by clicking the AutoFormat button (the rightmost button on the Organization Chart toolbar) and choosing the format in the Organization Chart Style Gallery dialog box. Many of the designs are intended for on-screen or web display, so if you’re creating an organization chart that’s destined to be printed in black and white, make sure the design will look okay.



■ Select a level of the org chart, a branch of it, all assistants, or all connecting lines by clicking the Select button and issuing the appropriate command.



■ Use the Text Wrapping button and its menu to specify how the org chart should appear in the workbook—in line with the text, behind the text, in front of the text, and so on.
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How to… ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■



Check the spelling in worksheets Set the print area to specify which parts of a worksheet to print Specify the paper size and orientation Scale a printout to fit the paper Use Print Preview to see how the printout will look Add useful headers and footers Set and adjust page breaks Check and change margins Include extra items in the printout Repeat row titles or column titles on subsequent pages Print a worksheet instantly with default settings Print a worksheet by using the Print dialog box



O



nce you develop a worksheet, you may need to print it out to share with other people. Before you print, check that the worksheet doesn’t contain any lurking spelling mistakes that will return to haunt you and that Excel knows which area of the worksheet you want to print. You should also add headers and footers to identify the printout amidst the morass of papers that your colleagues probably collect, and make sure that the worksheet is laid out correctly on suitably sized paper. Beyond these basics, you may sometimes want to include extra items in the printout or repeat row titles or column titles across multiple pages of a worksheet. In this chapter, you’ll learn how to do all this and more.



Check the Spelling in Worksheets Spelling is a great task for computerization because any given word is spelled either correctly or incorrectly; there are no gray areas. Excel shares the powerful spell checker that is included with Office, which enables you to identify and correct any misspelled words in worksheets. While the spell checker can root out every misspelled word, it doesn’t catch words that are spelled correctly but used incorrectly. For example, if you’ve written “You’re Debts” instead of “Your Debts,” the spell checker can’t help you, although AutoCorrect automatically fixes some incorrect usages (such as replacing the incorrect “their are” with the correct “there are”). To catch usage errors such as these, read through your work carefully or (better) ask someone else to read through it for you.
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Run a Spell Check You can start a spell check in any of these ways:



■ Click the Spelling button on the Standard toolbar. ■ Choose Tools | Spelling. ■ Press F7. The spell checker searches for spelling errors and displays the Spelling dialog box (Figure 6-1) if it finds an error. In this dialog box, you can choose whether to ignore one or all instances of the disputed word, add it to the dictionary, change this or all instances to one of the suggested words, or create an AutoCorrect entry to automatically correct the word to one of the suggested words. Usually it’s best to start a spell check from the beginning of the worksheet. If you start a spell check from elsewhere in a worksheet, when the spell checker reaches the end of the worksheet, it asks you whether you want to continue at the beginning. Alternatively, you can check the spelling of a particular range by selecting the range before starting a spell check. Excel displays a message box when the spell check is complete. If the spell checker found no errors in the worksheet, you’ll see this message almost immediately. Excel’s default settings for the spell checker work for many people, but you may want to customize them to better suit your needs. To configure spelling options, choose Tools | Options, and then click the Spelling tab in the Options dialog box. See “Set Spelling Options” in Chapter 2 for a discussion of these options.



FIGURE 6-1



The Spelling dialog box offers suggestions for correcting apparent spelling errors in worksheets.
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Use Custom Dictionaries The spell checker uses a shared dictionary that’s installed by default in the \Program Files\ Common Files\Microsoft Shared\Proof folder. The actual dictionary file varies based on which language you’re using. This dictionary contains a wide range of words for that language, but you may need to supplement the dictionary with special words and technical terms that you use in your work. To do so, you can use one or more custom dictionaries. A custom dictionary is a text file that contains a list of words that the spell checker shouldn’t query—words that you’ve told the spell checker are okay. Office starts you off with a custom dictionary named Custom.dic, which it stores in the %userprofile%\Application Data\Microsoft\Proof folder. Office’s default setting is to add words to this dictionary when you issue an Add command from the spell checker. If you add all of the extra words to this one dictionary, you at least know where they are. So if, for example, you mistakenly add a real spelling error to the custom dictionary, you know which dictionary to remove it from. But you may find it better to maintain a separate custom dictionary for each separate topic area—for example, one custom dictionary for part names and another custom dictionary for customer names. The two main advantages to separating terms into different dictionaries are that you can:



■ Load and unload the dictionaries as necessary. That way, you can make sure that— to continue the example—your parts database doesn’t have misspellings that are permitted only in your customer lists.



■ Share an individual dictionary with other people without burdening them with extra words that the spell checker doesn’t like. To work with custom dictionaries, run Word and choose Tools | Options. On the Spelling & Grammar tab of the Options dialog box, click the Custom Dictionaries button. The Custom Dictionaries dialog box appears:
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From this dialog box, you can perform several tasks as needed:



■ To specify which dictionaries to use, select and clear the appropriate check boxes. ■ To make a different dictionary the default, select the dictionary and click the Change Default button.



■ To create a new dictionary, click the New button, specify the name and location, and click the OK button.



■ To remove a dictionary, select it and then click the Remove button. ■ To add an existing dictionary, click the Add button, navigate to and select the dictionary file, and then click the OK button.



■ To edit a dictionary, select it, click the Modify button, and work in the resulting dialog box. You may want to edit a dictionary to remove incorrect words that you accidentally added or to add a large number of words you know the spell checker will disagree with. (For smaller numbers of words, it’s usually quicker to add them individually when the spell checker disagrees with them during a spell check.) If you don’t have Word, you can also create a custom dictionary in Excel. To do so, follow these steps: 1. Choose Tools | Options to display the Options dialog box. 2. Click the Spelling tab. 3. Click in the Add Words To text box to select the current entry. 4. To create a dictionary file in the default folder, type the name for the dictionary. To create a dictionary file in another folder, type the path and name. 5. Press ENTER. 6. Click the OK button to close the Options dialog box. Excel creates the dictionary when you next run a spell check.



Set the Print Area To tell Excel which cells of a worksheet to print, set the print area. You can do this by using the Set Print Area command or by using the Page Setup dialog box. If you don’t set the print area manually, Excel assumes that you want to print all the cells that contain data or objects. As long as you’ve created a spreadsheet in a single area of the worksheet, this assumption works well. But if you’ve used some distant cells for notes or scratch calculations, Excel will happily waste wads of paper printing all of the intervening blank cells. So in most cases, you should set the print area manually to make sure that Excel prints only what you want printed.
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How to Do Everything with Microsoft Office Excel 2003 The print area doesn’t have to be one range of contiguous cells—you can select multiple ranges by CTRL-clicking. When you issue the Set Print Area command, Excel creates a print area around each range of cells. Excel then prints each range of cells on a separate page.



Set the Print Area Using the Set Print Area Command To set the print area using the Set Print Area command, follow these steps: 1. Select the range of cells that you want to print. 2. Choose File | Print Area | Set Print Area. Excel places a dotted line around the cells.



Set the Print Area from the Page Setup Dialog Box To set the print area from the Page Setup dialog box, follow these steps: 1. Choose File | Page Setup to display the Page Setup dialog box. 2. Click the Sheet tab to display its contents (Figure 6-2). 3. Click the Collapse Dialog button in the Print Area box to collapse the dialog box to its title bar. 4. Click and drag in the worksheet to select the area you want to print. 5. Click the Collapse Dialog button to restore the Page Setup dialog box.



FIGURE 6-2



You can set the print area on the Sheet tab of the Page Setup dialog box.
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How Excel Handles the Print Area Here are the details of how Excel handles the print area:



■ It saves the print area set for each worksheet, so you don’t need to set the print area again until you need to print a different area of a worksheet.



■ If you add or delete rows or columns within the print area, Excel adjusts the boundaries of the print area to compensate.



■ If you add cells to the print area and use the Shift Cells Right option or the Shift Cells Down option rather than the Entire Row option or the Entire Column option, Excel doesn’t adjust the boundaries of the print area. Data that was previously in the print area can move out of the print area.



■ If you delete cells (rather than entire rows or columns) within the print area, Excel doesn’t adjust the boundaries of the print area. Data that was previously outside the print area may move inside the print area.



Change or Clear the Existing Print Area To change the print area, set the print area again. To clear the print area and return to the default print settings, choose File | Print Area | Clear Print Area.



Specify the Paper Size and Orientation After setting the print area, make sure that Excel is set to use the correct size of paper and the correct orientation. Choose File | Page Setup to display the Page Setup dialog box, and then click the Page tab (Figure 6-3) if it’s not already foremost. In the Orientation section of the Page tab, select the Portrait option button or the Landscape option button as appropriate. In the bottom section of the tab, make sure that the right paper size is selected in the Paper Size drop-down list and that the Print Quality drop-down list shows the right print quality. (The available print qualities depend on the printer.) You can also set a different starting page number than the default (Auto) in the First Page Number text box. The Page tab also contains controls for scaling the printout to fit the paper. See the next section for details.



Scale the Printout to Fit the Paper Often, to get the print area to appear on one or more sheets of paper, you need to scale the printout to the right size. Usually you’ll need to scale down the printout, but sometimes you may need to scale it up. To scale the printout, choose File | Page Setup to display the Page Setup dialog box, and then use the options in the Scaling section of the Page tab.
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FIGURE 6-3



Choose the paper size and orientation on the Page tab of the Page Setup dialog box, and then specify scaling if necessary to better fit the paper.



The Scaling section of the Page tab offers two scaling options:



■ Use the Adjust to NN% Normal Size option button and text box to specify an exact percentage. This option tends to be less useful than the Fit to NN Page(s) Wide by NN Tall option unless you happen to know the scaling percentage that a given print area needs for printing.



■ Use the Fit to NN Page(s) Wide by NN Tall option button and text boxes to resize a print area to fit on a specific number of pages. This option can save you time and paper, but always use Print Preview to check that the results will look acceptable before you commit them to paper. Excel will happily scale down worksheets so small that you need a magnifying glass to read the text.



Use Print Preview to See How the Printout Will Look Use Print Preview (Figure 6-4) to make sure that the worksheet will fit on the paper and look as you want it to. You can display the active worksheet in Print Preview in any of these ways:



■ ■ ■ ■



Click the Print Preview button on the toolbar. Choose File | Print Preview from the menu. Click the Print Preview button on any tab of the Page Setup dialog box. Click the Preview button in the Print dialog box.
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FIGURE 6-4



Use Print Preview to check the print layout before printing a worksheet.



From Print Preview, you can:



■ Click the Next button or the Previous button to navigate to the printout’s next page or previous page.



■ Click the Zoom button to toggle zooming on the display. ■ Click the Print button to display the Print dialog box. ■ Click the Setup button to display the Page Setup dialog box.
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How to Do Everything with Microsoft Office Excel 2003 ■ Click the Margins button to toggle the display of the margin guidelines. (See “Check and Change Margins,” later in this chapter. )



■ Display the worksheet’s current page breaks in Page Break Preview. (See “Set and Adjust Page Breaks,” later in this chapter.)



■ Click the Close button to exit Print Preview. ■ Click the Help button to access Excel’s help.



Add Effective Headers and Footers to Worksheets Excel provides good features for adding headers and footers to worksheets to help you keep your printouts in good order. Each worksheet in a workbook has its own header and footer, so you can give each worksheet exactly the right header, footer, or both. To create headers and footers, follow these steps: 1. Select the worksheet that you want to affect. 2. Choose File | Page Setup to display the Page Setup dialog box. 3. Click the Header/Footer tab to display its contents (Figure 6-5).



FIGURE 6-5



The Header/Footer tab of the Page Setup dialog box enables you to add canned or custom headers and footers.
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Page Number



Path and File Date



FIGURE 6-6



Format Picture



Sheet Name



Use the Header dialog box to create custom headers.



4. Select a predefined header from the header drop-down list, or click the Custom Header button and work in the Header dialog box (Figure 6-6):



■ The controls in the Header dialog box are self-explanatory: click in the Left Section box, the Center Section box, or the Right Section box as appropriate, then use the buttons to insert the appropriate information and format it.



■ As well as information on the file name and path, sheet name, date and time, page number and total pages, you can insert and format pictures. For example, you might add a company logo. 5. Select a predefined footer from the Footer drop-down list, or click the Custom Footer button and work in the Footer dialog box. The Footer dialog box offers the same controls as the Header dialog box. 6. Click the Print Preview button and see how the header and footer look. To adjust them, click the Setup button to return to the Page Setup dialog box. 7. Click the Close button to exit Print Preview. If you regularly need to add headers and footers to worksheets, add the headers and footers to the templates on which the worksheets are based so that you don’t have to enter them manually for each new workbook.
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How to Do Everything with Microsoft Office Excel 2003



Set and Adjust Page Breaks For a print area that’ll print on multiple pages, Excel automatically positions page breaks between the cells that will fall on different pages. You can adjust these page breaks manually, as you’ll see shortly. Typically, you’ll want to start by setting page breaks where they’ll produce a suitably logical division in your spreadsheets—or at least prevent crucial information that belongs together from being broken across two pages. After setting manual page breaks, you can reposition any of the automatic page breaks that fall in awkward places. (Setting the manual page breaks is likely to affect the automatic page breaks.)



Set a Manual Page Break To set a manual page break, work in Normal view. (Excel usually starts you off in Normal view, but if in doubt, choose View | Normal.) Select the cell above and to the left of which you want to insert the new page break, then choose Insert | Page Break. Excel displays dotted lines down and across the screen to denote the page break.



Remove a Manual Page Break You can remove a manual page break by selecting the cell below and to the right of the page break’s crossed dotted lines and choosing Insert | Remove Page Break.



Use Page Break Preview to Reposition Automatic Page Breaks After setting manual page breaks, you may want to improve the positioning of page breaks that the paper size and zoom percentage force on your worksheets. To do so, use Page Break Preview by choosing View | Page Break Preview from the menu or clicking Page Break Preview from Print Preview. Excel shows the automatic page breaks as dotted blue lines (which you can more or less see even in black and white in Figure 6-7), which you can move to better positions by dragging with the mouse. Usually it’s best to start repagination at page 1 and reduce pages rather than enlarging them. Manual page breaks that you set appear as solid lines. Once you move an automatic page break, Excel changes it to a solid line so that you can tell which page breaks are automatic and which are manual. Excel changes the zoom to make the resulting pages fit on the paper that you’re using. Choose View | Normal to exit Page Break Preview.



Remove All Page Breaks from the Active Worksheet To remove all page breaks from the active worksheet, click the Select All button, and then choose Insert | Reset All Page Breaks.
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FIGURE 6-7



After setting manual page breaks, use Page Break Preview to reposition automatic page breaks that fall in the wrong places.



Check and Change Margins To make printouts fit the page, you must set suitable margins. “Suitable” can encompass anything from the tiny margins that laser printers need (laser printers can’t print right up to the edge of the paper) to margins that are generous enough for scribbling paragraphs of complex notes. Excel starts you off with default margins for predefined paper sizes, but often you’ll need to change them.
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FIGURE 6-8



Use the Margins tab of the Page Setup dialog box to set margins and centering for the printout.



You can set margins in two ways. Usually it’s best to start on the Margins tab (Figure 6-8) of the Page Setup dialog box (choose File | Page Setup). On this tab, you can:



■ Use the Top, Bottom, Left, and Right boxes to set the top, bottom, left, and right margins.



■ Use the Header box to specify the distance between the header and the top of the page, and the Footer box to specify the distance between the footer and the bottom of the page.



■ Select the Horizontally check box to center the printout on the page horizontally, select the Vertically check box to center the printout on the page vertically, select both check boxes, or select neither (the default setting). After setting margin distances on the Margins tab, click the Print Preview button to display the worksheet in Print Preview. Then click the Margins button to make Excel display guidelines where the margins and the header and footer areas fall (Figure 6-9). You can change the margins and the header and footer areas by dragging these guidelines—for example, if you notice that a deep header or footer is crashing into the worksheet. You can also drag the markers along the top border of the page to change column widths—for example, if you notice that a cell is too wide for its column. After checking the margins, click the Margins button again to toggle off the guidelines, or simply click the Close button (or press ESC) to exit Print Preview without toggling off the guidelines. This way, Excel displays the guidelines the next time you enter Print Preview.
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FIGURE 6-9



In Print Preview, click the Margins button to display the margins and header and footer areas. You can then drag the guidelines to adjust these items.



Choose Which Items to Include in the Printout Excel’s default settings are to print the contents of cells in the print area that you specify but not print items such as gridlines, row headings and column headings, or comments attached to cells in the print area. You can change these settings, and choose further options, on the Sheet tab (shown in Figure 6-2, earlier in this chapter) of the Page Setup dialog box (choose File | Page Setup). The Sheet tab enables you to:



■ Print gridlines, and row and column headings. ■ Print colors as black and white (for a monochrome printer). ■ Use draft quality for faster printing and lower ink use.
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How to Do Everything with Microsoft Office Excel 2003 ■ Include comments. If you do, choose whether to print them at the end of the worksheet or in the positions in which they appear on the worksheet.



■ Specify how to deal with cells that contain errors: display them, print blank cells, print two dashes (--), or print #N/A to indicate that they’re not applicable.



■ Change the page order from Down, Then Over (the default) to Over, Then Down to specify how Excel paginates and numbers multipage printouts.



Repeat Row Titles or Column Titles on Subsequent Pages If the printout of a worksheet continues to a second or subsequent page, it’s usually a good idea to repeat the row titles or column titles (or both) on each page after the first to make them easy to read. Otherwise, you’ll see your readers carefully folding the second sheet over at the end of the white space and lining up the crease with the columns on the first sheet so that they can see what’s what. To repeat row titles or column titles, follow these steps: 1. Choose File | Page Setup to display the Page Setup dialog box, and then click the Sheet tab to display its contents. 2. Click the Collapse Dialog button in the Rows to Repeat at Top box and select the rows that you want to repeat. 3. Click the Collapse Dialog button in the Columns to Repeat at Left box and select the columns that you want to repeat. 4. Click the OK button to close the Page Setup dialog box.



Print Worksheets When a worksheet is ready to print, you can either print it instantly using the default print settings or choose any further options necessary in the Print dialog box.



Print Instantly with the Default Settings Once you choose a print area and suitable print settings for the worksheet, you can print instantly by clicking the Print button on the Standard toolbar. Excel prints the active worksheet without displaying the Print dialog box. You can also print by clicking the Print button without explicitly setting a print area or other settings. Excel prints the worksheet up to the last cell that contains data, using automatic page breaks and the default paper size. For a small worksheet that occupies less than one sheet of paper, printing this way can give tolerable results. But in most cases, you’ll do better to set up the printouts manually, as described earlier in this chapter.
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Control Printing Using the Print Dialog Box Printing via the Print button on the Standard toolbar can be quick and convenient, but in most cases you’ll probably prefer to exercise more control over printing by choosing File | Print and using the options in the Print dialog box (Figure 6-10).



Choose Options in the Print Dialog Box In the Print dialog box, you can:



■ Choose the printer in the Name drop-down list. If your computer is running Windows XP Professional or Windows 2000 Professional and is part of a Windows network, you can click the Find Printer button and use the Find Printers dialog box to locate available printers.



■ Specify which pages to print in the Print Range group box. The default is to print all pages in the print area. To print only some pages, enter the starting number in the From box and the ending number in the To box. When you enter the first of these values, Excel selects the Page(s) option button automatically.



■ Choose what to print in the Print What group box. The default is to print the active worksheet. You can also choose to print the current selection, the entire workbook, or the current list (if one is selected).



■ Set the number of copies to print in the Number of Copies box. The default is one copy. If you print multiple copies, select the Collate check box to print the full set of each copy at once (followed by the next copy), or clear the Collate check box to print all of the copies of each page together (followed by all of the copies of the next page).



FIGURE 6-10



Use the Print dialog box to choose what to print, which printer to use, and whether to print multiple copies.



P:\010Comp\HowTo8\071-1\ch06.vp Thursday, August 28, 2003 11:48:47 AM



6



(8) / How to Do Everything with Microsoft Office Excel 2003 / Hart-Davis / 3071-1 / Chapter 6 Color profile: Generic CMYK printerHowTo-Tght profile Composite Default screen



146



How to Do Everything with Microsoft Office Excel 2003 ■ To print to a file instead of printing to paper (or to a fax printer), select the Print to File check box. When you click the OK button in the Print dialog box, Excel displays the Print to File dialog box. Enter the path and file name for the print file in the Output File Name text box, and then click the OK button. Excel then creates a print file that you can send or take to another computer (for example, to a specialist print shop for high-quality printouts) for printing.



Choose Further Options in the Printer Properties Dialog Box You can choose further options by clicking the Properties button in the Print dialog box and working in the Properties dialog box for the printer. Figure 6-11 shows an example of a printer’s Properties dialog box. Your printer’s Properties dialog box may be substantially different, but it may well include these options:



■ Printing in back-to-front order instead of the default front-to-back order. (Back-to-front order is sometimes useful for photocopying tasks.)



■ Printing multiple pages on the same sheet of paper. After choosing options, click the OK button to close the Properties dialog box. You can also display the Properties dialog box for the printer by clicking the Options button on any of the tabs in the Page Setup dialog box.



Print Your Work After choosing the appropriate options, click the OK button in the Print dialog box to print your work.



FIGURE 6-11



Typically a printer’s Properties dialog box offers controls for changing paper orientation, page order, the number of pages per sheet of paper, and more.
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How to… ■ ■ ■ ■ ■ ■



Understand what functions are and what their components are Enter functions in worksheets Nest one function inside another function Edit a function in a worksheet Monitor calculations with the Watch window See examples of functions in action



T



o manipulate data and perform calculations with Excel, you use formulas and functions. A formula is a set of instructions for performing a calculation, while a function is a predefined formula for a standard calculation. In this chapter, you’ll start using Excel’s built-in functions in worksheets. You’ll learn what functions are and how you enter them in worksheets. You’ll also learn about the nine categories of functions that Excel provides, with examples of some of the most useful functions in each category. In the next chapter, you’ll learn how to create your own formulas to perform calculations that require more flexibility than the built-in functions provide.



Understand Functions Excel includes a large number of functions—built-in, predefined formulas for standard calculations. Excel’s functions range from the everyday to the highly specialized. For example, the SUM() function adds two or more values together and displays the result, whereas the MINVERSE() function produces the inverse matrix for a specific matrix. SUM() is very widely used, but MINVERSE() much less so.



Understand the Components of a Function Each function has a name entered in capitals and followed by a pair of parentheses—for example, SUM(), MAX(), or DATEVALUE(). Almost all functions have one or more arguments, which specify the elements and types of information you give them in order to get a valid result. (Some functions, such as =NOW(), =TODAY(), and =NA(), require no arguments at all.) The rules that govern the types of information a function needs are called its syntax. Excel shows required arguments in boldface, optional arguments in regular font, and an ellipsis to indicate where you can use further arguments of the same type. For example, the syntax for the =SUM() function is SUM(number1,number2,...)
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Here, number1 is a required argument that specifies the first number to include in the sum: you can’t have a SUM without a number. The number2 argument is an optional argument that specifies the second number, if there is one. The ellipsis indicates that you can use further arguments— number3, number4, and so on—as necessary.



Enter Functions in Worksheets You can enter a function in the active cell in three ways:



■ Type the function directly into the cell. ■ Use the AutoSum button and drop-down menu on the Standard toolbar. ■ Use the Insert Function dialog box. The following sections discuss these ways of entering a function and explain when to use each method.



Type a Function Directly into a Cell The most straightforward way to enter a function is to type it and its arguments directly into the cell. When you’ve typed enough to identify the function you’re entering, Excel displays a ScreenTip that shows the syntax for the function and tracks your progress in entering the argument. The ScreenTip includes links that you can click to select an argument you’ve previously entered or to return to the argument you’re currently entering. Here’s an example of entering the SUM() function by typing it directly into the active cell. To try it out, follow these steps: 1. Click the New button on the Standard toolbar to create a new blank workbook. 2. Enter 34 in cell A1 and 66 in cell A2. 3. Select cell A3 if it isn’t already selected. 4. Type =sum(. As soon as you type the opening parenthesis, Excel recognizes the function name and displays the ScreenTip, as shown here, to remind you of the syntax required. The boldface (on the number1 argument here) shows you the information that you need to enter next:
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How to Do Everything with Microsoft Office Excel 2003 You don’t have to enter function names in capitals—Excel automatically changes the names to capitals for you. 5. Type a1 after the opening parenthesis. Excel recognizes the cell reference and applies a blue outline to the cell to help make sure you’ve entered the correct cell:



6. Type , (a comma) after a1. Excel removes boldface from the number1 argument (which you’ve entered) and applies it to the number2 argument, which you need to enter next:



7. Click cell A2 to enter its address as the second argument in the function, as shown here. Excel applies a flashing outline to the cell and enters its address in green:



8. Type the closing parenthesis for the function and press ENTER. Excel enters the function in the cell and displays its result. The next illustration shows the function result displayed in the active cell and the function itself displayed in the Formula bar:
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Use the AutoSum Drop-Down Menu The other quick way to enter a function is to use one of the frequently used functions on the AutoSum button and drop-down menu on the Standard toolbar. The AutoSum button itself inserts the SUM() function. The AutoSum drop-down menu contains entries for the Average, Count, Max, and Min functions, together with a More Functions entry that displays the Insert Function dialog box (discussed in the “Use the Insert Function Dialog Box” section, next). To enter a function using the AutoSum button or drop-down menu, follow these steps: 1. Select the cell in which you want to enter the function. Often, the cell will be beneath the column of figures, or at the right of the row of figures, on which you want to use the function. 2. Click the AutoSum button if you want to enter the SUM() function, or click the drop-down button and select another function from the menu:



7



3. Excel enters the function in the active cell. If Excel detects numeric entries in the cells above or to the left of the active cell, it selects the cells as a suggestion for what you may want to enter in the function:



4. Edit the selection (or create a new selection) as necessary:



■ If Excel has selected almost the correct range for the function, drag one of the borders of the automatic selection to select the correct range.



■ If Excel has selected completely the wrong range for the function, or hasn’t identified any suitable range to select, click and drag to select the correct range.



■ Instead of clicking and dragging to select the range, you can type the start cell address and end cell address within the function. 5. Press ENTER to enter the function in the cell.
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Use the Insert Function Dialog Box The third way of entering a function is by using the Insert Function dialog box, which walks you through the process of choosing a function and specifying its arguments correctly. This dialog box is the fastest and easiest method for entering all but the most basic functions—those functions that appear on the AutoSum drop-down menu or those functions that take no arguments. You can display the Insert Function dialog box in any of these ways:



■ Click the Insert Function button in the Formula bar. ■ Choose Insert | Function. ■ Click the More Functions entry on the AutoSum drop-down menu. To enter a function by using the Insert Function dialog box, follow these steps: 1. Display the Insert Function dialog box. This illustration shows an example of the dialog box as it initially appears; the functions the dialog box displays at first depend on which functions you last used:



2. Select the function you want to enter in any of these ways:



■ If the Select a Function box already contains the function, click the function. ■ Select the appropriate category in the Or Select a Category drop-down list; then select the function in the Select a Function box.



■ Enter keywords describing the function in the Search for a Function text box and click Go. Excel displays matching functions in the Select a Function box under the Recommended category. Select the function.
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3. Check that the description of the function below the Select a Function box matches your expectations. (If necessary, click the Help on This Function link to display Excel’s help entry on the function.) 4. Click the OK button. Excel displays the Function Arguments dialog box, shown here with data entered for the ROUNDDOWN function:



7



5. Enter the data in each argument box in turn, either by typing in the data or by clicking the Collapse Dialog buttons and using the mouse to select the appropriate cell or range references. As you work, Excel displays information on the current argument and, as soon as appropriate, the result of the formula. Again, you can click the Help on This Function link to access help information. 6. Click the OK button. Excel enters the function in the cell.



Nest One Function Inside Another Function To achieve the calculations you need, you’ll often use multiple functions in sequence. You can do this by entering a function in one cell, and then using another function in another cell to work on the result of that function. But you can also achieve the same effect in a single cell by nesting one function within another. Excel supports nesting up to seven levels of functions, so you can create highly involved calculations. To nest one function within another, follow the procedure described in the “Use the Insert Function Dialog Box” section, earlier in this chapter, up to step 5. You’ll have noticed that when the Insert Function dialog box or the Function Arguments dialog box appears, Excel replaces the Name box to the left of the Formula bar with a box (called the Function box) that contains the name of the last function you used.
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How to Do Everything with Microsoft Office Excel 2003 In the Function Arguments dialog box, select the argument box in which you want to enter the nested function. Then click the drop-down list next to the Function box and choose either one of the listed functions (the list shows the last ten you’ve used) or select the More Functions entry to display the Insert Function dialog box again. Then select the function and specify its arguments as usual.



Edit a Function in a Worksheet To edit a function you’ve entered, select the cell that contains the formula and click the Insert Function button or choose Insert | Function. Excel displays the Function Arguments dialog box again. Edit the function by using the same techniques as for creating the function in the first place.



Monitor Calculations with the Watch Window Excel’s Watch window (Figure 7-1) is a tool for monitoring the value of specific cells in a workbook as you work. The cells can be on any of the worksheets in the workbook or on a worksheet in a linked workbook. You may find the Watch window useful for working with either functions or formulas. The easiest way to display the Watch window is by adding a watch cell to it. To do so, rightclick the cell and choose Add Watch from the shortcut menu. The figure shows the Watch window with several watch cells added. You can sort by any of the column headings, and you can doubleclick a watch cell to display its worksheet and select the cell. Click the Add Watch button to add further watches and the Delete Watch button to delete existing watches. The Watch window is a toolbar, so you can also display it from the View | Toolbars submenu and from the context menu that Excel displays when you right-click a displayed toolbar. By default, Excel displays the Watch window in a floating configuration, but you can dock it like any other toolbar; usually the bottom of the screen is most convenient. The easiest way to close the Watch window is to click its Close button, but you can also hide it from the View | Toolbars submenu or from the toolbars context menu.



FIGURE 7-1



Use the Watch window to monitor the values of particular cells during calculations.
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Examples of Functions in Action Excel offers nine categories of functions, including database, logical, statistical, and text functions. The following sections introduce each category, discuss those functions you’re most likely to find useful, and provide brief examples of most types of functions. Some categories contain too many functions to list all of them here. To access a category of functions, select it in the Or Select a Category drop-down list in the Insert Function dialog box.



Database Functions Excel’s 12 database functions are for identifying which values in an Excel database or list match certain criteria. For example:



■ DCOUNT returns the number of records that match the criteria. ■ DSUM adds the numbers in the specified column of the records that match the criteria. ■ DSTDEVP returns the standard deviation based on the entire population of entries that match the criteria. Chapter 9 discusses how to create databases in Excel.



Date and Time Functions Excel’s date and time functions, explained in Table 7-1, are widely useful in worksheets for a variety of operations. Function



What It Returns



DATE



Serial number of the specified date



TIME



Serial number of the specified time



DATEVALUE



Serial number of the specified text-formatted date



TIMEVALUE



Serial number of the specified text-formatted time



DAY



Day of the month for the specified serial date, as a serial number between 1 and 31



MONTH



Month of the year for the specified serial date, as a serial number between 1 and 12



YEAR



Year for the specified serial date (for example, 2007)



DAYS360



Number of days between the two specified dates, based on a 360-day year (used for some accounting purposes)



HOUR



Hour for the specified serial time, as a serial number between 0 and 23



MINUTE



Minute for the specified serial time, as a serial number between 0 and 59



SECOND



Second for the specified serial time, as a serial number between 0 and 59



TABLE 7-1



Excel’s Date and Time Functions
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Function



What It Returns



TODAY



Current date, formatted as a date



NOW



Current date and time, formatted as a date and time



WEEKDAY



Weekday for the specified day, as a serial number between 1 (Sunday) and 7 (Saturday)



TABLE 7-1



Excel’s Date and Time Functions (continued)



Here are three examples of using the date and time functions:



■ =TODAY() enters the current date in a cell, and =NOW() enters the current date and time, in an automatically updating form.



■ =DATEVALUE("2004-4-1") converts the text string “2004-4-1” to its corresponding serial date. By default, Excel displays the result with Date formatting, but you can apply other cell formatting (for example, you might choose to display the serial number for the date).



■ =HOUR("11:45 PM") returns 23, the hour derived from 11:45 P.M.



Financial Functions Excel includes 16 financial functions, explained in Table 7-2, for common calculations, and the Analysis ToolPak (one of Excel’s add-ins that you can load by choosing Tools | Add-Ins) adds about three dozen extra financial functions for more arcane calculations. Function



What It Returns



DB



Depreciation using the fixed-declining balance method



DDB



Depreciation using the double-declining balance method or other method



FV



Future value of an investment



IPMT



Interest payments for an investment for a specified period



IRR



Internal rate of return for cash flows



MIRR



Modified internal rate of return for cash flows



ISPMT



Interest paid for an investment over a specified period



NPER



Number of periods for an investment



NPV



Net present value of an investment



PMT



Payment for a loan



PPMT



Payment on the principal for an investment



PV



Present value of an investment



TABLE 7-2



Excel’s Financial Functions
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What It Returns



RATE



Interest rate per period of an investment



SLN



Straight-line depreciation for an asset



SYD



Sum-of-years’ digits depreciation for an asset



VDB



Depreciation for an asset using the double-declining balance method or a variable declining balance



TABLE 7-2



Excel’s Financial Functions (continued)



Here are two examples of using the financial functions:



■ =PMT(7.25%/12,24,-20000) calculates the payment required to pay off a $20,000 loan at 7.25% APR over 24 payments.



■ =DB(15000,3000,6,3) calculates the depreciation over the third year of an asset with an initial cost of $15,000, a salvage value of $3,000 at the end of its life, and a life of six years.



Logical Functions Excel’s six logical functions, explained in Table 7-3, enable you to test logical conditions. By combining these logical functions with other functions, you can make Excel take action that’s appropriate to how the condition evaluates. Here are two examples of using the logical functions:



■ =IF(C21>4000,"More than $4,000","$4,000 or less") returns More than $4,000 if C21 contains a number greater than 4000. Otherwise, the function returns $4,000 or less.



■ =AND(INFO("system")="pcdos",INFO("osversion")="Windows (32-bit) NT 5.01",INFO("release")="11.0") returns TRUE if the user is running Excel 2003 (version 11.0) on Windows XP (aka Windows [32-bit] NT 5.01) on a PC. Function



What It Returns



AND



TRUE if all the specified arguments are TRUE; otherwise FALSE



FALSE



FALSE (always—use to generate a FALSE value)



IF



The first specified value if the condition is TRUE; the second specified value if the condition is FALSE. (See the first example above.)



NOT



FALSE from TRUE; TRUE from FALSE



OR



TRUE if any of the specified arguments is TRUE; FALSE if all arguments are FALSE



TRUE



TRUE (always—use to generate a TRUE value)



TABLE 7-3



Excel’s Logical Functions
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How to Do Everything with Microsoft Office Excel 2003 Often IF is used with the information functions discussed in the next section, which contains further examples.



Information Functions Excel offers 16 information functions, explained in Table 7-4, for returning information about the contents and formatting of the current cell or range. Some of these information functions are widely useful, whereas others are more specialized. Here are three examples of using the information functions:



■ =INFO("osversion") returns Windows’ internal description of the operating system version—for example, Windows (32-bit) NT 5.01 for Windows XP. =INFO("directory") returns the current working directory. =INFO("numfile") returns the number of active worksheets in all open workbooks. Function



What It Returns



CELL



Specified details of the contents, location, or formatting of the first cell in the specified range.



COUNTBLANK



Number of empty cells in the specified range.



ERROR.TYPE



A number representing the error value in the cell: 1 for #NULL!, 2 for #DIV/0!, 3 for #VALUE!, 4 for #REF!, 5 for #NAME?, 6 for #NUM!, and 7 for #N/A.



INFO



Information about Excel, the operating system, or the computer.



ISBLANK



TRUE if the cell is blank; FALSE if it has contents.



ISERR



TRUE if the cell contains any error except #N/A; otherwise FALSE.



ISERROR



TRUE if the cell contains any error; otherwise FALSE.



ISLOGICAL



TRUE if the cell contains a logical value; otherwise FALSE.



ISNA



TRUE if the cell contains #N/A; otherwise FALSE.



ISNONTEXT



TRUE if the cell contains anything but text—even if it’s a blank cell; otherwise FALSE.



ISNUMBER



TRUE if the cell contains a number; otherwise FALSE.



ISREF



TRUE if the cell contains a reference; otherwise FALSE.



ISTEXT



TRUE if the cell contains text; otherwise FALSE.



N



A number derived from the specified value: a number returns that number, a date returns the associated serial date, TRUE returns 1, FALSE returns 0, an error returns its error value (see the ERROR.TYPE entry, earlier in this table), and anything else returns 0.



NA



#N/A (used to enter the error value deliberately in the cell).



TYPE



A number representing the data type in the cell: 1 for a number, 2 for text, 4 for a logical value, 16 for an error value, and 64 for an array.



TABLE 7-4



Excel’s Information Functions
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■ =IF(ISERROR(Revenue/Price), "Units not available", Revenue/Price) checks to see whether dividing the cell referenced by the name Revenue by the cell referenced by the name Price will result in an error before it performs the calculation. If the calculation will result in an error, the formula displays a label in the cell instead. If the calculation won’t result in an error, the formula performs the calculation and displays its result.



■ =IF(ISBLANK('Amortization Estimates.xls'!Amortization_Rate), "Warning: Base rate not entered","") displays a warning message if the Amortization_Rate cell in the Amortization Estimates workbook is blank. Otherwise, the formula displays nothing. The Analysis ToolPak also contains the ISEVEN function, which returns TRUE if the specified number is even, and the ISODD function, which returns TRUE if the specified number is odd.



Lookup and Reference Functions Excel includes 18 lookup and reference functions for returning information from lists and tables. You’ll see some of these functions in action in Chapter 9, which discusses how to create databases and lists in Excel.



Mathematical and Trigonometric Functions Excel offers 50 mathematical and trigonometric functions (and the Analysis ToolPak offers about 10 more). Many of these functions are self-explanatory to anyone who needs to use them in their work. For example, COS returns the cosine of an angle, COSH returns the hyperbolic cosine, ACOS returns the arccosine, and ACOSH returns the inverse hyperbolic cosine. Table 7-5 explains the mathematical and trigonometric functions you might use occasionally for more general purposes. Here are three examples of using the general-purpose mathematical and trigonometric functions:



■ =SUM(A1:A24) adds the values in the range A1:A24. ■ =RAND() enters a random value that changes each time the worksheet is recalculated. (Unless you turn off automatic calculation, Excel recalculates the worksheet each time you enter a change.)



■ =ROMAN(1998) returns MCMXCVIII.



Statistical Functions Excel includes a large number of statistical functions that fall into categories such as calculating deviation (including AVEDEV, STDEVA, STDEV, and STDEVP), distributions (BETADIST, CHIDIST, BINOMDIST, EXPONDIST, KURT, POISSON, and WEIBULL), and transformations (FISHER and FISHERINV).



P:\010Comp\HowTo8\071-1\ch07.vp Thursday, August 28, 2003 11:56:58 AM



7



(8) / How to Do Everything with Microsoft Office Excel 2003 / Hart-Davis / 3071-1 / Chapter 7 Color profile: Generic CMYK printerHowTo-Tght profile Composite Default screen



162



How to Do Everything with Microsoft Office Excel 2003



Function



What It Returns



ABS



Absolute value (without the sign) of the specified number



EVEN



Specified positive number rounded up to the next even integer, or the specified negative number rounded down to the next even integer



ODD



Specified positive number rounded up to the next odd integer, or the specified negative number rounded down to the next odd integer



INT



Specified number rounded down to the nearest integer



MOD



Remainder left over after a division operation



RAND



Random number (greater than or equal to 0 and less than 1)



ROMAN



Roman equivalent of the specified Arabic numeral



ROUND



Specified number rounded to the specified number of digits



ROUNDDOWN



Specified number rounded down to the specified number of digits



ROUNDUP



Specified number rounded up to the specified number of digits



SIGN



1 for a positive number, 0 for 0, and –1 for a negative number



SUM



Total of the numbers in the specified range



SUMIF



Total of the numbers in the cells in the specified range that meet the criteria given



TRUNC



Specified number truncated to the specified number of decimal places



TABLE 7-5



Excel’s General-Purpose Mathematical and Trigonometric Functions



Unless you’re working with statistics, you’re unlikely to need most of the statistical functions. However, you may need to use some of these functions for more general business purposes; these general statistical functions are listed in Table 7-6. Here are three examples of using the general-purpose statistical functions:



■ =AVERAGE(Q1Sales) returns the average value of the entries in the range named Q1Sales.



■ =COUNTBLANK(BA1:BZ256) returns the number of blank cells in the specified range.



■ =COUNTIF(Q2Sales,0) returns the number of cells with a zero value in the range named Q2Sales.



Text Functions Excel contains 24 functions for manipulating text, explained in Table 7-7. One of them, BAHTTEXT, is highly esoteric, and another, CONCATENATE, is seldom worth using because the & operator is usually easier for concatenating text strings. You may find the other text functions useful when you need to return a specific part (for example, the first five characters) of a text string, change the case of a text string, or find one string within another string.
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Function



What It Returns



AVERAGE



Average of the specified cells, ranges, or arrays



MEDIAN



Median (the number in the middle of the given set) of the numbers in the specified cells



MODE



Value that occurs most frequently in the specified range of cells



COUNT



Number of cells in the specified range that either contain numbers or include numbers in their list of arguments



COUNTBLANK



Number of empty cells in the specified range



COUNTIF



Number of cells in the specified range that meet the specified criteria



MAX



Largest value in the specified range



MIN



Lowest value in the specified range



TABLE 7-6



Excel’s General-Purpose Statistical Functions



Function



What It Returns



BAHTTEXT



Number converted to Thai text and with the Baht suffix



CHAR



Character represented by the specified character code



CODE



Character code for the first character in the specified string



CLEAN



Specified text string with all nonprintable characters stripped out (sometimes useful when importing files in other formats)



CONCATENATE



Text string consisting of the specified text strings joined together



DOLLAR



Specified number converted to text in the Currency format



EXACT



TRUE if the specified two text strings contain the same characters in the same case; otherwise FALSE



FIND



Starting position of one specified text string within another text string—case-sensitive



FIXED



Specified number rounded to the specified number of decimals, with or without commas



LEN



Number of characters in the specified text string



LEFT



Specified number of characters from the beginning of the specified text string



RIGHT



Specified number of characters from the end of the specified text string



MID



Specified number of characters after the specified starting point in the specified text string



LOWER



Text string converted to lowercase



UPPER



Text string converted to uppercase



TABLE 7-7



Excel’s Text Functions
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Function



What It Returns



PROPER



Text string converted to “proper case” (first letter capitalized, the rest lowercase)



REPLACE



Specified text string with the specified replacement string inserted in a specified location



REPT



Specified text string repeated the specified number of times



SEARCH



Character position at which the specified character is located in the specified string



SUBSTITUTE



Specified text string with the specified new text string substituted for the specified old text string



T



Text string for a text value, empty double quotation marks (a blank string) for a nontext value



TEXT



Text string containing the specified value converted to the specified format



TRIM



Specified text string with spaces removed from the beginning and ends, and extra spaces between words removed to leave one space between words



VALUE



Value contained in the specified text string



TABLE 7-7



Excel’s Text Functions (continued)



Here are three examples of using the text functions:



■ =EXACT(A1,A2) compares the text in cells A1 and A2, returning TRUE if they’re exactly alike (including case) and FALSE if they’re not.



■ =IF(LEN(H2)>=5, LEFT(H2,5),H2) returns the first five characters of cell H2 if the length of the cell’s contents is five characters or more. If the length is less than five, the formula returns the full contents of the cell.



■ =TRIM(CLEAN(C2)) strips nonprintable characters from the text string in cell C2, removes extra spaces, and returns the resulting text string.
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How to… ■ ■ ■ ■ ■ ■ ■ ■ ■



Understand formula components Understand how Excel handles numbers Refer to cells, ranges, other worksheets, and other workbooks in formulas Enter a sample formula Use range names and labels in formulas Use absolute, relative, and mixed references in formulas Work with array formulas Display formulas in worksheets—or hide formulas from other users Troubleshoot formulas



I



n Chapter 7, you learned how to enter Excel’s built-in functions to perform calculations. Excel’s functions are great for performing a wide variety of standard calculations—as you saw, the functions encompass everything from adding a series of values to testing the logical truth or falsity of conditions to manipulating statistics and text. But often you’ll need to perform calculations that the built-in functions don’t cover. For such calculations, you create custom formulas. This chapter describes the basics of formulas in Excel and the components from which formulas are constructed. Then it covers how Excel handles numbers and how to create both regular formulas and array formulas. Finally, you’ll learn how to troubleshoot formulas when they go wrong.



Understand Formula Components A formula is a set of instructions for performing a calculation. Excel enables you to create formulas for performing whatever types of calculations you need. In a formula, you use operands to tell Excel which items to use and operators to specify which operation or operations to perform on them. A formula can contain up to seven nested functions—enough to enable you to perform highly complex calculations. Each formula begins with an equal sign, so the standard way of starting to enter a formula is to type an equal sign. However, Excel automatically enters the equal sign if you type + or – at the start of a formula, so you don’t always need to type it.



Operands The operands in a formula specify the data you want to calculate. An operand can be:



■ A constant value you enter in the formula itself (for example, =8*12) or in a cell (for example, =B1*8)
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■ A cell address, range address, or range name ■ A worksheet function



Operators The operators in a formula specify the operation you want to perform on the operands. Excel uses arithmetic operators, logical operators, reference operators, and one text operator. Table 8-1 explains these operators.



Operator



Explanation



+



Addition



–



Subtraction



*



Multiplication



/



Division



%



Percent



^



Exponentiation



=



Equal to







Not equal to



>



Greater than



>=



Greater than or equal to
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